
 

 

CVTEE / DVTEE 101 
 
 

ICT Resources and Applications- I 
 
 
 
 

School of Vocational Studies 
 

 
 

उƣराखÖड मÈुत ͪवæवͪवɮयालय 
तीनपानी बाईपास रोड, Ěांसपोट[ नगर के पास, हãɮवानी- 263139 

फोन न.- 05946 - 261122, 261123 

टॉल ĥȧ न.- 18001804025 

फैÈस न.- 05946-264232, ई-मेल- info@uou.ac.in 

वेबसाइट- www.uou.ac.in 



BOARD OF STUDIES 
Academic Session 2020 - 21 

Chairman 
Hon’ble Vice-Chancellor, Uttarakhand Open University, Haldwani 

Convener 
Professor Durgesh Pant, Director, School of Vocational Studies, 

Uttarakhand Open University, Haldwani. 

Members of Board of Studies 

Prof. S. A. Hamid, 
Dept. of English and Foreign Languages, Kumaun University, Nainital. 

Dr. Manas Ranjan Panigrahi, Senior Programme Officer, 
Commonwealth Educational Media Centre for Asia (CEMCA), New Delhi. 

Dr. Jitendra Pandey, 
School of Computer Science and IT, Uttarakhand Open University, Haldwani. 

Dr. Gopal Datt, 
School of Vocational Studies, Uttarakhand Open University, Haldwani. 

Mr. Balam Dafouti, 
School of Computer Science and IT, Uttarakhand Open University, Haldwani. 

PROGRAMME COORDINATOR 

Dr. Gopal Datt, 
School of Vocational Studies, Uttarakhand Open University, Haldwani 

 

UNIT WRITING 

UNIT WRITERS UNIT NO. 
Dr. Gopal Datt, School of Vocational Studies, Uttarakhand Open University, 
Haldwani, Nainital. 1, 2 

Dr. Sonal Sharma, Department of Computer Applications, Uttaranchal 
University, Dehradun. 

3 

Dr. Nitin Deepak, Amrapali Group of Institutes, Haldwani, Nainital. 4 
Mr. Ritesh Kandari, S C Guria Institute of Management, Kashipur, U. S. 
Nagar. 

5, 6, 8, 12 

Dr. Hitender Singh Jalal, Amrapali Group of Institutes, Haldwani, Nainital.  7 
Dr. Raj Kishor Bisht, Department of Mathematics/Computing, Graphic Era 
Hill University, Dehradun. 

9 

Mr. Bhupendra Singh Latwal, Shriram Institute of Management and 
Technology, Kashipur, U. S. Nagar. 10 

Mr. Gaurav Joshi, M.B. Govt. P.G. College, Haldwani, Nainital. 11 
 

FORMATTING 
Dr. Gopal Datt, School of Vocational Studies, 

Uttarakhand Open University, Haldwani 
 

Copyright © Uttarakhand Open University, Haldwani, Nainital 

Edition- 2020, Pre-Publication copy for Limited Circulation, ISBN: 

Publication- Uttarakhand Open University, Haldwani, Nainital. 

E- Mail: studies@uou.ac.in 

Printer:  

  



C. Voc. / D. Voc. (Technology Enabled Education) 
 

CVTEE / DVTEE 101 
ICT Resources and Applications- I 

 

INDEX 
UNIT DESCRIPTION PAGE NO. 

1 FUNDAMENTALS OF DIGITAL COMPUTER- I  

 

INTRODUCTION 
OBJECTIVES 
DEFINITIONS OF COMPUTER 
COMPONENTS OF COMPUTER 
EVOLUTION OF COMPUTERS 
GENERATION OF COMPUTER 
CLASSIFICATION OF COMPUTERS 
APPLICATION OF COMPUTERS 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

7-19 

2 FUNDAMENTALS OF DIGITAL COMPUTER- II  

 

INTRODUCTION 
OBJECTIVES 
REPRESENTATION OF DATA IN COMPUTERS 
COMPUTER MEMORY 
PRIMARY MEMORY 
SECONDARY MEMORY 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

20-28 

3 ICT RESOURCES AND APPLICATIONS- I  

 

INTRODUCTION 
OBJECTIVES 
MEANING OF ICT (HARDWARE) RESOURCES 
POPULAR ICT (HARDWARE) RESOURCES 
ICT (HARDWARE) RESOURCES AND APPLICATIONS 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

29-38 

4 ICT RESOURCES AND APPLICATIONS- II  

 

INTRODUCTION 
OBJECTIVES 
SOFTWARE OVERVIEW 
TYPES OF SOFTWARE 
PROGRAMMING LANGUAGES 

39-51 



INTRODUCTION TO OPEN SOURCE SOFTWARE 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

5 ICT RESOURCES AND APPLICATIONS- III  

 

INTRODUCTION 
OBJECTIVES 
ICT RESOURCES AND NEW AGE LEARNING SKILLS 
OPEN EDUCATION AND OPEN LEARNING INITIATIVES 
LIST OF POPULAR DIGITAL REPOSITORIES FOR TECHNOLOGY 
ENABLED EDUCATION 
BRIEF OVERVIEW OF LEARNING MANAGEMENT SYSTEM 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

52-62 

6 INTRODUCTION TO TEXT EDITOR (MS WORD)- I  

 

INTRODUCTION 
OBJECTIVES 
STARTING MS WORD 
WORKING WITH DOCUMENT 
WORKING WITH SYMBOLS, GRAPHICS AND EQUATIONS 
WORKING WITH DIAGRAMS AND CHARTS 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

63-82 

7 INTRODUCTION TO SPREADSHEET (MS EXCEL)- I  

 

INTRODUCTION 
OBJECTIVES 
STARTING MS EXCEL 
MS EXCEL BASIC FUNCTIONALITIES 
INSERTING ROWS AND COLUMNS 
SAVING AND CLOSING WORKBOOK 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

83-92 

8 INTRODUCTION TO MS POWER POINT- I  

 

INTRODUCTION 
OBJECTIVES 
STARTING MS POWER POINT 
DIFFERENT TYPES OF VIEWS 
CREATING PRESENTATION 
DESIGN TEMPLATES 
APPLYING CUSTOM ANIMATION AND SLIDE TRANSITION 

93-107 



MISCELLANEOUS POINTS- PRESENTATION 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

9 FUNDAMENTALS OF INTERNET- I  

 

INTRODUCTION 
OBJECTIVES 
CONCEPT OF INTERNET 
APPLICATIONS OF INTERNET 
CONNECTING TO THE INTERNET 
BASICS OF COMPUTER NETWORKS 
UNDERSTANDING URL 
SEARCH ENGINE 
INTERNET AS AN EDUCATIONAL TOOL 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

108-121 

10 LAYERED ARCHITECTURE OF INTERNET AND PROTOCOLS- I  

 

INTRODUCTION 
OBJECTIVES 
COMPUTER NETWORKS 
HISTORY OF INTERNET 
The OSI MODEL 
TCP/IP PROTOCOL SUITE 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

122-134 

11 E-CONTENT DEVELOPMENT  

 

INTRODUCTION 
OBJECTIVES 
E-CONTENT 
BENEFITS AND IMPORTANCE OF E-CONTENT DEVELOPMENT 
TOOLS AND TECHNIQUES OF E-CONTENT DEVELOPMENT 
E-CONTENT DELIVERY PLATFORMS / TOOLS 
OPEN SOURCE E-CONTENT DEVELOPMENT TOOLS 
INTRODUCTION TO HTML 
WEBSITE PLANNING AND STRUCTURE FOR E-CONTENT/E-TUTORIALS 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 

135-151 

12 E- GOVERNANCE  

 
INTRODUCTION 
OBJECTIVES 

152-166 



E-GOVERNANCE: AN OVERVIEW 
IMPORTANCE AND BENEFITS OF E-GOVERNANCE 
TYPES OF INTERACTIONS IN E-GOVERNANCE 
E-GOVERNANCE PROJECTS IN INDIA 
CHALLENGES OF E-GOVERNANCE IN INDIA 
POINTS TO REMEMBER 
GLOSSARY 
CHECK YOUR PROGRESS 
BIBLIOGRAPHY/ REFERENCES 
SUGGESTED READINGS 



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 1: Fundamentals of Digital Computer- I  Page 7 of 166 

UNIT- 1 

FUNDAMENTALS OF DIGITAL COMPUTER- I 
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1.1 INTRODUCTION 
This unit presents a broad survey of concepts and terminology related to today’s digital 

computers. Here, the idea of computer literacy is introduced. A computer is also a tool 

intended to assist the user in accomplishing information-based tasks ranging from locating 

and acquiring data/information to processing it and to presenting or transmitting it as output. 

Besides, it allows the user to browse the web pages, read a book, play a video game, watch a 

movie, etc. 

When you look at a desktop computer, it comprises a monitor, keyboard, mouse, and a 

vertical or horizontal box called a system unit.  It is acceptable to refer to all of these 

components as a computer. Technically, the systems unit houses the actual ‘computer’ or 

programmable machine (hardware, firmware and, software), which executes (carries out) or 

responds to a sequence of program instructions. A computer system then is a collective term 

for a computer (housed within the system unit), as well as these other components that are 
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attached to it to allow the user to input data and view output using different devices. Some of 

these components include a monitor, keyboard, mouse, printer, disk drives, scanners, 

microphones, and speakers, which are also referred to as peripherals. The peripherals work 

together to help the user accomplish a given task effectively. It is the system unit that accepts 

and processes the data, and generates the results. Other peripheral devices such as the hard 

drive store the data and results, which can be viewed on the monitor. 

The peripheral devices mentioned above are collectively called hardware devices, since they 

can be physically attached to the computer. However, computer systems also include 

software, or programs that are integral in the functioning of some of these peripheral devices 

and are necessary to make the computer operate. Every computer system requires an 

operating system. An operating system is a program that establishes communications with the 

various peripherals and acts as a bridge to other application-specific software programs. An 

operating system is like the command centre of the ship. It makes all of the decisions about 

how the computer will function and work with others. 

1.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define the term and its components. 

 Understand the Input devices and output devices used. 

 Define Computer Generations and key applications of computers. 

1.3 DEFINITION OF COMPUTER 
A computer is an electronic processing device, which accepts inputs, processes the input data, 

and generates the output. In other words, a computer is an electronic device, operating under 

the control of instructions (software) stored in its own memory unit, that can accept data 

(input), manipulate data (process), and produce information (output) from the processing. 

COMPUTER stands for- Common Operating Machine Particularly Used for Training 

Education and Research. 

The minimum requirements for a functional computer system include; a keyboard, a CPU and 

memory, and a monitor. The data is usually entered via the keyboard and the information is 

usually presented through a screen. However, information can also be presented through 

speakers or any other output devices e.g. screen projector, printer. 

The way components inside a computer fit together helps describe how the computer works. 

Data comes in through an Input Device, and is sent to the CPU by the memory. CPU 

processes the data based on the input data and the program is installed in the computer 

memory. When the CPU has finished processing the data, it is presented through the output 

device as information. The information can be stored in the computer memory or presented 

through an Output Device. 
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1.4 COMPONENTS OF COMPUTER 
To perform computer functionalities, we need some hardware and software. In a general way 

computer is an electronic device which perform particular tasks. It takes input and processes 

it to produce an output. Primarily there are three main components of a digital computer-

Input Unit, Processing Unit and, Output Unit. 

Input Unit- 

It takes different types of input data from various input devices like-keyboard, mouse, light 

pen, scanner, MICR, Bar Code Reader, etc. Whenever you want to instruct anything to a 

computer, input device (s) is (are) needed. If you want to write an application on a computer, 

you need an input device called “KEYBOARD”. 

List of input devices- 

 Keyboard 

 Mouse 

 Joystick 

 Light pen 

 Trackball 

 Scanner 

 Graphic Tablet (touch screen) 

 Microphone 

 Magnetic Ink Character 
Reader (MICR) 

 Optical Character Reader 
(OCR) 

 Bar Code Reader 

 Optical Mark Reader (OMR) 

 

INPUT PROCESS OUTPUT INPUT PROCESS OUTPUT 

Mouse 

Joy Stick Microphone 

Keyboard 

MICR Scanner OMR 
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Details about some frequently used input devices- 

Keyboard- 

Keyboard is a frequently used 

input device. A keyboard is 

just like a traditional 

typewriter, although 

keyboard has some 

additional keys used for 

performing additional 

functions. 

The above keyboard has 104 
keys. Most of the keyboards 
are common. Generally, keyboards can be categorized into 6 parts as follows: 

Typing Keys- 

These keys consist of key letters (A-Z) and digit keys (0-9) which are the same as 
typewriters. 

Numeric Keypad- 

Some keyboards have this numeric keypad. Numeric keypad is placed into the right side of 
the keyboard just shown in the above keypad. 

Function Keys- 

At the top of the keyboard, 12 function keys are present where each key has a unique task. 
The function of these keys varies application to application. 

Control Keys- 

It includes Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt) and 
Escape(Esc) key. Each key has some special function or worked into combination with some 
other keys. 

Special Purpose Keys- 

Keyboard also contains some special purpose keys such as Enter, Shift, CapsLock, NumLock, 
Spacebar, Tab, and Print Screen. 

Arrow Keys- 

It consists of four directional arrow keys named as-left arrow, right arrow, up arrow and 
down arrow. 

Mouse- 

This is a commonly used pointing device. A mouse can be used to control the position of the 

cursor on the screen, but it cannot be used to enter text or any data into the computer. 

Douglas Engelbart called the father of mouse and invented it in 1963.There are basically 
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three kinds of mouse- Mechanical Mouse, Optical Mouse, and Cordless Mouse. 

A mouse contains the following functional buttons-  

 Click (Left Click) 
 Right Click 
 Scrolling (Middle Button) 
 Double Click 

Scanner- 

A scanner is an input device just like a photocopy machine. It is used when a paper has some 

information and it is to be transferred to the computer for further manipulation. The scanner 

captures images from the source, which are then converted into a digital form that can be 

stored on the disk. 

Processing Unit- 
The Processing unit is also called a Central Processing Unit (CPU). CPU is the brain of your 

computer. It performs all types of data processing operations and stores data & intermediate 

results for a while (during processing). It also controls the operation of all parts of the 

computer system. In general terms, CPU can be understood as the following-  

 Control Unit (CU) - It controls the various component of a computer. 

 Arithmetic and Logic Unit (ALU) - This subunit of the CPU performs all the arithmetic 

and logical operations such as- addition, subtraction, multiplication, division, and 

comparison. 

Note- Apart from the processing unit, memory unit is an indispensable part to the smooth 

running of a program. Whenever you need to store information in a computer, you need 

memory. Computer memory is basically sub divided into two broader categories as-  

(i) Primary Memory (also known as Main Memory).  
(ii) Secondary Memory (also known as Storage / Permanent Memory).  

Note-We will have a detail discussion about memory unit further in this book. 

Output Unit- 

The processed data is called output. After processing, either the results are stored in the 

memory or sent to the output unit. Some examples of different output devices are- CRT 

(Cathode Ray Tube) monitor, LCD (Liquid Crystal Display) monitor, LED (Light Emitting 

Diode) monitor, printer, speaker, screen projector, plotter, etc. 

Monitor- 

A monitor is a commonly used output device which displays information in a similar way to 

that of a television screen. Generally, the size of a monitor is 19-inch, 20 inch and 21 inches. 

Broadly speaking, there are three different types of monitors- 
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Cathode Ray Tube (CRT) 

Liquid Crystal Display (LCD) 

Light Emitting Diode (LED) 

Printer- 

A printer is a hard copy output device i.e. it provides the output in a hard copy/printed form. 

There are two types of computers- Impact Printer and Non- impact printers. 

Impact Printers– refers to all those printers whose printing heads touches the paper, for e.g. 

dot matrix printer. 

Non- Impact Printer– refers to all those printers whose printing heads do not touch the paper, 

for e.g. laser and inkjet printer.  

1.5 EVOLUTION OF COMPUTER 
Today most of the jobs mainly depend on either the creation or collection and distribution of 

information. This topic addresses the different advancements in computer technology and the 

various types of computers and their critical components. As each new computer generation 

improves on its previous generation, there has been a corresponding reduction in size (or 

miniaturization) of computer circuitry. In contrast to this miniaturization, the speed, power, 

and memory of computers have proportionally increased. Although this topic will describe 

the major developments of each computer generation, it is more important to consider how 

technology has influenced the development of current computer systems. The detailed 

description of computer evolution is discussed in the next title. 

1.6 GENERATION OF COMPUTER 

 First Generation (Year 1946 - 1959) 

 Second Generation (Year 1959 - 1965) 

 Third Generation (Year 1965 - 1971) 

 Fourth Generation (Year 1971 - 1980) 

 Fifth Generation (Year 1980- Onwards) 

First Generation (1946 - 1959)- 

First-generation computers were vacuum tube-b a s e d  computers popular in the period 1946-

1959. These vacuum-based computers were expensive, extremely large, and less cost-

effective as they consumed a lot of electricity. The language used for storing and processing 

data was machine language. Some of the first-generation computers are:  

Electronic Numerical Integrator and Calculator (ENIAC) built at the University of 

Pennsylvania in the year 1946 by John Eckert and John Mauchly. Electronic Discrete 
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Variable Automatic Computer (EDVAC) developed in 1950 at Cambridge University. 

UNIVAC-1 developed in 1951. The following drawbacks were there in first-generation 

computers as- 

 They were extremely large. 

 Operational speed was very slow. 

 Electric consumption was very large. 

 They have no operating system. 

 The programming capability was very low. 

Second Generation (1959 - 1965)- 

The computers from 1959- 1965 were transistor-based second generation computers. In this 

generation, vacuum tubes were replaced by more durable transistors. Transistors are more 

compact than vacuum tubes as they are made up of semiconductors. Some of the computers 

of the second generations are:  

IBM 1620- Its size was smaller as compared to the first-generation computers, used mostly 
for scientific purposes. 

IBM1401- used for business applications. 

CDC3600- used for scientific purposes. 

The salient features of this generation are- 

 They were smaller in size than the first generation computers. 

 Operational speed relatively faster and more reliable than first-generation computers. 

 Electricity consumption was relatively lesser than first-generation computers. 

 They had higher capacity internal storage. 

Third Generation (Year 1965 - 1971)- 

The third- generation computers from 1965 to 1971 were Integrated Circuit (IC) based. These 

ICs are more compact than a transistor and were called chips. Single ICs has many 

transistors, resistors and capacitors, placed on a single thin of silicon. So, the computer built 

of such components became smaller. Some of the computers developed during this period 

were- 

IBM360- developed by IBM in the year 1964. 

PDP8- developed by DEC in the year 1965. 

The salient features of this generation are- 

 Relatively small in size. 

 Relatively low cost. 
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 Operating system is used. 

 More reliable and high operational speed. 

 Large memory capacity. 

Fourth Generation (1971 - 1980)- 

The computers from the period 1971-1980 were Very Large Scale Integrated ( VLSI) 

microprocessor-based fourth generation computers. VLSI circuits were used in these 

computers. VLSI circuits having about 5000 transistors and other circuit elements and their 

associated circuits on a single chip made it possible to have microcomputers of the fourth 

generation. As a result, fourth-generation computers became more powerful, compact, 

reliable, and affordable giving rise to personal computer (PC) revolution. In this generation 

time sharing, real-time networks, and distributed operating systems were used. All the high-

level programming languages like C, C++, DBASE etc., were developed during this 

generation. 

The salient features of this generation are- 

 They have a very high speed. 

 Low costs in comparison to the preceding generations. 

 Smaller in size. 

 Reliability is very high. 

 Hardware failure is very low. 

 Very low heat generation. 

Fifth Generation (1980- Onwards)- 

The fifth generation of computers developed 1980 onwards were Ultra Large Scale Integrated 

(ULSI) microprocessor-based. In this generation, the VLSI technology was replaced by more 

advanced ULSI technology. ULSI is a set of ten million electronic components into a single 

chip. This technology is based on parallel processing with hardware and software support. A 

key advancement of this generation is machine learning/artificial learning. 

The salient features of this generation are- 

 Working based on artificial intelligence or machine learning. 

 Working based on image and graphics recognition. 

 Highly efficient in solving highly complex problems including decision making, logical 

reasoning, and many more. 

1.7 CLASSIFICATION OF COMPUTER 
 Computers of this age can be broadly categorized in the following two ways- 

 Based on the size of memory 
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 Based on speed. 

Based on the size of the memory, computers can be further classified into- 

 Micro Computer 

 Mini Computer 

 Mainframe Computer 

 Super Computer 

Micro Computer- 

The speed of a micro computer is very low with similar low capacity of storage. Its CPU is a 

microprocessor. The first microcomputers were built of 8-bit microprocessor chips. The most 

common microcomputer is a personal computer (PC). The PC supports many input and 

output devices. An improvement of the 8-bit chip is 16-bit and 32- bit chips. Examples of 

microcomputers are- IBM PC, PC-AT, etc. 

Mini Computer- 

This is designed to support more than one user at a time. It possesses a large storage capacity 

and operates at a high speed than a microcomputer. The mini computer is used in a multi-

users system in which various users can work at the same time. This type of computer is 

generally used for processing large volumes of data in an organization. They are also used as 

servers in Local Area Networks (LAN). 

Mainframe Computer- 

32-bit computers are generally called mainframe computers. They operate at a very high 

speed, have very large storage capacity, and can handle the workload of many users 

simultaneously. They are generally used in centralized databases. The mainframe computers 

are also used as controlling nodes in Wide Area Network (WAN).  Examples of mainframe 

computers are- DEC, ICL and IBM 3000 series. 

Super Computer- 

A supercomputer is the fastest and most expensive. The processing speed of this type of 

computer is very high, so they are relatively costly. They also have multiprocessing 

techniques. One of the ways in which supercomputers are built is by interconnecting 

hundreds of microprocessors. Supercomputers are mainly used for weather forecasting, 

biomedical research, remote sensing, aircraft design, and other advanced areas of science and 

technology. Some examples of supercomputers are- CRAY YMP, CRAY2, NEC SX3, 

CRAY XMP, and PARAM from India. 

1.8 APPLICATION OF COMPUTERS 
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The range of computer applications has penetrated each possible field.  Some of the key areas 

are -  

 Business- A computer performs faster calculations and provides accurate and reliable 

results which have made it possible to integrate with business organizations. Some of 

the areas where computer performs different roles are- Payroll calculations, Budgeting, 

Sales analysis, financial forecasting, and Managing employee database, Maintenance of 

stocks, etc. 

 Education- Some of the key areas where computers are used are- student management 

systems, teaching tools, learning management systems, etc. 

 Marketing/Advertising – Computers have revolutionized the advertisement industry 

where you can create art and graphics, write, revise and copy, and print and disseminate 

ads and sell more and more products. 

 Banking- In this day and age, banking is mostly dependent on computers. Some of the  

facilities provided using computers are − Online accounting facility, checking current 

balance, making deposits and overdrafts online, checking interest charges, ATM, 

shares, etc. 

 Insurance- Insurance companies keep all the records up-to-date with the help of 

computers. Some of the other important functions are- amount calculation, customer 

MIS, maturity, etc. 

 E-Learning- Computers have bought a boom in the popularisation of e-learning. One 

can sit at home and enrich his/her learning with not just textual information but also 

pictorial and animated information which are easier to learn.  

 Military- Computers are largely used in defence and military operations. Modern tanks, 

missiles, weapons, etc are some devices that can be handled by a computer. 

 Desktop publishing- With desktop publishing, you can create page layouts for entire 

books on your personal computer. 

 Medicine- Computers are a great help in the diagnosis of diseases.  Various computer 

led software are used in magnetic resonance imaging to examine the internal organs of 

the human body. Computer software is also used in storing patient data and performing 

surgeries. 

The list of areas where computer application is endless in this day and age no place has been 

left untouched. The above mentioned are some of them. 

1.9 POINTS TO REMEMBER 

 Assembly Language- It is the first step to improve the programming structure. You 

should know that a computer can handle numbers and letters. The symbolic 

programming of assembly language is easier to understand and saves a lot of time and 

effort of the programmer. 
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 High-Level languages- Assembly language and machine level language require deep 

knowledge of computer hardware whereas in a higher language you have to know only 

the instructions (Language Grammar) in English words and logic of the problem 

irrespective of the type of computer hardware you use. 

 Von Neumann Architecture also known as the Von Neumann model is a design model 

for a stored-program concept wherein the computer consists of a CPU, memory and 

Input/output devices. The program is stored in the memory and the CPU fetches an 

instruction from the memory at a time and executes it.  

 Freeware- Freeware is software that is distributed without demanding any cost for its 

usage. These programs are available either as fully functional software for an unlimited 

period. 

 Open Source- The term ‘Open Source’ is very close to ‘free software’ but not identical. 

We say this because, the source code of open-source software is readily available to 

users as well under a copyright, and one is freely allowed to redistribute the software. 

The concept of an open-source program relies on the fact that a user can review a 

source-code for eliminating possible bugs/error in it. 

 Shareware- Shareware is demonstration software that is distributed for free but for a 

specific evaluation period only, say, 15-30 days (Say trial version). After the evaluation 

period, the program gets expired and a user can no longer access the program. Only if 

you are interested in using the program further, the shareware provider may require you 

to purchase a license for the software. 

 Spyware- Spyware goes a few steps further and surreptitiously installs software on your 

computer. The spyware may contain a code that sends information about the user’s 

computer to the developer or some other location whenever the user is connected to the 

Internet.  

 Malware- Typically referred as ‘Malicious Software’, Malware is any program with 

mala fide intentions which exploits data of a computer without its user’s consent. 

1.10 GLOSSARY 
 Cache Memory- Cache is a type of memory and is similar to RAM. A cache is used by 

the computer to move data between the RAM and CPU. 

 Bit- Represents a binary digit which is the amount of information obtained by asking a 

‘yes’ or ‘no’ question. This is also the smallest unit of information stored on a computer 

as a 0 or 1. 

 Byte- Data is stored on a computer in the form of bytes. A byte is one character, which 

may be a number or letter. A byte is composed of 8 consecutive bits. 
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 Flash Drive- This is a small portable hard drive that plugs into a USB port and allows 

you to transport files between different computers. Also called a thumb drive. 

 Graphical User Interface (GUI) - A program that helps you work easily with your 

operating system. Also, application programs by providing pictures and visual clues 

enhance your experience at work. Windows is the GUI on PCs. 

 Modem- This is a way to transfer data through a telephone or cable line generally by 

the Internet. It may be internal or external. Some modems are used to fax or act as 

answering machines. 

 Motherboard– The circuit board that functioning parts of the computer connect to be 

the motherboard. The CPU, RAM, and cache all plug into the motherboard. 

 NIC (Network Interface Card) – A card is put in the computer allowing connection to a 

network. 

 Sound Card– This device allows the computer to reproduce music, sounds, and voices. 

The computer needs a sound card to hear the audio portion of web sites or often to play 

multimedia games. 

 USB Port– The Universal Serial Bus is accessed through small rectangular port on the 

front or back of computer that allows peripheral devices such as digital cameras and 

external hard drives to connect to the computer. See Ports for other types of 

connections. 

 App- A type of application software designed to run on a mobile device, such as a 

Smartphone or tablet computer (also known as a mobile application). 

 Bug- An error in a software program. It may cause a program to unexpectedly quit or 

behave in an unintended manner. The process of removing errors (bugs) is called 

debugging. 

1.11 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) What do you understand by Computer Generation? 

b) Draw a block diagram of a digital computer and explain it briefly. 

c) Explain input and output devices used in the computer. 

d) Write down some important applications of a computer. 

Objective type questions- 

a) Which of the following are components of the Central Processing Unit (CPU)? 
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[A] Arithmetic logic unit, Mouse   [B] Arithmetic logic unit, Control unit 

[C] Arithmetic logic unit, Integrated Circuits [D] Control Unit, Monitor 

b) If a computer has more than one processor then it is known as 

[A] Uniprocessor [B] Multiprocessor [C] Multithreaded [D] Multiprogramming 

c) In which of the following form, data is stored in the computer? 

[A] Decimal  [B] Binary  [C] Hexadecimal  [D] Octal 

d) GUI stands for..... 

[A] Graphical user Instrument   [B] Graphical unified Interface  

[C] Graphical unified Instrument  [D] Graphical user Interface 

Answer (Objective type questions)- 

[a] Arithmetic logic unit, Control unit [b] Multiprocessor [c] Binary [d]Graphical user 

Interface 
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2.1 INTRODUCTION 
The major components of a computer system include Central Processing Unit (CPU), input 

and output devices. The CPU comprises a set of electronic circuits kept within the system 

unit. The CPU is the brain of a computer system and is responsible for processing the data i.e. 

input from peripheral devices and output to another peripheral device. The Central Processing 

Unit (CPU), also known as the processor or microprocessor has components that control the 

operating system and other software installed on the computer. The CPU also sends 

commands and data to the peripherals attached to the computer, such as the monitor or 

printer.  

Therefore, the speed (how fast the electrons move around the chip) at which the CPU 

executes its tasks (or commands) determines how quickly you can view or hear the output 

from the command such as printing a page or allowing you to view a letter on the monitor. 

This speed is called ‘clock speed’ and is measured in megahertz (MHz). A computer system 

that responds to commands quicker means that it’s clock speed is working faster to execute 

these commands. Table 2 compares some common CPUs and their clock speeds. Different 
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CPUs use different silicon chips to execute the commands and process data. Different types 

of chips have different clock speeds based on the technology that was used to create them. 

2.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Understand the concept of storing data into computers. 

 Know about computer memory e.g. primary memory and secondary memory. 

2.3 REPRESENTATION OF DATA IN COMPUTERS 
Data and instructions cannot be entered and processed directly into computers using human 

language. Any type of data- numbers, letters, special symbols, sound or pictures must first be 

converted into machine-readable form i.e. binary form. Due to this reason, it is important to 

understand how a computer together with its peripheral devices handles data in its electronic 

circuits, on magnetic media, and in optical devices. Electronic components, such as 

microprocessor, are made up of millions of electronic circuits. The availability of high 

voltage(on) in these circuits is interpreted as ‘1’ while a low voltage (off) is interpreted as 

‘0’.This concept can be compared to switching on and off an electric circuit. When the switch 

is closed the high voltage in the circuit causes the bulb to light (‘1’ state). On the other hand, 

when the switch is open, the bulb goes off (‘0’ state). This forms a basis for describing data 

representation in digital computers using the binary number system. 

It has proved difficult to develop devices that can understand natural language directly due to 

the complexity of natural languages. However, it is easier to construct electric circuits based 

on the binary or ON and OFF logic. All forms of data can be represented in a binary system 

format. Other reasons for the use of binary are that digital devices are more reliable, small, 

and use less energy as compared to analog devices. 

Bits, bytes, nibble, and word 

The terms bits, bytes, nibble, and word are used widely in reference to computer memory and 

data size. 

Bits:  is the basic unit of data or information in digital computers, expressed in binary forms 0 

or 1. 

Byte: a group of bits (8 bits) used to represent a character. A byte is considered as the basic 

unit of measuring memory size in computer. 

A nibble: is half a byte, which is usually a grouping of 4 bytes. 

Word: two or more bits make a word. The term ‘word length’ is used as the measure of the 

number of bits in each word. For example, a word can have a length of 16 bits, 32 bits, 64 

bits, etc. 
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Computers not only process numbers, letters and special symbols but also complex types of 

data such as sound and pictures. However, these complex types of data take a lot of memory 

and processor time when coded in a binary form. This limitation necessitates the need to 

develop better ways of handling long streams of binary digits. Higher number systems are 

used in computing to reduce these streams of binary digits into manageable form. This helps 

to improve the processing speed and optimize memory usage. 

Number systems and their representation- 

A number system is a set of symbols used to represent values derived from a common base or 

radix. As far as computers are concerned, number systems can be classified into two major 

categories: 

 decimal number system 

 binary number system 

While the other number systems include: octal number system and hexadecimal number 

system. 

2.4 COMPUTER MEMORY 
Computer memory is used to store information (data and instructions) in a digital computer. 

A memory is divided into several small parts called memory cells. Each memory cell or 

location has a unique address in the form of machine language (0/1). It is useful to know how 

to store information on a computer because this will allow us to ascertain about the amount of 

space that will be required to store a data set which in turn will allow us to determine what 

software or hardware we will need to be able to work with a data set and to decide upon an 

appropriate storage format. The computer memory is divided into main and auxiliary 

memory. Main memory also called primary memory and secondary memory also called 

storage memory. Main memory holds instructions and data when a program is in execution, 

while auxiliary or secondary memory holds data and programs not currently in execution and 

acts as a storage medium. 

2.5 PRIMARY MEMORY 
Primary memory holds instructions and data currently being processed by the CPU- the 

intermediate results produced during the execution of the process. The instructions and data 

remain in primary memory which can be accessed by the CPU directly and quickly. 

Functions of Primary Memory 

 Holding data and instructions for the task assigned by the input device before 

processing. 

 Holding intermediate results while processing. 
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 Holding data and information after processing unless they are transferred to the output 

unit. 

 Holding programs and instructions from the secondary storage device. 

 Holding system programs like an operating system. 

Types of Primary Memory- 

 Random Access Memory (RAM)  

 Read-Only Memory (ROM) 

Random Access Memory (RAM)- 

It is a volatile or temporary memory. Its contents get lost once the power supply is switched 

off. It is also called read/write (R/W) memory. It allows CPU to read as well as write data and 

instructions over it. It temporarily holds software, programs /instructions before and after 

processing of the data. RAM is used during the execution of instructions. RAM is considered 

‘random access’ because you can access any memory cell directly. RAM is made up of 

semiconductor material; therefore it is also called semiconductor memory, just like 

processors and ROM types of chips. In comparison to other memory devices (storage 

memory), RAM is much faster to read and write instructions, and data. RAM is also named 

direct access memory because the operating system, application programs, and data currently 

in use are stored in RAM directly accessed by the CPU/processor. 

The Random Access Memory is further divided into- (i) Dynamic Random Access Memory 

(DRAM) (ii) Static Random Access Memory (SRAM). 

Dynamic Random Access Memory (DRAM)- 

It makes use of a transistor and a capacitor to form a memory cell standing for a single bit of 

data. DRAM is not able to retain information for a longer time even if the power supply is on 

because it needs refreshing frequently. It is slower and less expensive than SRAM. 

Static Random Access Memory (SRAM)- 

In SRAM flip flops are used for retaining memory. Typically, it uses four to six transistors 

for each memory cell. It does not have a capacitor and hence does not require refreshing. It 

can store information until the power supply is “on”. It is faster and expensive in comparison 

to DRAM and primarily used in the processor’s cache memory. 

Note- Apart from SRAM and DRAM, some other types of RAM are also available. Few 

are as follows: 

a) Fast Page Mode Dynamic Random Access Memory (FPM DRAM) – This memory is a 

bit faster in comparison to the conventional DRAM. The access time is improved for 
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this memory as it sends row address only once for accessing the neighbouring locations 

in memory. Despite its name, it is still one of the slowest RAMs used today. This 

memory is not considered good for high-speed memory buses over 66 MHz. 

b) Extended Data Output Dynamic Random Access Memory (EDO DRAM) – It can be 

seen as an improved version of “FPM DRAM”, as it can retain data valid for a longer 

period than FPM. Due to this feature, it is known as the extended data output. It stores 

265 bytes of data information into latches and these latches hold the next same amount 

of information. This arrangement makes it possible for programs to be executed 

sequentially without any delay. 

c) Synchronous Dynamic Random Access Memory (SDRAM) – SDRAM is a generic 

name that refers to the many dynamic random access memories that are synchronized 

with the system bus.  It carries data between the CPU and the memory controller hub. It 

uses the features called pipelining, which accepts new data before to finish previous 

processing data. 

d) Double Data Rate - Synchronous Dynamic Random Access Memory (DDR- SDRAM) 

- Double data rate SDRAM was introduced later to give an alternative to single data 

rate SDRAM. DDR SDRAM provides better speed than Synchronous Dynamic 

Random Access Memory and also consumes a lesser amount of energy. The transfer 

rate of data became just double as it is capable of sending data on both rising and 

falling edges of the clock pulse.  

e) Double Data Rate Type2 - Synchronous Dynamic Random Access Memory (DDR2- 

SDRAM) – The speed of DDR2- SDRAM is just double in comparison to the DDR 

SDRAM because its input/output buffer frequency is doubled. 

f) Double Data Rate Type3 - Synchronous Dynamic Random Access Memory (DDR3 

SDRAM)– DDR3- SDRAM is considered as an improved version of DDR2 SDRAM. 

It also doubles the speed of DDR2 SDRAM. Its power consumption is lesser and the 

rates of data transfer range from 800Mbps to 1600 Mbps. 

g) Double Data Rate Type4 - Synchronous Dynamic Random Access Memory (DDR4 

SDRAM) – This RAM is a higher-speed successor to the technology used by DDR3 

SDRAM. This provides better system-level reliability, capacity, performance 

scalability, and power efficiency in comparison to all of its previous memories. Such 

as- DDR3 SDRAMs. 

Read-Only Memory (ROM) 

It is a non-volatile memory whose contents are not lost even the electric power is off. It stores 

instructions for computer start-up. During the computer start-up operation, the main memory 

(RAM) of the computer is empty because of its volatile nature, so that the computer gets 
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instructions from the ROM to start-up (booting) operation. The contents of ROM cannot be 

written or erased by the user only trained programmers and technicians can alter or write or 

erase the contents of ROM. ROM chips are generally designed at the time of manufacturing. 

ROM also performs the BIOS (Basic Input Output System) functions. 

Types of Read-Only Memory 

 Programmable Read-Only Memory (PROM) 

 Erasable Programmable Read-Only Memory (EPROM) 

 Electronically Erasable Read-Only Memory (EEPROM) 

a) Programmable Read-Only Memory (PROM) - The data stored in PROM cannot be 

modified and therefore it is also known as a ‘one-time programmable device’. It is 

made as a blank memory as a result when you want to write on a PROM chip, a ROM 

burner is required to write data onto a PROM chip. 

b) Erasable Programmable Read-Only Memory (EPROM)- Unlike programmable 

ROM; erasable programmable ROM can write/modify data more than once. When 

ultraviolet rays of some specific wavelength fall into EPROM’s chip glass panel, the 

bits of memory come back to 1 and the chip enables them to write.  

c) Electronically Erasable Read-Only Memory (EEPROM)- Electrically Erasable 

Programmable ROM is as same as Erasable Programmable ROM, but the same work of 

erasing the stored data is performed with an electric current. EEPROM is a type of non-

volatile memory and used in computers and other electronic devices. It used to store 

relatively small amounts of data and also allows individual bytes to be erased and 

reprogrammed. It stores a computer system’s BIOS (Basic Input Output System). 

Unlike EPROM the entire chip does not have to be erased for changing some portion of 

it. 

2.6 SECONDARY MEMORY 
Secondary memory is where programs and data are kept on a long-term basis. Common 

secondary storage devices are the hard disk and optical disks. A hard disk might have a 

storage capacity of one terabyte (TB). A hard disk is slow in accessing speed compared to the 

main memory. Secondary memory has enormous storage capacity, especially hard disk. Some 

of the secondary storage devices are explained below- 

a) Hard Disk Drive (HDD)- Hard disks are stored permanently inside their drive, which 

is normally installed into the computer box where you cannot see any part of it. Hard 

Disks can store a lot of data and are used to store most of the information on computers. 

The advantage of HDD is cost and capacity. The disadvantage of HDD is that they 

make a lot of noise, are slow, and prone to failure. They are slowly being replaced by 

solid-state drives (SSD). 
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b) Floppy Disk Drive (FDD)- Floppy disks are small disks that you can pop in and out of 

their drive. All you can see of their drive is a slit in the computer box with a button and 

a light. You can put in different disks and then take them out and give them to someone 

so that you can transfer data between your computers. FDD's are now obsolete. They 

can store only about 1.44 MB, which is way too little. They are prone to damage and 

are now unsupported for many years. 

c) Compact Disk (CD)- The most popular kind of optical disk is the Compact Disc (CD). 

CDs can still be put into and taken out of their drive, making them good for buying 

programs and for transferring data nowadays. The normal CDs that you buy with 

programs on them are CD-ROMs. They are called so because like ROM, they are read-

only. You can also get CD-Rs and CD-RWs, which are not read-only and are not 

erasable and erasable, respectively. However, CD-R cannot be deleted once it is 

written(a process known as finalizing). CDs can store around 700MB. And, because 

CDs store their information with variations in the shape of the disk that reflects a laser 

differently, they cannot be damaged as easily. However, one should still never touch 

the shiny surface of the CD. CDs are now being replaced by online media, and do not 

feature in many new computers anymore. 

d) Digital Versatile Discs (DVD)- DVDs are another kind of Optical disc that works 

identically to CDs; however, they can store much more information than CDs. DVDs 

can store usually about 4.3 GB, but dual-layered DVDs can store up to about 9 GB and 

DVD-RAM can store about the same amount. They are sometimes called Digital Video 

Discs because of their extensive use in video and films. 

e) Flash memory- Nowadays, one can get memory cards that are called flash memory or, 

more properly, EEPROMs. These are cards that operate just like ROM that isn’t read-

only, so they don’t lose their information when the power is cut. 

f) Solid State Disks (SSD)- SSDs are based on flash memory. They are much quicker 

than HDDs, do not make much noise and heat, but they are costlier than HDD's, but the 

cost of SSDs are rapidly declining. Another concern with SSDs is that the cells on the 

SSD can last only up to a specific number of write cycles. However, they are not of 

much concern to home users, as SSDs utilize features such as TRIM to extend lifespan. 

The lifespan of the SSD will usually be mentioned, which could be anywhere between 

30 - 150 TB more than the average lifespan of a computer.  

2.7 POINTS TO REMEMBER 
 Data and instructions cannot be entered and processed directly into computers using 

human language. Any type of data- numbers, letters, special symbols, sound or pictures 

must first be converted into machine-readable form i.e. binary form. 
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 The CPU is the brain of a computer system and is responsible for processing the data 

i.e. input from peripheral devices and output to another peripheral device. 

 Byte: a group of bits (8 bits) used to represent a character. A byte is considered as the 

basic unit of measuring memory size in computer. 

 Word: two or more bits make a word. The term ‘word length’ is used as the measure of 

the number of bits in each word. For example, a word can have a length of 16 bits, 32 

bits, 64 bits, etc. 

 Computer memory is used to store information (sometimes also called data and 

instructions) in a digital computer. A memory is divided into several parts called 

memory cells. 

 Main memory holds instructions and data when a program is in execution, while 

auxiliary or secondary memory holds data and programs not currently in execution and 

acts as a storage medium. 

2.8 GLOSSARY 

 PROM- Programmable Read-Only Memory. 

 EPROM- Erasable Programmable Read-Only Memory. 

 EEPROM- Electronically Erasable Read-Only Memory. 

 ROM- Read-Only Memory. 

 HDD- Hard Disk Drive.  

 FDD- Floppy Disk Drive. 

 CD- Compact Disk.  

 DVD- Digital Versatile Discs.  

 SSD- Solid State Disks. 

 SDRAM- Synchronous Dynamic Random-Access Memory. 

 DDR- Double Data Rate. 

 EDO DRAM- Extended Data Output Dynamic Random-Access Memory. 

 SRAM- Static Random-Access Memory. 

 DRAM- Dynamic Random-Access Memory. 

 Bit- Binary Digit. 

2.9 CHECK YOUR PROGRESS 
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Descriptive type Questions- 

a) Distinguish between RAM and ROM 

b) Write short notes on: Primary memory and Secondary memory 

c) ‘Computers play an important role in our daily lives’. Discuss in your own words. 

d) How data is stored in a computer? Define. 

Objective type questions- 

a) EEPROM stands for............ 

b) RAM is of two types........... & ........... 

c) Main memory is also known as...........  

d) Pen drive is an example of ......... storage device. 

e) ROM is volatile memory. (True/False) 

f) Analog computers use continuous physical quantities like voltage. (True/False) 

Answers (Objective type questions)- 

[a]Electronically Erasable Programmable Read Only Memory [b] DRAM & SRAM [c] 

Primary memory [d] Secondary[e] False [f] True. 
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3.1 INTRODUCTION 
In the previous unit, you have learned about the representation of data in a computer, the 

concepts of bits and bytes as well as the various memory-hierarchy levels. Till now, you 

know well about the digital computer. The information present in a computer can be easily 

transferred through the Internet to anyone across the globe.  

In this unit, you would explore various hardware tools that can be used as Information and 

Communication Technology (ICT) resources. ICTs are tools that support users to 

communicate/transfer the information across the globe. The usage of ICT has been witnessed 

in various domains like Education, Healthcare, Banking, Insurance, etc. To realize the 

importance of ICT one must understand the peripheral devices and expertise various ICT 

Tools. 

3.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Understand the overview of hardware resources used. 
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 Explore ICT hardware resources used for Technology Enabled Learning. 

 Explore the uses of different hardware resources. 

3.3 MEANING OF ICT (HARDWARE) RESOURCES 
Information and Communication Technology (ICT) includes the products which help the user 

to store, access, disseminate, or receive information. These products comprise of all the 

software applications, hardware resources like computer, CDs, videotapes, multimedia, 

telephone, scanner, etc. The world of ICT exists due to the advent of the Internet. So, it 

becomes highly important to understand the concept of Internet before moving further. 

ICT is thus the integration of information, computation, and technological advancements. It 

has made our life simple. It has changed the dimensions of our work, learning, and dealings 

in business. In fact, it has changed the whole ecosystem of society and its people. 

Just look around your surroundings, you would find your siblings getting study material from 

their school through mobile phones, your parents chatting with your relatives, sharing their 

experiences through smartphones, your neighbours paying their bills online, your cousin 

purchasing goods online, your friend studying through online courses, your doctor using 

medical instruments with the support of ICT. There are so many devices that are linked 

together to do daily business viz. CD, USB, smart phones, digital camera, remote controls, 

printers, scanners, etc.  

Hardware is the most visible part of any information system: the equipment such as 

computers, scanners, and printers are used to capture data, transform it, and present it to the 

user as an output. In this unit, we will focus mainly on the personal computer (PC) and the 

commonly used peripheral devices. 

Some commonly known range of computer systems are- 

 Supercomputers- The term Supercomputer is used to denote the fastest computing 

engines available at any given time that are used for running exceptionally demanding 

scientific applications. 

 Mainframe computers- It provides high-capacity processing and data storage facilities 

to hundreds or even thousands of users operating from dumb terminals. A dumb 

terminal is a display monitor that has no processing capabilities, because all it’s 

processing it depends on the server.  

 Servers- Servers have large data storage capacities enabling users to share files and 

application software though processing typically occurs on the user’s own machine. 

 Workstations- Workstations provide high-level performance for individual users in 

computationally intensive fields such as engineering. 
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 Personal computers (e.g. laptop/notebook computers) - They have a connected 

monitor, keyboard, and CPU that are developed into a convenient and flexible business 

tool, capable of operating independently or as part of an organizational network. 

 Mobile devices- such as personal digital assistants or the latest generation of cellular 

telephones offer maximum portability plus wireless connection to the internet, although 

they do not offer the full functionality of a PC. Also, we are already moving into the 

age of wearable computers for medical or security applications, embedded computers in 

appliances ranging from motor cars to washing machines, and the smart card which  

provide identification, banking facilities, medical records, and many more. 

3.4 POPULAR ICT (HARDWARE) RESOURCES 

Input Devices- 

Data may enter an information system in a variety of different ways and the most appropriate 

input device usually depends on the type of data being entered into the system. Following are 

the frequently used input peripherals- 

 Keyboard- A lot of input still happens with the help of a keyboard. Usually, the 

information that is entered by means of a keyboard is displayed on the monitor. The 

layout of most keyboards is similar to that of the original typewriter on which it was 

modelled.  

 Pointing Devices [Mouse]- The now ubiquitous electronic mouse is an essential input 

device for use with any graphical user interface. It consists of a plastic moulded 

housing designed to fit snugly in the palm of the hand with a small ball at its bottom. 

Moving the mouse across a flat surface will translate the movements into a rolling 

action of the ball. This is translated into electronic signals that direct the corresponding 

movement of a cursor on the computer monitor. Buttons on the mouse can then be used 

to select icons or menu items, or the cursor can be used to trace drawings on the screen. 

 Pointing devices [Trackball]- The less popular trackball operates exactly like an 

‘upside-down’ mouse except that the ball is much larger and  instead of the mouse 

being moved over a surface the user manipulates the ball directly. Originally popular in 

educational laboratory settings and for laptop computers, trackballs are now mainly 

confined to exhibition displays and other public terminals. 

 Touch Screens- Touch-screens are computer monitors that incorporate sensors on the 

screen panel itself or its sides. The user can indicate or select an area or location on the 

screen by pressing a finger onto the monitor. Light and touch pens work on a similar 

principle, except that a stylus is used, allowing much finer control. Touch pens are 

more commonly used with handheld computers such as personal organizers or digital 

assistants. They have a pen-based interface whereby a stylus (a pen without ink) is used 
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on the small touch-sensitive screen of the handheld computer, mainly by means of 

ticking off pre-defined options. Although, the fancier models support data entry either 

by means of a stylized alphabet, which resembles a type of shorthand, or some other 

more sophisticated handwriting recognition interface. 

 Digitizer- Digitizer tablets also use a pressure-sensitive area with a stylus. This can be 

used to trace drawings. A similar conceptual approach is used for the touchpad that can 

be found on the majority of new notebook computers, replacing the more awkward 

joystick or trackball. The user controls the cursor by moving a finger across a fairly 

small rectangular touch-sensitive area below the keyboard, usually about 5 cm by 7 cm. 

A large number of game interfaces have been developed to provide a more realistic and 

natural interface in various gaming situations and simulations: the joystick, steering 

wheel, foot pedal, and other gaming devices. They all perform functions similar to the 

mouse in that they allow the user to control a cursor or simulate generally real-time 

motion control. You can contact your nearest game arcade for further details. 

 Optical scanners and readers [Optical Scanner]- Optical Scanners use light-emitting 

devices to illuminate the printing on paper. On the basis of the amount of light emitted, 

a light sensor determines the position and darkness (or colour) of the markings on the 

paper. Special-purpose optical scanners are in use by postal services to read and / 

interpret hand-written postal codes. General-purpose scanners are used with personal 

computers to scan in images or text. These vary from handheld devices (see picture) to 

flatbed scanners which feed input documents one sheet at a time. A common use of 

optical scanners is the scanning of black-and-white or colour images and pictures. 

When scanning text, it is necessary to load additional optical character recognition 

(OCR) software that converts the scanned raster-image of the text into the equivalent 

character symbols, so that they can be edited using word processing software. 

 Optical scanners and readers [Barcode Scanner]- Barcode scanners detect sequences 

of vertical lines of different widths, the ubiquitous barcode as found also on the back of 

this book. These scanners have become very popular with retailers due to the fact that 

all pre-packaged products are now required to have a product bar code on their 

packaging, following the standard laid down by the South African Article Numbering 

Association (SAANA). Libraries and video shops now also commonly use bar code 

scanners. They are more generally used for tracking and routing large numbers of 

physical items such as for asset inventory purposes in many larger organizations, postal 

items by the postal services and courier services, or for luggage handling by airlines. 

 Optical scanners and readers [Optical mark readers]- Optical mark readers are 

capable of reading dark marks on specially designed forms. The red multiple-choice 

answer sheets in use at many educational and testing institutions are a good example. 
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 Magnetic Card Reader- A magnetic card reader reads the magnetized stripe on the 

back of plastic credit-card size cards. These cards need to be pre-recorded following 

certain standards. Although the cards can hold only a tiny amount of information, they 

are very popular for access (door) control and financial transactions (ATMs and point-

of-sale terminals). 

 Magnetic ink character recognition (MICR)- MICR uses a special ink (containing 

magnetisable elements) and a distinct font type. It is used mainly in the banking sector 

for the processing of cheques. 

 Touch-tone devices- Touch-tone devices can use a voice telephone to contact 

computer-based switchboards or enter information directly into remote computers. 

Many corporate telephone help-lines rely on the customer pressing the touch-tone 

telephone buttons to route his/her call to the correct operator by selecting through a 

menu of possible options. Indian banks also enable their clients to perform a number of 

banking transactions via telephone. 

 Biometric devices- Biometric devices are used to verify personal identity based on 

fingerprints, iris or retinal scanning, hand geometry, facial characteristics, etc. A 

scanning device is used to capture key measurements and compare them against a 

database of previously stored information. This type of authentication is becoming 

increasingly important in the control of physical access. 

 Voice-recognition devices- Voice-recognition devices has recently made a strong entry 

into the market with the availability of low-cost systems that work surprisingly well 

with today’s personal computers. These systems allow for voice control of most 

standard applications (including the operating system). With voice control, the 

computer recognizes a very limited number (50 or less) of frequently used, 

programmable system commands (“save”, “exit”, “print”) from a variety of users. In 

fact, these systems are not only used for the interface of computer programs, they are 

also slowly making an appearance in consumer appliances, novelty items, and even 

motor cars too. 

Output Devices- 

Output devices are used to transform computer-readable data back into an information format 

that can be understood by humans. Input devices collect data from users and process it at the 

CPU finally sending it to us an output. Following are the output devices used in computers-  

 Display screens [Cathode Ray Tube]- The desk-based computer screen is the most 

popular output device. The standard monitor works on the same principle as the normal 

TV tube: a ray gun fires electrically charged particles onto a specially coated tube 

(hence the name Cathode-Ray Tube or CRT). When the particles hit the coating, the 

coating is being excited and emits light. A strong magnetic field guides the particle 
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stream to form the text or graphics on your familiar monitor. CRTs vary substantially in 

size and resolution. Screen size is usually measured in inches diagonally across from 

corner to corner.  

 Display screens [Liquid Crystal Display] - A technology that has received much 

impetus from the fast-growing laptop and notebook market is the liquid crystal display 

(LCD). LCDs have matured quickly, increasing in resolution, contrast, and colour 

quality. Their main advantages are lower energy requirements and their thin flat size. 

Although alternative technologies are already being explored in research laboratories, 

they currently dominate the “flat display” market. 

 Display screens [Light Emitting Diodes]- Organic light-emitting diodes (OLED) can 

generate brighter and faster images than LED technology and require thinner screens, 

but they have less stable colour characteristics, making them more suitable for cellular 

telephone displays than for computers. 

 Screen Projectors- Originally developed for the projection of video films, the current 

trend towards more portable LCD-based lightweight projectors is fuelled by the needs 

of computer-driven public presentations. They are rapidly replacing the flat transparent 

LCD panels that needed to be placed on top of an overhead projection unit. Though the 

LCD panels are more compact, weightless, and are much cheaper. 

 Printers- Printers are the most popular output device for producing permanent, paper-

based computer output. Although they are all hardcopy devices, a distinction can be 

made between impact and non-impact printers. With impact printers, a hammer or 

needle physically hits an inked ribbon to leave an ink impression of the desired shape 

on the paper. The advantage of the impact printer is that it can produce more than one 

simultaneous copy by using carbon or chemically-coated paper. Non-impact printers, 

on the other hand, have far fewer mechanically moving parts and are therefore much 

quieter and tend to be more reliable. 

 Plotters- Plotters are mainly used for engineering and architectural drawings. A plotter 

consists of one (or several, in the case of colour plotters) pen(s) affixed to an arm. As 

the arm moves across the sheet of paper, the pen draws lines onto the paper. It is ideal 

for line drawings such as plans, especially in cases where the paper size exceeds that 

which can be accommodated by the other types of printers. 

 Sound output- It is required by most multimedia applications and sophisticated games. 

The sound card in many of today’s personal computers synthesizes sound by drawing 

from a library of stored sounds, essentially using the same process as found in music 

keyboards.  

 Musical Instrument Digital Interface (MIDI) - Modern day music production would 

be impossible without a vast array of electronic instruments and keyboards. These are 
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typically controlled by a personal computer by means of Musical Instrument Digital 

Interface, a common standard for linking, controlling and processing electronic music. 

 Speech synthesis- Speech synthesis is the production of speech-like output using an 

artificial voice. Although the lack of intonation still makes the voice sound artificial, 

the technology is reasonably mature and can be found anywhere from talking clocks 

and luxury cars to automated responses for telephonic directory enquiries. 

ICT Resources, helpful for technology-enhanced learning- 

 Tablet- A tablet computer (or sometimes called a tablet) is a type of computer that can 

be carried easily. Users control a tablet mostly by using its touch screen with multi-

touch technology similar to a smartphone. The screen can be anywhere from 7 inches 

(18 cm) (sometimes called a phablet) to 12 inches (30 cm) in size, but many have a 

screen size of about 10 inches (25 cm) diagonal. Almost all tablet computers can access 

the Internet using Wi-Fi, and many can use mobile phone networks like 2G, 3G, and 

4G. Tablets are lighter, more portable, have longer battery life, make less heat, and do 

not need a mouse or keyboard to be connected. Typing is usually done on the touch 

screen with a ‘virtual keyboard’ that appears on the screen.  

 Interactive Whiteboard- An interactive whiteboard is a large interactive screen that 

connects a computer and a projector. The projector projects the computer's desktop 

onto the screen of the interactive whiteboard. The user can control the computer by 

using a special pen, finger, or another tool to touch the screen of the interactive 

whiteboard. Normally, interactive whiteboards are fixed on walls. However, there are 

some mobile interactive whiteboards. Interactive whiteboards are used in many 

different places such as in classrooms, in workgroups, and in training rooms for 

professional coaching. Interactive whiteboards are the modern version of the traditional 

whiteboards used in schools. 

 Graphic Card- It is a circuit board that is placed inside the computer system to display 

images through the monitor. It ensures high-quality video at a high speed.  

 Sound Card- It helps the computer to convert digital signals into sound waves so that 

one can hear it. The sound card audio ports are placed at the back of the computer 

system and marked with different colours. For example white/yellow colour is used to 

mark digital out whereas the blue colour is used for sound in. 

 Network Card- Network Interface Card (NIC) helps the computer system to 

interconnect with local networks or the Internet. It contains the circuitry which is 

required to communicate and interact using wired or wireless connections. Wired 

connections are referred as Ethernet Connection (used in LAN) and wireless as in Wi-

Fi. It would not be possible to even send an email without NIC. 



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 3: ICT Resources and Applications- I  Page 36 of 166 

 Modem- Modem Stands for Modulator Demodulator. In order to share the data, we 

require two modems, sending modem and receiving modem. The sending modem 

converts the data into signals which can be transmitted through a phone line. The 

receiving modem demodulates the signals back to digital data. It converts the data in a 

suitable form so that it can be transferred from one device to another by changing 

analog signals into digital signals and vice versa. It is an interface between the user and 

the internet. There are two types of modem- (i) Ethernet - It is a wired modem which 

can be plugged into any network card, (ii) Wireless - It connects to a computer using 

wireless LAN(WLAN) 

 Router- It is the device that ensures the transfer of data from one network to the other. 

The information is sent from the source in small packets. It is the responsibility of the 

router to forward these data packets to the marked destination (receiver) by following 

appropriate routing protocol for find the optimum route. 

3.5 ICT (HARDWARE) RESOURCES AND APPLICATIONS 
Information and communication technology (ICT) can complement, enrich, and transform 

education for the better. UNESCO shares knowledge about the many ways technology can 

facilitate universal access to education, bridge learning divides, support the development of 

teachers, enhance the quality and relevance of learning, strengthen inclusion, and improve 

education administration and governance. We need to continue making new efforts to further 

develop the capacities of teachers and learners to make effective use of appropriate 

technologies for learning. Technology-enabled learning aims to focus on increasing access to 

quality teaching and learning by supporting policy formulation and innovation in the 

application of ICT in education, and the development of ICT skills. In order to understand the 

role and applications of ICT (hardware) in technology-enabled education one must be aware 

of hardware resources used in accessing ICT in everyday life. 

3.6 POINTS TO REMEMBER 
 To share data (send or receive) in networks we require two modems- sending modem 

and receiving modem. 

 There are two types of modem- (i) Ethernet- It is a wired modem that can be plugged 

into any network card (ii) Wireless- It connects to a computer using wireless LAN 

(WLAN). 

 The Network Interface Card (NIC) helps the computer system to interconnect with 

local networks or the Internet.  

 An interactive whiteboard is a large interactive screen that connects a computer and a 

projector.  

 Plotters are mainly used for engineering and architectural drawings.  
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 Biometric devices are used to verify personal identity based on fingerprints, iris or 

retinal scanning, hand geometry, facial characteristics, etc.  

 Digitizer tablets also use a pressure-sensitive area with a stylus. This can be used to 

trace drawings. 

3.7 GLOSSARY 

 Router- A device that ensures the transfer of data from one network to the other 

network. 

 Modem- Stands for Modulator Demodulator.  It converts the data in a suitable form so 

that it can be transferred from one device to another by changing analog signals into 

digital signals and vice versa. 

 Sound Card- It helps the computer to convert digital signals into sound waves so that 

one can hear it.  

 Screen Projectors- Originally developed for the projection of video films, the current 

trend towards more portable LCD-based lightweight projectors are in demand. 

 MICR- Uses a special ink (containing magnetisable elements) and a distinct font type. 

It is used mainly in the banking sector for the processing of cheques. 

 Supercomputers- The term Supercomputer is used to denote the fastest computing 

engines available at any given time that is used for running exceptionally demanding 

scientific applications. 

3.8 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) Define the role of hardware resources to the functioning of a computer system. 

b) List the input devices with their right uses. 

c) Explain the uses of different types of computer systems available. 

d) What do you understand by output devices? List the popular output devices. 

Objective type questions- 

a) A sound card helps the computer to convert digital signals into sound waves so that one 

can hear it.(True/False) 

b) MIDI stands for Musical Instrument Digital Interface.(True/False)   

c) Organic Light-Emitting Diodes (OLED) can generate brighter and faster images than 

Light Emitting Diodes (LED). (True/False) 
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d) A magnetic card reader reads the magnetized stripe on the back of plastic credit-card 

size cards. (True/False) 

e) Servers have large data storage capacities where users unable to share files and 

application software. (True/False) 

Answers (objective type question)- 

[a] True  [b] True  [c] True  [d] True  [e] False 
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4.1 INTRODUCTION 
There is an urgent need for quality software and digital materials for use in schools. Teachers 

and students must become discerning and knowledgeable ICT users. The school environment 

has to be fully supportive of ICT, making available expert assistance and advice to the 

teacher in this rapidly-changing field. New forms of curriculum and assessment are called for 

new ways of organising schools if the dramatic educational potential of ICT is to be delivered 

and realised. A report made by the National Institute of Multimedia Education in Japan 

proved that an increase in the use of ICT in education with integrating technology to the 

curriculum has a significant and positive impact on student achievements. The results 

specifically showed that the students who are continuously exposed to technology through 

education has better ‘knowledge’, presentation skills, innovative capabilities, and are ready to 

take more efforts into learning as compared to their counterparts. In this unit, we will discuss 

ICT resources from the viewpoint of software resources used for technology-enhanced 

education. 
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4.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Understand the overview of the software and its role. 

 Explore the types of software. 

 Define Operating system, its functions, and types. 

 Define programming languages. 

 Explore the free and Open Source Software (FOSS). 

4.3 SOFTWARE OVERVIEW 
Software is a way to communicate with the blind hardware of the computer system. It 

consists of all the instructions that tell the hardware how to perform a task. Software is 

developed through a programming language. Software, commonly known as programs or 

apps can be broadly divided into two categories- (i) System Software and (ii) Application 

software.  

System software helps to run the computer hardware and computer system itself. System 

software includes operating systems, device drivers, diagnostic tools, and more. An operating 

system is a type of system software that manages the hardware and creates the interface 

between the hardware and the user.  

Application software allows users to accomplish one or more tasks. It is meant to perform 

several tasks for the user including word processing, web browsing, and other task which 

require installation of the software. Applications software are designed and developed as per 

the users/customers requirements. 

4.4 TYPES OF SOFTWARE 

[1] System Software-  

System software comprises device drivers, operating systems, servers, software components, 

and programming software (for writing programs through tools such as editors, linkers, 

debuggers, compilers/interpreters, and others). The most important is the operating system, 

here we will discuss the operating system. 

Operating System- 

An operating system handles signals or instructions received from input and output devices, 

manages memory usage, and control peripherals. Therefore, the operating system is the most 

important program a computer must run on. DOS (Disk Operating System), Microsoft 

Windows XP, and Mac OS are some examples of personal computer operating systems. 

Server-level computers use operating systems such as UNIX and Microsoft Windows Server. 
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Portable devices, such as cellular phones, smartphones, and personal data assistants use 

specialized, ‘embedded’ operating systems that enable them to do many tasks. Some of the 

functions operating system include- starting the computer (also called ‘booting’), managing 

and monitoring other programs, memory management, communications management, 

management of peripheral devices, enabling interaction between the user and the computer 

system through the use of external input devices, monitoring and security of access to data 

and applications. 

Today’s personal computers use a Windows-based operating system that incorporates many 

of the original concepts in DOS. Operating systems differ in functionality, flexibility, and 

ease of use. Today there are a number of different operating systems in use. They can be as 

either classified as personal operating systems, network (client/servers) operating systems, 

and handheld operating systems.  

To interact with the computers a user uses a part of the operating system called a user 

interface. The functions of the user interface are to start application programs, manage 

secondary storage, such as hard disks, as well as manipulate files and folders, and finally shut 

down the computer safely. The three principal types of interfaces are- 

 Graphical User Interface (GUI) 

 Command‐line interface/Character User Interface (CUI) 

A graphical user interface is a form of user interface that allows users to interact with 

electronic devices through graphical icons, menu and an audio indicator such as primary 

notation. A GUI is a user‐friendly interface that eliminates the need to remember complex 

computer commands. CUI is a way for users to interact using commands with computer 

programs. In CUI based computers user interacts using text-based commands. Examples 

CUIs are MS-DOS and the Windows Command Prompt. 

Functions of an Operating System- 

 Managing computer resources- The operating system allows application software 

programmes such as word processing, spreadsheet, and database packages to 

communicate with the computer’s hardware. For example, if you work on a document 

in Excel and you want to print the document, you just press the print button on the 

toolbar. Excel will direct the operating system to select a printer to print the document. 

The operating system then notifies the computer to begin sending data and instructions 

to the appropriate program to get the document printed. The operating system, 

therefore, acts as an interface between the application programmes and the hardware. 

 Managing files and memory- The operating system manages all files on a computer. It 

keeps tracks of the locations where programmes and data are stored within the 

computer’s memory. For example, when you open a file that has been saved to the hard 
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drive you are first instructing the computer to find the file and then to open it. The 

operating system also allows you to easily find files stored in secondary storage 

devices. Other file management functions include copying, erasing, renaming, and 

backing‐up files. 

 Maintaining security- In networks and larger computers, each user is given a user name 

or ID and password to gain access to the computer system. The operating system keeps 

a register of all these names so that only persons with valid usernames and passwords 

can access the system. This prevents access by hackers and unauthorised persons. The 

operating system also keeps a log to records users logged in, the length of time each 

user stayed on the system, and the tasks they performed. Administrators can check the 

log to look for security breaches and the abuse of resources. 

 Managing tasks- A computer can perform many tasks simultaneously. One way of 

doing this is multi‐tasking – the ability of the computer to run more than one 

programme at the same time. For example, a user can listen to music on his/her 

computer while typing a document or typing an e‐mail while another e‐mail is being 

sent. In the case of networks, the multiuser operating system allows more than one user 

to access the same data at the same time. 

 Providing a user interface- Many operating systems functions are never apparent on the 

computer’s display screen. What you see on the screen is called the user interface. The 

interface helps the user to interact with the computer. 

Types of operating systems- 

[a] Batch operating system- 

It is a type of operating system where users directly do not interact with the computer system.  

The user prepares his/her job in the form of batch (a group of tasks) and submits it to the 

computer for processing. To speed up processing, jobs with similar needs are batched 

together and run as a group. The batch operating system have some difficulties- lack of 

interaction between the user and the job, slower speed of the mechanical I/O devices than the 

CPU, difficulty in providing the desired priority, etc. However, some advantages  involved 

with the batch operating system are- It is very difficult to guess time required for any job to 

complete, processors of the batch systems know how long the job would be when it is in a 

queue, the idle time for the batch system is very less, etc. 

[b] Time-sharing operating systems- 

Time-sharing is a technique that enables many people located at various terminals to use a 

particular computer system at the same time. Time-sharing or multitasking is a logical 

extension of multiprogramming. The processor's time which is shared among multiple users 

simultaneously is termed as time-sharing. The main difference between Multiprogrammed 
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Batch Systems and Time-Sharing Systems is that in the case of Multi programmed batch 

systems, the objective is to maximize processor use, whereas, in Time-Sharing Systems, the 

objective is to minimize response time.  

[c] Distributed Operating System– 

The distributed operating systems are referred to as loosely coupled systems or distributed 

systems. These system’s processors differ in size and function. The major benefit of working 

with these types of operating system is that it is always possible that one user can access the 

files or software which are not present on his system but some other system connected within 

this network i.e., remote access is enabled within the devices connected in that network. 

[d] Network operating System- 

A Network Operating System runs on a server and provides the server the capability to 

manage data, users, groups, security, applications, and other networking functions. The 

primary purpose of the network operating system is to allow shared file and printer access 

among multiple computers in a network, typically a local area network (LAN), a private 

network, or to other networks. Examples of network operating systems include Microsoft 

Windows Server 2003, Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell 

NetWare, and BSD. The network operating systems are having the following features- 

centralized servers, high security at the server level, upgrades to new technologies and 

hardware that can be easily integrated into the system, etc. 

[e] Real-time operating System- 

A real-time system is defined as a data processing system in which the time interval required 

to process and respond to inputs is so small that it controls the environment. The time taken 

by the system to respond to an input and display of required updated information is termed as 

the response time. A real-time operating system must have well-defined, fixed time 

constraints, otherwise, the system will fail. For example, scientific experiments, medical 

imaging systems, industrial control systems, weapon systems, robots, air traffic control 

systems, etc. 

[2] Application Software- 

Computer software is basically programs and procedures intended to perform specific tasks 

on a computer system. The user directly deals with the application software for a specific 

purpose. The application software (program) also called end-user programs or apps can be a 

single program or a group of small programs often referred as an application suite. Some 

examples of application software are- 

 Word processing software (example- MS Word, WordPad, and Notepad). 

 Database software (example- Oracle, MS Access, MY SQL, etc). 
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 Spreadsheet software (example- Apple Numbers, Microsoft Excel, Open Office). 

 Multimedia software (example- Real Player, Media Player, VLC player, etc). 

 Presentation Software (example- Microsoft PowerPoint, Keynotes, open office, etc). 

 Enterprise Software (example- Customer relationship management system, Hospital 

Management Software, etc). 

 Information Worker Software (example- Documentation tools, resource management 

tools, etc). 

 Educational Software (example- dictionaries like Encarta and Britannica, mathematical 

software like MATLAB  and others  like Google Earth, NASA World Wind). 

 Simulation Software (example- Flight and scientific simulators). 

 Application Suites (example- OpenOffice, Microsoft Office). 

 Software for Engineering and Product Development (example- IDE or Integrated 

Development Environments). 

Utility programs- 

Utility programs, as the name suggests not only help in executing various crucial tasks for the 

operating system but also help in the overall maintenance of the computer system. Operating 

systems such as Windows, macOS, and Linux come with their own set of utility programs to 

maintain and execute different utility functions such as formatting, compressing, scanning, 

exploring, and much more. Utility programs also assist with the management of computer 

functions, resources, and files. Some common tasks performed by utility programs are- Disk 

Defragmentation, Disk Clean-up, File Management, Compression, Disk Management, 

Antivirus, Firewall, etc. 

4.5 PROGRAMMING LANGUAGES 
Do you use various applications (apps) in your smart phone? Do you ever think about how to 

develop these apps? Answer is simple, all the applications are developed using programming 

languages. There are a bunch of programming languages available. A computer is a device 

that can accept human instruction, processes it, and responds to it. In other words, a computer 

is a computational device which is used to process the data under the control of a computer 

program.  

Computer programming languages allow us to give instructions to a computer in a language 

the computer understands. Just as many human-based languages exist, there is a list of 

computer programming languages that programmers can use to communicate with a 

computer. The portion of the language that a computer can understand is called a binary. 

Translating programming language into computer understandable language (or in binary) is 
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known as ‘compiling.’ Each programming language has it’s own translator (except machine 

language). Some popular languages of computer are- C, Python, C++, C#, R, Ruby, ADA, 

Java, Visual BASIC, Perl (Practical Extraction and Report Language), PHP, JavaScript, 

PROLOG (Programming in Logic), Document formatting languages (e.g. TeX, PostScript, 

SGML), etc. 

A computer program is a sequence of instructions along with data to process needful action. 

In other words, a computer is a computational device that is used to process the data under 

the control of a computer program.  

So, these computer programs are written using a programming language which is called high-

level programming languages. High-level programming languages are nearly human 

languages which are more complex than the computer understandable (computer only 

understands binary language) language which is called machine language, or low-level 

language. Basically, computer programming languages are divided into two categories, as- 

low-level language and high-level language.  

Example of a low-level programming language is machine language. 

Examples of some high-level programming languages are- FORTRAN (Formula 

Translation), ALGOL (Algorithmic Language), LISP (List Processing), COBOL (Common 

Business-Oriented Language), BASIC (Beginner’s All-purpose Symbolic Instruction Code), 

SQL (Structured Query Language), Pascal, Logo, Ada, etc. 

Note- The advantages of both the low- and high-level programming language are merged 

within the middle-level languages. Examples of such languages are- C, C++, JAVA, C#, etc. 

Characteristics of a programming Language– 

 A programming language must be simple, easy to learn and use, have good readability, 

and is human recognizable. 

 A portable programming language is always preferred. 

 Programming language’s efficiency must be high so that it can be easily converted into 

machine code and executed consumes little space in memory. 

 A programming language should be well structured and documented as it is suitable for 

application development. 

 Necessary tools for development, debugging, testing, and maintenance of a program 

must be provided by a programming language. 

 A programming language should provide a single environment known as the Integrated 

Development Environment (IDE). 

 A programming language must be consistent in terms of syntax and semantics. 
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4.6 INTRODUCTION TO OPEN SOURCE SOFTWARE 
Open-source software is released through a specific kind of license that makes its source code 

legally available to end-users. There are many such licenses, but typically software is 

considered open source if- 

It is available in source code form without additional cost i.e. users can view the code that 

comprises the software and make any kind of changes to it they want. 

The source code can be repurposed into other new software, meaning anyone can take the 

source code and distribute their program from it. 

Is open-source software always free? 

Open-source software does not necessarily mean that executable software is given always 

free because converting that source code into an enforceable code requires expertise, time, 

and servers.  

Open-source software is also sometimes conflated with the free software movement, which 

can add to the confusion around whether open source means ‘free.’ The free software 

movement grew out of the ‘hacker culture’ of the 1970s and was formally founded by 

Richard Stallman as part of the GNU Project and the non-profit Free Software Foundation. 

Usually, ‘free software’ is meant to emphasize freedom in the rights of end-users, but can 

sometimes be confused as meaning ‘free of cost.’ 

One thing is interesting, neither free software nor open-source software denotes anything 

about cost both the kinds of software can be legally sold or given free. The primary 

difference between them has to do with the sharing. For free software, if you make changes to 

source code and want to share them, you also have to share those changes back with the 

original project. For open-source software, there is typically no such restriction. Despite their 

practical differences, free software and open-source software do share common values. Both 

the terms 'free' and 'Open Source' are combined in a common phrase, as “Free and Open 

Source Software” (FOSS). 

FOSS vs. Proprietary Software- 

The key difference between proprietary software and FOSS is the availability of the source 

code. Proprietary or commercial software like Microsoft Windows and Adobe Photoshop are 

not available to end-users as source code where free software like the Linux kernel and open-

source software such as Google Chromium (the basis of the Chrome web browser) are 

available as source code through their respective licenses. 

The Open source license allows software to be freely used, modified, and shared. It should 

also be approved by the Open Source Initiative (OSI), a license must go through the Open 

Source Initiative's license review process. Some popular open-source licenses are- Apache 
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License 2.0, BSD 3-Clause ‘New’ or ‘Revised’ license, BSD 2-Clause ‘Simplified’ or 

‘FreeBSD’ license, GNU General Public License (GPL), GNU Library or Lesser General 

Public License (LGPL), MIT license, Mozilla Public License 2.0, Common Development and 

Distribution License and Eclipse Public License version 2.0. 

Why does Open-source software matter? 

Open-source software matters to everyone, not just programmers because it unlocks the 

potential of many more people to become innovators than a closed-source (proprietary 

Software) model. Open source communities, for instance, are organized around open source 

projects where anyone with skills can join and contribute code. These groups still maintain 

standards around contributing to open source projects just like proprietary software teams do 

but they open up this process to anyone in the world who wants to contribute. 

This open-source development model has resulted in some of the most important applications 

and cloud platforms in use today. The most popular of which comprise LAMP (Linux, 

Apache, MySQL, PHP), a model of service stacks that undergird much of the web.  

Brief about LAMP- 

Linux- is an open-source Operating System (OS) and the largest open source project in the 

world. 

Apache- is an open-source cross-platform web server that played a key role in the early web. 

MySQL- is an open-source Relational Database Management System (RDBMS) used by 

many database-driven web applications. 

PHP- a general purpose scripting language used in software development (Perl or Python 

languages are sometimes substituted). 

Other examples of popular open source technologies include the Android mobile OS, the 

Mozilla Firefox web browser, the widely-used version control system Git, and the two related 

office suites OpenOffice and LibreOffice. On a broader scale, most innovation in the areas of 

cloud computing, big data, and artificial intelligence have been derived from open-source 

software projects.  

Open-source software has other advantages for businesses and individual programmers. 

When source code is open, it makes it easier for anyone to study it to develop new 

programming skills. Open-source licensing also allows students to get practice by editing the 

code and sharing it with friends and the broader open-source community, or even 

contributing fixes to existing open source projects. The open-source software also offers 

businesses the ability to customize it to meet their specific needs. Some also prefer open-

source software because there are many more developers looking for security vulnerabilities 

when the source code is openly available and has an active community supporting it. The 
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open-source way is so effective because it can attract tremendous technical talent much of the 

innovation in technology is taking place in the open source community, and people all over 

the world end up using open-source software. 

SourceForge (https://sourceforge.net)- 

SourceForge is an Open-Source software community resource dedicated to helping open-

source projects as successful as possible. It helps to create a premiere resource for open-

source software development and distribution. 

With the tools it provides, developers on SourceForge create powerful software in over 

502,000 projects and host millions of registered users. It also connects more than 32 million 

monthly users with all of these open source projects and serves more than 2.6 million 

downloads a day. The SourceForge business software directory lists over 50,000 software 

titles. IT professionals come to SourceForge to develop, download, review and publish open 

source, and business software. SourceForge is the largest, most trusted destination for Open 

Source Software discovery, software reviews, and software development on the web. 

4.7 POINTS TO REMEMBER 
  Software is a way to communicate with the blind hardware of the computer system. It 

consists of all the instructions that tell the hardware how to perform a task.  

 System software helps to run the computer hardware and computer system itself. 

System software includes operating systems, language translators, device drivers, 

diagnostic tools, and more.  

 Application software is the category of programs which include word processing, web 

browsing, and almost any other task for which you might install the software. 

Applications software are designed and developed as per the users/customers 

requirements. 

 An operating system handles signals or instructions received from input and output 

devices, manages memory usage, and control peripherals. 

 Some of the functions operating system include- starting the computer (also called 

‘booting’), managing and monitoring other programs, memory management, 

communications management, management of peripheral devices, enabling interaction 

between the user and the computer system through the use of external input devices, 

monitoring and security of access to data, and applications. 

 To interact with the computers, a user uses a part of the operating system called a user 

interface, which is basically of two types e.g. Graphical User Interface (GUI), 

Character User Interface (CUI). 
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 The operating system manages all files on a computer. It keeps tracks of the locations 

where programmes and data are stored within a computer’s memory. 

 A Network Operating System runs on a server and provides the server the capability to 

manage data, users, groups, security, applications, and other networking functions. 

 Time-sharing is a technique that enables many people located at various terminals to 

use a particular computer system at the same time. 

 Utility programs not only help in executing various crucial tasks for the operating 

system but also help in the overall maintenance of the computer system. 

 Computer programming languages allow us to give instructions to a computer in a 

language the computer understands. Just as many human-based languages exist, there is 

a list of computer programming languages that programmers can use to communicate 

with a computer.  

 Open-source software is released through a specific kind of license that makes its 

source code legally available to end-users. 

4.8 GLOSSARY 

 GUI- Graphical User Interface. 

 CUI- Character User Interface. 

 LAMP- Linux, Apache, MySQL, and PHP. 

 FOSS- Free and Open Source Software. 

 IDE- Integrated Development Environment. 

 DOS- Disk Operating System. 

4.9 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) Why does open source software matter? 

b) Define FOSS and Proprietary Software. 

c) Is open-source software always free? 

d) What do you understand by programming languages? 

e) Define the role of Application software. 

f) Briefly define the types of operating system. 

g) Why Operating system is important for the execution of a computer system? 
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Objective type questions- 

a) System software includes operating systems, language translator, device drivers, etc. 

(True/False) 

b) Operating systems differ in functionality, flexibility, and ease of use. (True/False) 

c) The operating system manages only folders on a computer. (True/False) 

d) A Network Operating System runs on a server and provides the server the capability to 

manage data, users, groups, security, applications, and other networking functions. 

(True/False) 

e) The operating system keeps tracks of the locations where programmes and data are 

stored within the computer’s memory. (True/False) 

f) A computer program is a sequence of instructions along with a memory to process 

needful action. (True/False) 

g) The Open source license allows software to be freely used, modified, and shared. 

(True/False) 

Answers (objective type question)- 

[a] True   [b] True   [c] False   [d] True   

[e] True   [f] False   [g] True 
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5.1 INTRODUCTION 
The applications of ICT in our daily life have changed the ways individuals access and 

elaborate knowledge. In the 21st century, digital skills are essential for learning and even 

living a successful life (accessing resources at anytime and anywhere). In order to grab the 

new opportunities, digital technologies are opening possibilities in many areas. Individuals 

have to develop the right set of skills to make meaningful use of these technologies in their 

life. Increasing use of digital technologies at work (especially in teaching & learning) is 

raising the demand for new skills along with the following directions-  

 ICT specialist skills to programme, develop applications, and manage networks. 

 ICT generic skills to use such technologies for professional purposes. 

 ICT complementary skills to perform new tasks associated to the use of ICTs at work, 

e.g. information-processing, self-direction, problem-solving, and communication. 
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Raising the demands of new-age skills, digital technologies are also creating new 

opportunities for skills development. Massive Online Open Courses (MOOCs) and Open 

Educational Resources (OER) modify learning methods and give access to quality resources 

to a larger population. The use of digital technologies in formal education and vocational 

training has the potential to improve learning, although the outcomes depend on the capacity 

to link these tools to effective pedagogy. Here we are going to elaborate on some useful ICT 

resources and repositories for future use and access as well as we will briefly describe the 

overview of the Learning Management System (LMS). 

5.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define new age learning skills. 

 Explore open education and learning initiatives. 

 Explore digital repositories for e-learning. 

 Define Learning Management System. 

5.3 ICT RESOURCES AND NEW AGE LEARNING SKILLS- 
Knowledge involves two components, e.g. inter-linked content and skills. Content includes 

facts, ideas, principles, evidence, and descriptions of processes or procedures. Generally, 

subject instructors are well trained in content and have a deep understanding of the subject 

areas in which they are teaching. Skill development is the process of lifelong learning. The 

new-age learning skills include- 

 Communications Skills- With the traditional communication skills of reading, speaking, 

and writing coherently and clearly we need to add social media communication skills. 

These might include the ability to create a short YouTube video to capture the 

demonstration of a process or to pitch sales, the ability to reach out through the Internet 

to a wide community of people with one’s ideas, to receive and incorporate feedback, 

to share information appropriately, and to identify trends and ideas. 

 The ability to learn independently- To take responsibility for working out what you 

need to know and where to find that knowledge. This is an ongoing process in 

knowledge-based work because the knowledge base is constantly changing. It could be 

learning about new equipment, new ways of doing things or learning from whom do 

you need to get the job done. 

 Ethics and responsibility- Are the essential values required to build trust in both the real 

and the business world where there are many different players and a greater degree of 

reliance on others to accomplish one’s own goals. 
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 Teamwork and flexibility- Although many workers work independently or in very 

small companies they depend heavily on collaboration and the sharing of knowledge 

with others in related but independent organizations.  

 Thinking Skills- e.g. critical thinking, problem-solving, creativity, originality, and 

strategizing are one of the most important skills needed in a knowledge-based society. 

The teaching community should have always pride in themselves on teaching such 

intellectual skills. 

 Digital Skills- Most knowledge-based activities depend heavily on the use of 

information technology. However, the key issue is that these skills need to be 

embedded within the knowledge domain in which the activity takes place. The use of 

digital technology needs to be integrated and evaluated through the knowledge-base of 

the subject area. 

 Knowledge Management- Is perhaps the most over-arching of all the skills. Knowledge 

is not only rapidly changing with new research, new developments, and rapid 

dissemination of ideas and practices over the Internet. But the sources of information 

are increasing with a great deal of variability in the reliability or validity of the 

information. 

5.4 
OPEN EDUCATION AND OPEN LEARNING 
INITIATIVES 

Open education is education without academic admission requirements and is typically 

offered online. Open education broadens access to the learning and training traditionally 

offered through formal education systems. The qualifier ‘open’ refers to the elimination of 

barriers that can preclude both opportunities and recognition for participation in institution-

based learning. One aspect of openness or ‘opening up’ education is the development and 

adoption of open educational resources. (Source: 

https://en.wikipedia.org/wiki/Open_education). 

Programs are commonly offered by the educational institutions in online mode or using open 

and distance learning mode like e-learning, MOOC, and Open Course Ware to eliminate the 

entry barriers e.g. with no academic admission requirements. Where many e-learning 

programs are free to follow the costs of acquiring a certification may be a barrier. Thus, many 

open education institutes offer free certification schemes accredited by organizations. 

In other words, open education is a collection of practices that utilize online technology to 

freely share knowledge. The open education movement not only includes the sharing of 

knowledge but also follows the following features- 

 Publishing research in open journals (open access publishing) 
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 Releasing data to be reused by others (open data) 

 Using, sharing and collaboratively creating software and computer code (open-source 

software) 

 Flexible admission policies to institutions or courses (open admissions or open 

registration) 

 Student assignments that promote student publishing or participating on the open web 

(open teaching or open pedagogy) 

 Sharing of teaching and research practices (open scholarship) 

 Sharing and reuse of teaching and learning materials (open educational resources) 

including courses (open courseware) and textbooks (open textbooks) 

The above literature is a thematic idea to briefly understand the open education and the types 

of activities that the 'open education' encompasses. The 'open education' develops the 

learning opportunity for the deprived section of the society with quality learning material 

globally. To grab the advantages of open education movement someone needs to have basic 

IT literate and Internet savvy. 

List of useful resources to access quality learning material- 

[a] Open Learning initiatives at Carnegie Mellon University (https://oli.cmu.edu/learn-

more-about-oli)- 

You may visit the above link, to freely access the bunch of courses offered under Open 

Learning initiatives (OLI). 

[b] Open Learning Initiative at Stanford University (http://oli.stanford.edu)- 

Open Learning initiative courses are openly and freely available to anyone in the world at 

Stanford University who wants to learn- whether you are a student at a college or university 

or learning on your own; you can avail the OLI courses using the following link- 

http://oli.stanford.edu. 

[c] Open Learning at Harvard (https://www.extension.harvard.edu/open-learning-

initiative)- 

One can visit the Harvard Open learning initiatives and explore the open courseware (free 

courses). 

[d] Open Learning at lumen learning (https://lumenlearning.com/courses)- 

One can visit the lumen learning (https://lumenlearning.com/courses) initiatives of open 

learning and explore the open courseware (free courses). 
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5.5 
LIST OF POPULAR DIGITAL REPOSITORIES FOR 
TECHNOLOGY ENABLED EDUCATION 

Online Learning Resources (under the NMEICT, MHRD, Govt. of India)- 

 E-PG Pathshala (epgp.inflibnet.ac.in) - e-PG Pathshala is an initiative of the MHRD 

under its National Mission on Education through ICT (NME-ICT) being executed by 

the UGC. e-Adhyayan, e-Pathya, and UGC-MOOCs are more initiatives of NMEICT 

where under e-Adhyayan 700+ e-Books and video contents for the Post-Graduate 

Courses are provided. 

 NCERT e-books (www.ncert.nic.in/textbook/textbook.htm)-  

 Spoken Tutorial (www.spoken-tutorial.org)- It is an educational content portal where 

one can learn various Free and Open Source Software by oneself. The courses offered 

are of self-paced, multi-lingual that anybody with a computer and a desire for learning, 

anyone can learn from any place, at any time and in a language of their choice. 

 Digital Library Inflibnet (www.inflibnet.ac.in)- The Ministry of Human Resource 

Development (MHRD) has formed e-ShodhSindhu merging three consortia initiatives, 

namely UGC-INFONET Digital Library Consortium, National Library, and 

Information Services Infrastructure for Scholarly Content (NLIST) and Indian National 

Digital Library in Engineering Sciences and Technology (INDEST)-All India Council 

for Technical Education (AICTE) Consortium. The e-ShodhSindhu provides current as 

well as archival access to more than 15,000 core and peer-reviewed journals and many 

bibliographic, citation, and factual databases in different disciplines. 

 SWAYAM PRABHA (TV Channel)-  

 E-pathshala (www.epathshala.nic.in)-  

 Tamanna (www.ncert.nic.in/tamanna/tamanna.html)-  

 NISHTHA (www.itpd.ncert.gov.in)-  

 Talk to Teacher (aview.in)- A-VIEW is an indigenously built multi-modal, multimedia 

e-learning platform that provides an immersive e-learning experience that is almost as 

good as a real classroom experience. A-VIEW is part of the talk to a teacher program 

coordinated by IIT Bombay and funded by the Ministry of Human Resource 

Development (MHRD). 

 Consortium for Educational Communication (www.cec.nic.in)- It is an Inter-University 

Centers set up by the University Grants Commission (UGC) of India.  It has been 

established to address the needs of higher education through the use of a powerful 
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medium of television along with the appropriate use of emerging Information 

Communication Technology (ICT). 

 FOSSEE (www.Fossee.in)- Free Open Source Software for Education (FOSSEE) 

project promotes the use of FOSS tools to improve the quality of education in our 

country. This project aims to reduce dependency on proprietary software in educational 

institutions. 

 E-Kalpa (www.dsource.in)- This project presents three initiatives – providing digital 

online content for the design, a social networking environment for design & higher 

learning, and creating a digital resource database on design. The project would focus on 

knowledge accumulation, storing and dissemination, and education in four sectors - 

University, Industry, Government, and the Informal sector. 

 Virtual Labs (www.vlab.co.in)- This initiative has been taken by the Ministry of 

Human Resource Development (MHRD). Virtual Labs project is a consortium activity 

of 12 participating institutes among them, the IIT Delhi is coordinating institute. Virtual 

Labs do not require any additional infrastructural setup for conducting experiments at 

user premises. The intended beneficiaries of this project are- all students and faculty 

members of science and engineering, high‐school students whose inquisitiveness will 

be triggered, researchers, and engineering colleges who can share the given resources. 

 Open Source Courseware Animations Repository 

(http://oscar.iitb.ac.in/oscarHome.do)-  

 E-Yantra (www.e-yantra.org)- The e-Yantra is an initiative to spread education in 

embedded systems and robotics by IIT Bombay, sponsored by the Ministry of Human 

Resource & Development (MHRD). The objective of this project is to provide hands-on 

learning to engineering students who have limited access to labs and mentors. The goal 

is to create the next generation of (Embedded Systems) engineers in India with a 

practical outlook to take on challenging problems and provide solutions. 

 Quantum & Nano Computing (www.dei.ac.in/dei/quantumNano)- The Quantum-Nano 

Centre is a multidisciplinary centre at Dayalbagh Educational Institute, Agra. The 

mission of this project is to aggressively explore and advance the application of 

quantum-nano systems to a vast array of relevant information processing techniques. 

 Expert Database & National Researcher Network (vidwan.inflibnet.ac.in)-  

 Indian Research Information Network System (irins.org/irins)- 

Open Educational Resources- 

 NPTEL (www.nptel.ac.in)- 
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 SWAYAM (www.swayam.gov.in)- 

 NROER (www.nroer.gov.in)-  

 Saylor Academy (www.saylor.org)- 

 OER Commons (www.oercommons.org)- 

 Khan Academy (www.khanacademy.org)- 

 MIT BLOSSOMS (www.blossoms.mit.edu)- 

 COL Virtual Learning (www.colvee.org)- 

 Directory of OER (www.doer.col.org)- 

 COL’s Institutional Repository (www.oasis.col.org)- 

 Virtual University of Pakistan (www.ocw.vu.edu.pk)- 

 LabXchange (www.labxchange.org)- 

 MIT Open CourseWare (www.ocw.mit.edu)- 

 Lumen Courses (www.lumenlearning.com)- 

 MERLOT- Online Learning Resources (www.merlot.org)- 

 eCampus- Learning Resources (www.ecampusontario.ca)-  

 Skills Commons (www.skillscommons.org)- 

Quizzes/ Testing / Games- 

 Book Widgets (www.bookwidgets)- Worksheets, simulations, games & more for use in 

classrooms and multi-touch books. 

 Class kick (www.classkick.com)- Easy real-time feedback & formative assessment. 

 Class marker (www.classmaker.com)- Easy online testing. 

 Class tools (www.classtools.net) - Several class tools of any kind. 

 DeckToys (https://deck.toys) - Drag-and-drop lesson creation, differentiate the right 

way, full control over your lesson delivery and tracking your progress in real-time. 

 Educaplay (educaplay.com) - Create numerous interactive games with instant feedback. 

 Flipgrid (https://info.flipgrid.com) - Create a Grid - that’s your classroom or 

community. Add a Topic or two to spark the discussion. Your students share short 

video responses to ignite a dialogue. Super simple. Super powerful.. 

 Google Forms (http://forms.google.com)- Easy for quizzes, evaluations or 

questionnaires. 
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 Goosechase - Scavenger hunts for the masses. Bold, crazy, and highly addictive. 

Incredibly easy to use with all the power you could ever want. 

 Gynzy - Gynzy is an online whiteboard helping teachers create engaging lessons plans 

to engage students in the classroom. 

 H5P (www.h5p.org) - Create, share, and reuse interactive HTML5 content in your 

browser. 

 Learnclick (www.learnclick.com) - Create online cloze quizzes. Simply mark words to 

turn them into gaps, dropdown or drag & drop quizzes. 

 Poll Everywhere (www.polleveryone.com)- Live interactive audience participation. 

Engage your audience or class in real-time. 

 Quizizz (www.quizizz.com) - Quizizz is a fun review tool that allows the entire class to 

practice together. It’s completely free.  

 SurveyMonkey (www.surveymonkey.com)- Create Surveys, Get Answers. 

5.6 
BRIEF OVERVIEW OF LEARNING MANAGEMENT 
SYSTEM 

The Learning Management System (LMS) may be defined in the user perspective as a virtual 

environment that aims to simulate face-to-face learning environments with the use of 

Information Technology. In LMS, the interaction happens through devices that enable 

communication either synchronously or asynchronously allowing the creation of different 

strategies to encourage dialogue and active participation of students. Learning Management 

Systems are web-based systems that enable teachers and students to share materials, submit 

& return assignments, and to communicate online. The LMS, mediation involves both the 

acquisition of competences and communication skills for all the teachers and students as well 

as creation of interactive moments and practical application possibilities for collaborations. 

To establish such communication we used chat rooms, forums, blogs, video blogs, etc. 

The LMS is enabled to integrate multiple media, different languages & resources while 

enabling alternative technologies and presenting information in an organized manner to fulfil 

its main purpose which is the construction of learning through interaction. The well-planned 

and designed courses perform the key role in teaching-learning using LMS, which is 

necessary for e-learning quality. There are several LMS (software) options available in the 

market including commercial or proprietary and free and open-source software. Some top 

rated LMS options are- BlackBoard (proprietary), Breeze, Moodle (Free and Open Source), 

plus dotLRN and the Sakai Project, etc.  

In relation to quality standards in LMS, considering the development of information 

technology and the growing use of these LMS environments, the importance of identifying 
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those that comply with minimum requirements arises. These requirements can be expressed 

in terms of reliability, scalability, security, sustainability, and adoption of international 

standards of quality. Reliability can be obtained through the experience of large universities 

in using virtual fields for face-to-face or distance education. Scalability is needed to attend to 

the large numbers of students, a fundamental characteristic of e-learning. The adoption of 

international quality standards largely depend on the developer team and the options for 

meeting the needs and goals of users which can differentiate virtual environment. 

5.7 POINTS TO REMEMBER 
 The applications of ICT in our daily life have changed the ways individuals access and 

elaborate knowledge. 

 Individuals have to develop the right set of skills to make meaningful use of ICT in 

their life. Increasing use of digital technologies at work (especially in teaching learning) 

is raising the demand for new skill sets. 

 Knowledge involves two components e.g. content and skills 

 Most knowledge-based activities depend heavily on the use of information technology.   

 Open education is education without academic admission requirements and is typically 

offered online. Open education broadens access to the learning and training 

traditionally offered through formal education systems. 

 The open education is a collection of practices that utilize online technology to freely 

share knowledge. 

 The Learning Management System (LMS) may be defined in the user perspective as a 

virtual environment that aims to simulate face-to-face learning environments with the 

use of Information Technology. 

5.8 GLOSSARY 
 LMS- Learning Management System.  

 OLI- Open Learning initiatives. 

 Knowledge Management- Knowledge is not only rapidly changing with new research, 

new developments and rapid dissemination of ideas and practices over the Internet but 

the sources of information are also increasing with a great deal of variability in the 

reliability or validity of the information. 

 Communications Skills- With the traditional communication skills of reading, speaking 

and writing coherently and clearly we need to add social media communication skills. 

5.9 CHECK YOUR PROGRESS 
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Descriptive type questions- 

a) What do you understand by new-age learning skills? Explain. 

b) Explain Open Education. 

c) List five digital repositories for e-learning. 

d) Briefly explain the learning management system. 

Objective type questions- 

a) LMS may be defined as a virtual environment that aims to simulate face-to-face 

learning environments with the use of Information Technology. (True/False) 

b) In LMS, the interaction happens through either synchronous communication or 

asynchronous communication. (True/False) 

c) The objective of the E-Yantra project is to provide hands-on learning to engineering 

students who have limited access to labs and mentors. (True/False) 

d) Virtual Labs project is a consortium activity of JNU and Delhi University to provide 

virtual practical experience. (True/False) 

e) Open education is a collection of practices that utilize online technology to freely share 

knowledge. (True/False) 

f) FOSSEE stands for Free Open Source Software for Enterprise. (True/False) 

g) A-VIEW is an indigenously built multi-modal, multimedia e-learning platform that 

provides an immersive e-learning experience. (True/False) 

Answer (objective type questions)- 

[a] True   [b] True   [c] True   [d] False  

[e] True   [f] False   [g] True 
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6.1 INTRODUCTION 

MS-Word is a powerful word processor that allows you to create memos, fax coversheet, web 

pages, reports, mailing labels, brochures, tables, and many other professional and business 

applications. MS Word provides easy graphics handling, calculation of the data tables, ability 

to create a mailing list, list sorting, and efficient file management. 

6.2 OBJECTIVES 

After the successful completion of this unit, you will be able to- 

 Describe how to create, open and save a word document 

 Discuss MS-Word working tools. 

6.3 STARTING MS WORD 



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 6: Introduction to Text Editor (MS Word)- I  Page 64 of 166 

A text editor is any word processing program that you can use to type and edit text. Word Pad 

and Notepad for Windows and SimpleText and Text Edit for the Mac are common text 

editors. Large programs such as Microsoft Word and Word Perfect are also text editors. 

Microsoft Word allows you to create professional-quality documents, reports, letters, and 

résumés. Unlike a plain text editor Microsoft Word has features including spell check, 

grammar check, text and font formatting, HTML support, image support, advanced page 

layout, and more. 

Step 1 Click Start Button 

Step 2 Click on the ‘sub-menu’ icon. 

Step 3 Click on ‘Microsoft Office 2007’ from the sub-menu. 

Step 4 Click on the ‘Microsoft office word 2007’. 

Basics of MS-Word 

 Tabs: - Tabs are the predefined functions and features in the word processor which can 

be applied for developing certain characteristics on the entered text. 

 Active tab: - Active tab comprises of seven tabs- home, insert, page layout, references, 

mailing, review, and view. 

 Ribbon: - Each tab of the active tab menu has its specific groups of related commands 

termed as the ribbon. 

 Rulers: - Rulers help us to control the margins of the page and indentation of the 

paragraphs. They are also used for aligning the images and the text. 
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 Document header/footers: - Headers and footers are being used to display descriptive 

information such as page number, document name, date/or time, etc. 

 Document area: -Document area is a huge blank section of the word processor 

window which allows the user to enter the contents. This area contains infinite number 

of pages which is being incremented automatically when the previous page is filled.  

 View buttons: - View button is a feature that allows us to see how the document 

appears or presented.   

 Zoom slider: - Zoom slider is used to zoom in or zoom out the document pages. 

There are many basic operations and functions that we should know before start working in 

the MS-word, which are listed below: 

[1] To move the insertion point to the beginning or end of the document 

Press H+> or H+B. 

[2] To convert a document created in an earlier version of Word 

Click the Microsoft Office Button, and then click Convert. 
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[3] To view multiple pages 

 On the View toolbar, click the Zoom button. 

 In the Zoom dialog box, click the many pages arrow, select the number of pages, and 

then click OK. 

[4] To adjust the magnification of a document 

 On the View toolbar, click the Zoom button. 

 In the Zoom dialog box, enter the percentage or type an amount in the Percent box and 

then click OK. 

[5] To display the Document Map 

On the View tab in the Show/Hide group, select the Document Map check box. 

[6] To display thumbnails of pages 

 On the View tab, in the Show/Hide group, select the Thumbnails check box to display 

or hide non-printing characters.  

 On the Home tab, in the Paragraph group, click the Show/Hide ¶ button. 

[7] To display a document in a different view  

 On the View tab, in the Document Views group, click the button for the desired view, 

or  

 Click a view button on the View toolbar at the right end of the status bar. 

[8] To switch among open documents  

On the View tab in the Window group click the Switch Windows button and then click 

the name of the document you want to switch to. 

[9] To view multiple open documents  

On the View tab in the Window group, click the Arrange All button. 

[10] To open a new document  

Click the Microsoft Office Button, click New and then in the New Document window 

double-click Blank document. 

[11] To save a document for the first time 

 On the Quick Access Toolbar, click the Save button or click the Microsoft Office 

Button and then click Save As. 
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 If Browse Folders is shown in the lower-left corner of the Save As dialog box, click it 

and then navigate to the location where you want to save the file. 

 In the File name box, type a name for the document, and then click Save. 

[12] To create a new folder while saving a document 

 Click the Microsoft Office Button, and then click Save As. 

 In the Save As dialog box, navigate to the folder where you want to create the new 

folder. 

 On the dialog box’s toolbar, click the New Folder button 

 Type the name of the new folder, press F, and then click Open. 

 In the File name box, type a name for the document, and then click Save. 

[13] To preview how a document will look when printed  

Click the Microsoft Office Button, point to print, and then click Print Preview. 

[14] To print a document with the default settings  

Click the Microsoft Office Button, point to print, and then click Quick Print. 

[15] To print a document with custom settings 

 Click the Microsoft Office Button, and then click Print. 

 In the Print dialog box, modify the settings as needed, and then click OK 

[16] To select text  

 Word: Double-click the word.  

 Sentence: Click in the sentence while holding down the H key.  

 Paragraph: Triple-click in the paragraph, or double-click in the selection area to the left 

of the paragraph.  

 Block: Click to the left of the first word, hold down the G key, and then click 

immediately to the right of the last word or punctuation mark. 

 Line: Click in the selection area to the left of the line. 

 Document: To delete the text Triple-click in the selection area. 

 Select the text and then press A or Z. 

[17] To undo an action 

On the Quick Access Toolbar click the Undo button. 
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[18] To move the text by dragging 

 Select the text and then point to the selection. 

 Hold down the mouse button, drag the text to its new location and then release the 

mouse button. 

[19] To save the text as a building block 

 Select the text. Then on the Insert tab, in the Text group, click the Quick Parts button, 

and then click Save Selection to Quick Part Gallery. 

 In the Create New Building Block dialog box, type a name for the building block, make 

necessary changes to the settings, and then click OK. 

[20] To insert a building block in a document  

Click where you want to insert the building block. Then either type the name of the 

building block, and press #; or click the Quick Parts button on the Insert tab in the Text 

group and select the building block from the Quick Part gallery. 

[21] To insert the date and time 

 Click where you want the date or time to appear. Then, click the Date & Time button 

on the Insert tab in the Text group. 

 In the Date and Time dialog box under Available formats click the format you want, 

and then click OK. 

[22] To use the Thesaurus 

 Double-click the word you want to replace. Then, click the Thesaurus button on the 

Review tab in the Proofing group. 

 In the Research task pane, point to the word you want to insert in place of the selected 

word, click the arrow that appears, and then click Insert. 

[23] To research information 

 Click Research on the Review tab present in the Proofing group, 

 Type the research topic in the search for box present in the Research task pane. 

 Click the arrow of the box below the Search for box, click the resource you want to use, 

and then in the results list, click a source to view its information. 

[24] To translate a word or phrase into another language 

 Select the word or phrase, and then on the Review tab, in the Proofing group, click the 

Translate button. 
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 In the Translation area of the Research task pane, select the desired languages in the 

form and to boxes to display the translation. 

[25] To display a document in Outline view 

On the View toolbar, click the Outline button. 

[26] To display specific heading levels in Outline view 

On the Outlining tab, in the Outline Tools group, click the Show Level arrow, and in 

the list, click a heading level. 

[27] To collapse or expand heading levels in Outline view  

Click anywhere in the heading to be collapsed or expanded. Then on the Outlining tab, 

in the Outline Tools group, click the Collapse or Expand button. 

[28] To demote or promote headings in Outline view  

Click the heading to be demoted or promoted. Then on the Outlining tab, in the Outline 

Tools group, click the Demote or Promote button. 

[29] To move content in Outline view  

Collapse the heading whose text you want to move. Then on the Outlining tab, in the 

Outline Tools group, click the Move Up or Move Down button. 

[30] To find text 

 On the Home tab, in the Editing group, click the Find button. 

 On the Find tab of the Find and Replace dialog box, specify the text you want to find, 

and then click Find Next. 

[31] To replace text 

 On the Home tab, in the Editing group, click the Replace button. 

 On the Replace tab of the Find and Replace dialog box, specify the text you want to 

find and the text you want to replace it with, and then click Find Next. 

 Click Replace to replace the first instance of the text, Replace All to replace all 

instances, or Find Next to leave that instance unchanged and move to the next one. 

[32] To check spelling and grammar 

 On the Review tab, in the Proofing group, click the Spelling & Grammar button. 

 In the Spelling and Grammar dialog box, click the appropriate buttons to correct the 

errors Word finds or to add words to the custom dictionary or AutoCorrect list. 
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 Click OK when Word reaches the end of the Spelling and Grammar check, and then 

click Close. 

[33] To remove personal information from a document 

 Click the Microsoft Office Button, point to Prepare, and then click Inspect Document. 

 In the Document Inspector dialog box, select the items you want to check and then 

click Inspect. 

 In the Document Inspector summary, click the Remove All button to the right of any 

items you want to remove, and then close the Document Inspector dialog box. 

[34] To mark a document as final 

 Click the Microsoft Office Button, point to Prepare, and then click Mark as Final. 

 Click OK in the message box, click Save, and then click OK in the finalization 

message. 

[35] Changing the Look of  

Click the paragraph or select the text to which you want to apply a style. Then on the 

Home tab, in the Styles group, click the thumbnail of the style you want to apply in the 

Quick Styles gallery. 

6.4 WORKING WITH DOCUMENT 

Entering and saving text in a document- 

Entering and saving of the data in MS-word is very easy. A blinking cursor appears in the 

text area which decides the position of the text which is to be entered.  We can enter the 

contents in the text area with not only various formats of writing but also different sizes, 

shapes, and colours. We can also apply certain features like bold, italic, and underline and 

can arrange the position of the contents through various aligning icons. We can save the 

entered content by shortcut key (CTRL+S) OR can go through various steps given below: 

Step 1: Click on the ‘office button’ present at the top left corner of the screen. 
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Step2: Now, click on the ‘save’ option from the menu. Or Click on the ‘Save As’ option to 

provide a custom name to your document. 

Closing the MS Word- 

If you want to close the MS-Word window you just have to click on the ‘X’ icon present on 

the right top corner of the window. As you click on the ‘X’ icon, a small dialog box appears 

which asks you for saving the document. If you want to save the document just click on the 

‘Yes’ option that will close the window after saving your document or else click on the ‘No’ 

option that will close the window without saving your document. 

Opening an existing document- 

We can open our previously saved documents by just clicking on the office button present at 

the top left part of the MS-Word window. As we click on that ‘open’ option from the menu a 

document window appears which contains all the previously saved documents. All we have 
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to do is select the desired document from the list and click on the ‘Open’. 

Copy and Cut (Move)- 

Copy and the cut commands are used for transferring data from one place to another within 

the page or between the different 

pages of multiple documents. The 

copy command transfers the 

replica of the original data while 

the cut command transfers the 

original data to another place. We 

can perform both the operations 

by selecting the ‘Copy’ or ‘Cut’ 

options from the dialog box 

appears on right clicking the 

mouse after selecting the desired 

data. 

After clicking on any one of the 

two options, just position the 

mouse on the area where you want the data and select the ‘paste’ command by right clicking 

on the mouse. 

6.5 
WORKING WITH SYMBOLS, GRAPHICS, AND 

EQUATIONS 

We have several disciplines, areas, and fields where documentation work is highly preferred. 

They require number of equations, pie-charts, graphs, and other quantitative properties for 

their documents. As a result in order to create quality documents formatting of documents is 

highly preferable. The common features used in MS-Word are as follows- 

[1] To insert a picture 

 Click where you want to insert the picture. Then click the Picture button on the Insert 

tab in the Illustrations group,. 

 Navigate to the folder where the picture is stored, and then double-click the picture to 

insert it. 

[2] To adjust the size of an object  

Click the object. Then point to one of the handles surrounding the object and when the 

pointer becomes a two-headed arrow drag until the picture is the size you want. 
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[3] To insert clip art 

 Click where you want to insert the clip art. Then on the Insert tab, in the Illustrations 

group, click the Clip Art button 

 In the Clip Art task pane, in the Search for box, type a word describing what you are 

looking for, and then click Go. 

 In the task pane, click a clip art image to insert it in the document, and then close the 

task pane. 

[4] To move an object  

Click the object to select it. Then point to the object, and when the pointer changes to a 

four-headed arrow. Finally, drag the object to the new position. 

[5] To quickly copy an object 

Click the object, hold down the H key, and then drag a copy of the object to its new 

location, releasing first the mouse button and then the F key. 

[6] To insert a WordArt object 

 Click where you want to insert the WordArt. Then on the Insert tab, in the Text group, 

click the WordArt button. 

 In the WordArt gallery, click the style you want. 

 In the Edit WordArt Text dialog box, type your text 

 Set the size and other attributes of the text, and then click OK. 

[7] To apply a drop cap  

Click in the paragraph. Then on the Insert tab, in the Text group, click the Drop Cap 

button, and click the style you want. 

[8] To draw a shape 

 On the Insert tab, in the Illustrations group, click the Shapes button, and then click the 

shape you want. 

 Point where you want the shape to appear, and then drag to draw the shape. 

[9] To group drawing objects 

 Hold down the H key, and click each object you want to group. 

 On the Format contextual tab, in the Arrange group, click the Group button, and then 

click Group. 
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[10] To change the text wrapping of a picture 

Select the picture. Then click the Test Wrapping button on the Format contextual tab in 

the Arrange group. Select the wrapping style and attributes as desired. 

[11] To change the position of a picture  

Select the picture. Then point to the picture, and when the pointer changes to a four-

headed arrow. Finally, drag the picture to its new location. Or 

Select the picture. Then on the Format contextual tab click the Picture button present in 

the Arrange group, and click More Layout Options 

In the Advanced Layout dialog box, on the Picture Position tab, set the position options 

you want, and then click OK. 

[12] To insert a symbol 

 Click where you want to insert the symbol. Then on the Insert tab, in the Symbols 

group, click the Symbol button, and click More Symbols. 

 In the Symbols dialog box on the Symbols tab select the font you want. 

 Scroll through the list of symbols until you find the symbol you want, double-click it, 

and then click Close. 

[13] To insert an equation 

 Click where you want to insert the equation. Then on the Insert tab, in the Symbols 

group, click the Equation button. 

 Type your equation in the equation box that appears in the document. 

6.6 WORKING WITH DIAGRAMS AND CHARTS 

[1] To insert a diagram 

 Click where you want to insert the diagram. Then on the Insert tab, in the Illustrations 

group, click the SmartArt button. 

 In the Choose a SmartArt Graphic dialog box, click the diagram layout you want and 

then click OK. 

[2] To add text to a diagram  

Click the placeholder text in the Type your text here pane or in the diagram shape, and 

then type your text. 

[3] To resize a diagram  
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Drag the sizings handle around the diagram frame, and then drag the handle to increase 

or decrease the size of the diagram. 

[4] To add a shape to a diagram  

Click the diagram shape above or below where you want the new shape to appear. Then 

on the Design contextual tab, in the Create Graphic group, click the Add Shape arrow, 

and in the list, click Add Shape After, Add Shape Before, Add Shape Above, or Add 

Shape Below. 

[5] To change the diagram layout  

Click a blank area in the diagram’s frame. Then click the ‘More’ button on the Design 

contextual tab in the Layouts group. In the gallery, click the layout you want. 

[6] To move a diagram 

Point to the diagram’s frame (not one of the handles), and when the pointer changes to 

a four-headed arrow, drag the diagram to its new location. 

[7] To change the style of a diagram  

Click a blank area inside the diagram’s frame. Then on the Design tab, in the SmartArt 

Styles group, click the ‘More’ button. In the gallery, click the style you want. 

[8] To insert a chart 

 On the Insert tab, in the Illustrations group, click Chart. 

 In the Insert Chart dialog box, click the category of chart you want. Click the style you 

want and then click OK. 

[9] To enter data in a new chart  

In the Excel worksheet, replace the sample data by clicking a cell, and then type your 

data. 

[10] To fit a column to its longest entry  

Point the border between two column headings. Double click when the pointer changes 

to a double-headed arrow. 

[11] To edit the data in a selected chart 

 Click the Edit Data button on the Design tab in the Data group,. 

 In the Excel worksheet, click the cell you want to edit, type the new data, and then 

press F. 

[12] To change the type of a selected chart 
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 On the Design tab, in the Type group, click the Change Chart Type button. 

 In the Change Chart Type dialog box, click the chart type you want, and then click OK. 

[13] To change the style of a selected chart  

On the Design tab, in the Chart Styles group click the more button. In the Chart Styles 

gallery, click the style you want. 

[14] To turn a chart’s gridlines on and off  

On the Layout contextual tab in the Axes group click the Gridlines button. Point to 

Primary Horizontal Gridlines or Primary Vertical Gridlines and click the option you 

want. 

Working with professional documents 

E.g. reports, thesis, proposals, etc. 

[1] To delete a building block 

 In the Text group, click Quick Parts, and then click the Building Blocks Organizer. 

 In the Building blocks list, select the building block you want to delete. Then, click 

Delete. 

[2] To create a table of contents based on headings 

 Position the insertion point where you want to insert the table of contents. Then on the 

References tab, in the Table of Contents group, click the Table of Contents button. 

 In the Table of Contents gallery, click the table of contents style you want. 

[3] To update a table of contents 

 Click in the table of contents. Then on the References tab, in the Table of Contents 

group, click the Update Table button. 

 In the Update Table of Contents dialog box, click Update page numbers only or Update 

entire table, and then click OK. 

[4] To insert an index entry 

 Select the word you want to mark. Then, click the Mark Entry button on the References 

tab in the Index group. 

 Click Mark in the Mark Index Entry dialog box. 

[5] To create an index 
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 Click where you want to insert the index. Then, click the Show/Hide button on the 

Home tab in the Paragraph group to turn off the display of non-printing characters. 

 Click Insert Index on the References tab in the Index group. In the Index dialog box, 

click the Formats arrow, click an index format, select any other options you want, and 

then click OK. 

[6] To insert a bookmark 

 Select the text or item that you want to bookmark. Then on the Insert tab, in the Links 

group, click Bookmark. 

 Type the bookmark name (with no spaces) or select one from the list of bookmarks on 

the Bookmark dialog box in the Bookmark name box and then click Add. 

[7] To insert a cross-reference 

 Click where you want to insert the cross-reference. Then type the introductory text for 

the cross-reference. For example, for more information, see. 

 On the Insert tab, in the Links group, click the Cross-reference button. 

 In the Cross-reference dialog box, click the Reference type arrow and then click the 

type of reference you want. 

 Click the Insert reference to the arrow and then click the type of item you are 

referencing, if necessary. 

 In the Reference type drop-down list, click the item you are referencing to. Finally, 

click Insert, and then click Close. 

Finding a Particular Pattern- 

A pattern is a simple, repeating overlay of a one-color design over a background of another 

color. We can apply the pattern on different objects and various sections and part of the 

documents with the help of given steps: 

Step 1. Right-click the shape and choose Format Shape. The Format Shape dialog box opens. 

Step 2. Click the Fill tab. 

Step 3. Click the Pattern Fill option button. The controls change to show pattern options. 

Step 4. Click the desired pattern. 

Step 5. Open the Foreground Color menu and select the foreground color. As with other 

color selectors, you can select a theme color, a tint or shade, or a standard color. 

Step 6. Open the Background Color menu and select the background color. 
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Step 7. Click Close to close the dialog box. 

Inserting objects into a document- 

Depending on the version of Word or Outlook you're using you can insert a variety of objects 

(such as PDF files, Excel charts or worksheets, or PowerPoint presentations) into a Word 

document or an email message by linking or embedding them. 

[1] To insert an object 

 Click Object on the Insert tab. 

 Insert a new object 

[2] To create a new file that is inserted into your Word document or email message 

In the Object dialog box, click the Create New tab, and then select an option from the Object 

type list. 

The default program for that file type opens, where you can enter any text or data you want. 

When you close the program, any added content or changes appear in your Word document 

or email message. 

Select Display icon if you want the new file to appear as a clickable icon rather than the first 

page of your new file. If this check box is selected, you can choose a different icon by 

clicking Change Icon. 

Tips:  

 The information in the Result section changes based on the selected object type and 

whether the Display icon is selected. Use this information to help you determine what 

you want to insert and how you want it to appear. 

 To edit the information in your inserted object, double-click the object. 
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[3] Link or embed an existing file 

To link or embed an object that's already been created: 

 In the Object dialog box, select the Create from File tab, and then click Browse to find 

the file you want to insert. 

 To link to the source file, rather than embedding it into your Word document or email 

message, select Link to file. 

 Select Display as icon if you want the inserted file to appear as a clickable icon, rather 

than the first page of the file. If this check box is selected, you can choose a different 

icon by clicking Change Icon. 

Tip: The information in the Result section changes based on whether link to the file and 

Display as icon are selected. Use this information to help you determine what you want to 

insert and how you want it to appear. 

Embedded objects vs. linked objects 

Embedded objects become part of the Word file or email message and after they are inserted. 

However, they are no longer connected to any source file. 

Linked objects can be updated if the source file is modified. Linked data is stored in the 

source file. The Word files or email message (the destination file) stores only the location of 

the source file and it displays a representation of the linked data. Use linked objects if the file 

size is a consideration. 

6.7 POINTS TO REMEMBER 
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 Microsoft Word is a word processing program, designed to help you create 

professional-quality documents.  

 With the finest document formatting tools Word helps you organize and write your 

documents more efficiently.  

 Word also includes powerful editing and revising tools so that you can collaborate with 

others easily.  

 We have learned how to create our own documents, open existing documents, and 

finally save them before closing. 

6.8 GLOSSARY 

 Title Bar: It displays the document name followed by a program name.  

 Menu Bar: It contains a list of options to manage and customize documents. 

 Standard Toolbar: It contains shortcut buttons for the most popular commands. 

 Formatting Toolbar: It contains buttons used for formatting. 

 Ruler: Ruler is used to set margins, indents, and tabs. 

 Status Bar: It displays the position of the insertion point and working mode buttons. 

 Scroll Bars: These are used to view parts of the document. 

6.9 CHECK YOUR PROGRESS 

Objective type questions- 

a) ..... is the file extension for the MS-Word document. 

b) The active tab consists of ..... sub-tabs which opens the ribbon for performing various 

operations on the content. 

c) ..... shortcut key is used for UNDO and ..... for REDO the operations. 

d) We can save the document by one of the two ways i.e. by clicking on the SAVE AS 

option from the ..... button or by using ..... shortcut key for the same. 

e) We can group many objects by clicking them all while pressing holding the ..... key on 

the keyboard.  

f) MS-Word didn’t allow us to use various patters in the objects and in the document. 

(True / False) 

g) A text editor is any word processing program that you can use to type and edit text. 

(True / False) 
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h) We can change the style of the text by selecting designs from the FONT option of the 

HOME tab. (True / False) 

i) B option in the HOME tab is used for applying bold effect in the text. (True / False) 

j) MS-Word does not have an option for serial numbers on the pages. (True / False) 

Descriptive type questions 

a) What is a word processor?  

b) How the text is made bold, italic, and underlined? 

c) How can you insert a table in your document? 

d) How can you change the case of the text? 

e) Describe various types of apply text formatting in a word document. 

f) Discuss the steps of applying paragraph formatting. 

g) Learn how to create and edit hyperlinks in word 2007. 

h) How will you insert special characters and equations in word 2007? Explain using an 

example. 

Answer (Objective type questions) 

[a] .docx [b] 7 [c] CTRL+Z, CTRL+Y [d] OFFICE, CTRL+S [e] H [f] False [g] True [h] 

True [i] True [j] False 

6.10 BIBLIOGRAPHY/ REFERENCES 

 J. K. Shahjahan, MS Office 2007, Excel Books 

 Sanjeev Gupta and Shameena Gupta, computer Aided Management (Using MS 

Offfice2007 Tools), Excel Books 

 Laurie Ann Ulrich, How to Do Everything with Microsoft Office 2007, McGraw-Hill 

Professional 

 Joseph W. Habraken, MS Office 2007 All-In-One, Que Publishing 

 https://www.wikihow.com/Use-Microsoft-Word 

 https://www.nuance.com/products/help/dragon15/dragon-for-

pc/enx/dmpe_sub/Content/CommandandControl/word_basics.htm 

 https://techterms.com/definition/texteditor 

 https://guides.co/g/microsoft-word-how-to-start-a-document/11891 



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 6: Introduction to Text Editor (MS Word)- I  Page 82 of 166 
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7.1 INTRODUCTION 
MS-EXCEL is a very powerful and easy-to-use spreadsheet package. It is a member-

application of the MS Office suite. It works very well with numbers and their complex 

calculations. There are numbers of spreadsheet programs but from all of them Excel is most 

widely used application. The best part about Excel is it can apply to many business tasks, 

including finance, data management, forecasting statistics, analysis, inventory, billing, and 

business intelligence. 

7.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Understand MS Excel interface. 

 Working with MS- Excel. 

7.3 STARTING MS EXCEL 
Microsoft Excel is a spreadsheet program that is used to record and analyse numerical data. 

Spreadsheets were originally developed for bookkeeping. However, they are also useful for 
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data manipulation and producing for graphs. Spreadsheet as a collection of columns and rows 

form a table. Alphabetical letters are usually assigned to columns and numbers are usually 

assigned to rows. The point where a column and a row meet is called a cell. The address of a 

cell is given by the letter representing the column and the number representing a row. 

The MS Excel interface- 

Starting MS Excel- To start the MS Excel, follow the steps- 

Step 1- Open the Windows Start menu 

Step 2- Choose All Programs then Microsoft Office followed by Microsoft Office Excel 2013 

Step 3-You can create a shortcut to this software by dragging Microsoft Excel from this menu 

onto the Desktop using the right mouse button – select Create shortcut here, from the popup 

menu. 

The MS Excel interface basic tools and commands- 

[1] Active Cell-  

A cell in the Excel spreadsheet that is currently selected by clicking on it,  and highlighted by 

a rectangular box. 

[2] Column- 

A column is a vertical set of cells in a spreadsheet. Every column has its own alphabet for 

identity. You can select a column clicking on its header. 
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[3] Row- 

A row is a horizontal set of cells. Every row has its own number for identity. You can select a 

row clicking on the row number marked on the left side of the window. 

[4] Fill Handle- 

It is a small dot present on the lower right corner of the active cell. It is used to fill numeric 

values, text series, insert ranges, insert serial numbers, etc. 

[5] Address Bar- 

The address bar is the small input bar at the left side of the window. It shows the address of 

the active cell. We can select more than one cell and then it will show the address of the first 

cell in the range. 

[6] Formula Bar- 

The Formula bar is an input bar, below the ribbon. It is used to enter a formula in a cell. 

[7] Title Bar- 

It lies in the middle and at the top or the window. The title bar shows the program and sheet 

titles. 

[8] File Menu- 

The file menu is a simple menu just like other applications. It contains options like (Save, 

Save As, Open, New, Print, Excel Options, Share, etc). 

[9] Quick Access Toolbar- 

 You will find it just above the file menu and its purpose is to provide a convenient resting 

place for the Excel’s most frequently used commands. You can customize this toolbar based 

on your comfort.  

[10] Ribbon Tab- 

Starting from the Microsoft Excel 2007 all the options menus are replaced with the ribbons. 

The ribbon contains commands organized into three components: Tabs, Groups, and 

Commands. 

[11] Worksheet Tab- 

This tab shows all the worksheets present in the workbook. By default you will see three 

worksheets in your new workbook with the name of Sheet1, Sheet2, and Sheet3 respectively. 

[12] Status Bar- 

This displays sheet information as well as the insertion point location from left to right this 

bar can contain the total number of pages and words in the document, language, etc. 
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7.4 MS EXCEL BASIC FUNCTIONALITIES 

Exiting MS EXCEL- 

When you are ready to quit Excel, you have different choices for exit the program: 

 Select File -> Exit. 

 Press Alt+F4. 

 Click the Close button in the upper 

right corner of the Excel 2013 

Program window.   

Working with Workbook- 

Excel files are called workbooks. In 

Microsoft Excel, a workbook is a 

collection of one or more spreadsheets, 

also called worksheet in a single file. A 

workbook is another word for Excel file. 

To create an Excel workbook from 

scratch click the blank workbook while 

starting the Excel. 

Creating a new Workbook- 

Whenever you start a new project in 

Excel you need to create a new workbook, 

by following the given steps- 

Step 1 On the file tab, Backstage view will appear 

Step 2 Select New and Click the blank workbook 

Step 3 A new blank workbook will appear. 

Working with cells- 

The interaction of rows and columns is called cell. A cell is identified with a combination of 

the column header and row number. 

Setting Font- 

You can assign any of the fonts already installed for your printer to cells in a worksheet. You 
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can set the font of the selected text from Home>>Font group>> select the font. 

Setting font from format cell dialogue- 

Step 1 Right click on cell >> Format cells >> Font Tab 

Step 2 Press Ctrl + 1 or Shift + Ctrl + F  

Text Formatting- 

Various options available in “Home Tab” are as follows: 

 Bold: It makes text highlighted by choosing Home>> Font Group>> Click B or Press 

Ctrl + B 

 Italic: It makes text italic by choosing Home>> Font group>>  Click I or Press Ctrl + I 

 Underline: It makes text  underlined by choosing Home>> Font group>>  Click U or 

Press Ctrl + U 

 Double Underline: It makes text double underlined by choosing Home>> Font group>>  

Click the arrow near U >> Select double underline 

 Strike-through: It strikes the text in the centre vertically.  

 Super Script: It makes content appear above the type line. 

 Sub Script: It makes content appear below the type line. 

Change Alignment- 

You can change the horizontal and vertical alignment of the cell. By default, Excel aligns 

numbers to the right and text to the left. Click on the available option in the Alignment group 

in Home Tab to change alignment. Right click on the cell and select the format cell. In format 

cells dialogue select Alignment Tab. Select the available options from the vertical alignment 

and horizontal alignment options.  

Horizontal Alignment: You can set horizontal alignment to Left, Center, Right, etc. 

Left: Aligns the cell contents to the left side of the cell. 

Center: Centers the cell contents in the cell. 

Right: Aligns the cell contents to the right side of the cell. 
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Justify: Justify the text to the left and right of the cell.  

Vertical Alignment: You can set vertical alignment to Top, Middle, Bottom, etc. 

Top: Aligns the cell contents to the top of the cell. 

Center: Centers the cell contents vertically in the cell. 

Bottom: Aligns the cell contents to the bottom of the cell. 

Merging of Cells- 

MS Excel enables you to merge two or more cells. When you merge cells you don’t combine 

the contents of cells. You combine a group of cells into a single cell that occupies the same 

space. Select Merge and Center control on the Ribbon is simpler. To merge cells, select the 

cells that you want to merge and then click the Merge and Center button. Select the alignment 

tab of the format cells dialogue box to merge cells. The Home>> Alignment Group>> Merge 

and Center control contains a drop-down list with these additional options: 

Merge Across: When a multi-row range is selected this command creates multiple merged 

cells- one for each row. 

Merge Cells: Merges the selected cells without applying the center attribute   

Unmerge Cells: Unmerges the selected cells. 

Wrap Text and Shrink to Fit- 

If you have text too wide to fit the column width but don’t want that text to spill over into 

adjacent cells you can use either the wrap Text option or the Shrink to fit the option to 

accommodate that text. 

7.5 INSERTING, DELETING ROWS, AND COLUMNS 

Inserting Rows and Columns 

To insert a row or column into a Microsoft Excel worksheet: 

Step 1 Select a cell in your worksheet where you would like the 

new row or column to be 

inserted. To select multiple 

rows or columns simply select 

multiple cells. [1] New rows 

are inserted above the selected 

cell. [2] New columns are inserted above the 

selected cell. 

Step 2 On the Home tab in the Cells group, click the Insert command. 
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Step 3 Select Insert Sheet Rows or Insert Sheet Columns: 

Deleting Rows and Columns 

To delete a row or column into a Microsoft Excel 

worksheet: 

Step 1 Select a cell in your worksheet in the new row 

or column you wish to delete. To delete multiple rows 

or columns, simply select multiple cells. 

Step 2 On the Home tab in the Cells group click the 

Delete command. 

Step 3 Select Delete Sheet Rows or Delete Sheet 

Columns. 

7.6 SAVING AND CLOSING WORKBOOK 

Saving a Workbook- 

It’s important to save your workbook whenever you start a new project or make changes to an 

existing one. Execute the following steps: 

Step 1 Locate and select the save command on the Quick Access toolbar. 

Step 2 If you are saving a file for the first time, the Save As pane will appear in the 

backstage view. 

Step 3 You then need to select where to save the file and give it a file name. To save the 

workbook to your computer, select the computer, then click OneDrive to save the file to your 

OneDrive. 
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Step 4 The Save As dialog box will appear. Select the location where you want to save the 

workbook. 

Step 5 Enter a file name for the workbook, then click Save. 

Step 6 The workbook will be saved. You can click save command again to save your 

changes as you modify the workbook. 

You can also access the save command by pressing Ctrl + S on your keyboard. 

Closing a Workbook- 

To close a workbook, follow the steps 

given below- 

Step 1 Click on the File tab in the main 

menu. 

Step 2 Click on close. 

If the file gets saved then, it will get 

closed. Otherwise you will get a message 

“want to save changes in xxxx.xls”. 

If you want to save changes just click on save. 

7.7 POINTS TO REMEMBER 

 MS Excel is a very powerful and easy to use spreadsheet packages, perhaps the most 

commonly used these days. It is a member application included in the MS Office suite. 
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It works very well with numbers and their complex calculations. 

 Spreadsheets were originally developed for bookkeeping. However, they are also useful 

for data manipulation and producing for graphs. Spreadsheet as a collection of columns 

and rows form a table. Excel can sort and select data for a large amount of data or more 

complex tasks. 

7.8 GLOSSARY 
 Cell: A cell is a box at the intersection of a row and column in a worksheet where data 

is stored. 

 Column: Columns are a combination of all the vertical cells joined together in a single 

vertical line. 

 Row: Rows are a combination of all the horizontal cells joined together in a single 

horizontal line. 

 Workbook: It is a group of worksheets, which can be stored as a unit. A workbook is 

stored on the disk in the form of a file with extension .xls. 

 Worksheet: It is the working area of MS-EXCEL. Each worksheet of a single 

workbook has its own identity and is separate from other worksheets. 

 Workspace: It is the working area of MS-Excel where workbooks, worksheets, and 

other related objects may be opened and manipulated. 

7.9 CHECK YOUR PROGRESS 

Objective type questions- 

a) ..... Includes some statistical functions, but for serious research work, a specialized 

package should be used. 

b) MS-EXCEL is a very powerful and easy-to-use..... package. 

c) ..... are  a combination of all vertical cells joined together in a single vertical line. 

d) Rows are a combination of all the horizontal cells joined together in a single..... 

e) Each..... of a single workbook has its own identity and is separate from other 

worksheets. 

f) A cell with a dark border around it is called..... 

g) A calculation can be performed through..... 

h) A.... is a box at the intersection of a row and a column in a worksheet where data is 

stored. 

i) The mail merge option is in..... menu. 
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j) In excel replace option is in..... menu. 

Descriptive type questions- 

a) What do you mean by the range of cells? 

b) What do you mean by cell referencing and what are different types of referencing?  

c) Explain various types of charts available in MS Excel. 

d) What is the difference between copying and moving a range? 

e) What are the different components of the charts? Explain. 

f) Explain the major functions used in MS Excel. 

g) What do you use MS Excel for? Define. 

h) Which types of files can be imported and exported from MS Excel? 

Answers (Objective type questions) 

[a] Microsoft Excel [b] Spreadsheet [c] Columns [d] Horizontal line [e] Worksheet [f] Active 

[g] Excel [h] Cell [i]  Tools [j] Edit 

7.10 BIBLIOGRAPHY/ REFERENCES 
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8.1 INTRODUCTION 
PowerPoint is similar to a word processor such as Word except the fact that it’s geared 

toward creating presentations rather than documents. A presentation is like those Kodak 

Carousel slide trays that your grandpa filled up with 35mm slides of the time he took the 

family to the Grand Canyon in 1965. The main difference is that with Microsoft PowerPoint 

2019 you don’t have to worry about dumping all the slides out of the tray and figuring out 

how to get them back into the right order. 

A word document consists of one or more pages likewise, PowerPoint presentations consist 

one or more slides. Each slide contains text, graphics, animations, videos, and other 

information. You can easily rearrange the slides in a presentation, delete slides that you don’t 

need, add new slides, or modify the contents of existing slides. 

8.2 OBJECTIVES 
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After the successful completion of this unit, you will be able to- 

 Work with MS PowerPoint e.g. design templates, insert charts, shapes, etc. 

 Create your presentation. 

 Apply custom animation and slide transition. 

8.3 STARTING MS POWERPOINT 
MS PowerPoint interface- 

You can start Microsoft PowerPoint in just a few simple steps as follows: 

Step 1 Click on the PowerPoint icon in the Taskbar. If you do not see the icon, go to the Start 

button, right-click, and choose Search. Type "PowerPoint" in the search field, and when 

PowerPoint appears, double-click it. (Windows 7: Go to the Start button, then All Programs 

and choose PowerPoint.) 

Step 2 PowerPoint will open, prompting you to select a theme. Click on the Blank 

Presentation. 

The MS PowerPoint interface’s quick explanation- 

 Quick Access- This button is positioned on the top left portion. This toolbar is 

customizable which can be moved into two possible locations. This toolbar consists of 

a set of commands that it is independent on the tab of the ribbon currently displayed 

and you can add commands in this button. 

 Title Bar- It is positioned at the top of the user interface where the file name is seen 

after saving a file. As default, once you open your MS-Office 2010 you will see it as 
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Presentation1 Microsoft PowerPoint. 

 Control Tool Box- Located right top of the user interface where you can close, restore 

and maximize, and minimize the windows program. 

 Tab Menu or a tab of the ribbon- Positioned below the title bar the Tab menu relates 

to the type of activity such as to relate a ribbon menu name. For example once you 

click the home it will open as home ribbon menu. The tab menus are FILE, HOME, 

INSERT, DESIGN, TRANSITIONS, ANIMATIONS, SLIDE SHOW, REVIEW, and 

VIEW.   

 Ribbon Menu- Located under of the tab menu if you need to see it or control it, hold 

CTRL key and press F1. This menu contains all the commands and other menu items 

that help you find the command easily to finish your work. 

 Slide Sorter- Positioned to the left side of your user interface. All the slides will 

arrange in vertical order from the top as first slides down to your last slides. You can 

drag to rearrange the slides, delete, and use other tools once you right click your mouse. 

 Slide Template- This part is located at the center of your user interface, this is where 

you start and put your design in Presentation, animation, effects, and more. 

 Animation Pane- It is a part and command of ANIMATION PANE. Once you click 

this button it will open in the right-side portion of your user interface. This pane or 

panel will display the animation functions you use in your slide template. Also, you can 

rearrange the animation and effects as desired. 

 Zoom In and Out Sliding Bar- This part is located on the right side down and above 

of the taskbar. This is used to enlarge and decrease the view of your slide template at 

the center. 

 Add Note or Notes Pane- This pane or panel is positioned at the bottom of your user 

interface. This is where you can type notes that accompany your slide. You can print 

these notes as notes pages or display it when you save a presentation as a web page. 

 Status Bar- This part is located below the user interface and left side of the zoom 

in/out sliding bar and view buttons of the slide show. This is only to notify what slide 

number you use in your application. 

Exiting MS PowerPoint- 

After you have created a new presentation file and spent some time working on it, you will 

want to save it every so often so that when your system crashes, you can recover your work. 

And if you are like most folks you'll also want to save and close your presentation each time 

you wrap up a work session. 



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 8: Introduction to MS Power Point- I  Page 96 of 166 

Saving and closing a PowerPoint presentation are both straightforward tasks. If you are 

familiar with any other Windows programs, then you will recognize most of the steps. To 

save a newly created presentation: 

Step 1 Select Office button> Save. The Save As dialog box appears. 

Most of the time, when you're ready to save your presentation, you'll choose the .pptx file 

type or .ppt (the old, pre-2007 PowerPoint format). But you have got about a dozen choices, 

including the template (.potx) and show (.ppsx) formats. 

You can press Ctrl+S or click the Save button (the little diskette icon) that appears in the 

Quick Access toolbar. 

Step 2 Click the Save in the drop-down box to choose a directory to store your file in. In the 

File name field, type a new name for your file. 

Step 3 Click the Save as Type drop-down box to select a file format. Most of the time, you 

will choose the .pptx format and click Save. The Save As dialog box disappears and 

PowerPoint saves the file in the format you specified.  

Step 4 To close a presentation, simply select Office Close. When you do, PowerPoint closes 

your presentation with no fanfare. If you have never saved this particular file, however, a 

dialog box pops up asking you if you want to save the changes you made. Click ‘Yes’ to 

display the Save As dialog box and proceed as described above. 

8.4 DIFFERENT TYPES OF VIEWS 
PowerPoint supports multiple views to allow users to gain the maximum from the features 

available in the program. Each view supports a different set of functions and is designed 

accordingly. PowerPoint views can be accessed from two locations. 

[1] Views can be accessed quickly from the bottom bar just to the left of the zoom settings. 

[2] Views can also be accessed from the Presentation Views section in the View ribbon 

Here is a short description of the various views and their features. 

a) Normal View- This is the default view in PowerPoint and is primarily used to create 

and edit slides. You can create/ delete/ edit/ rearrange slides, add/ remove/ modify 
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content and manipulate sections from this view. 

b) Slide Sorter View- This view is primarily used to sort slides and rearrange them. This 

view is ideal to add or remove sections as it presents the slides in a more compact 

manner making it easier to rearrange them. 

c) Reading View- This view is new to PowerPoint 2010 and it was created mainly to 

review the slideshow without losing access to the rest of the Windows applications. 

Typically, when you run the slideshow, the presentation takes up the entire screen so 

other applications cannot be accessed from the taskbar. In the reading view, the taskbar 

is still available while viewing the slideshow which is convenient. You cannot make 

any modifications on this view. 

Slides Show- This is the traditional slideshow view available in all the earlier versions of 

PowerPoint. This view is used to run the slideshow during the presentation. 

8.5 CREATING PRESENTATION 
In Microsoft PowerPoint, a presentation is made up of multiple slides. There are several ways 

to create or add a slide in a PowerPoint presentation. After adding slides, you can move the 

slides around and also delete slides. 

[1] Working with Slides 

Insert new slide- 

To insert a new slide into a presentation, follow the steps below. 

 In the slide preview pane on the left, left-click with your mouse in-between two slides 
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where you want to insert a slide. 

 In the PowerPoint ribbon, on the Home or Insert tab, click the New Slide option. 

 In the drop-down menu that opens, select the type of slide to insert. The new slide will 

be inserted into the presentation where you clicked in step 1 above. 

Copy and paste an existing slide- 

To add a copy of an existing slide to a presentation, follow the steps below. 

 In the slide preview pane on the left, find the existing slide you want to copy. 

 Using your mouse, right-click on that slide and select Copy in the pop-up menu. 

 Determine where you want to add the copied slide. Right-click on the slide above 

where you want to paste the copied slide. 

 In the pop-up menu that appears in the Paste Options section, click the middle paste 

option icon to paste the slide. The middle paste option will paste the slide using the 

same formatting as the slide you copied. 

Insert slide from another presentation- 

To add a slide from another presentation, follow the steps below: 

 In the slide preview pane on the left, left-click with your mouse in-between two slides 

where you want to insert a slide. 

 In the PowerPoint ribbon, on the Home or Insert tab, click the New Slide option. 

 In the drop-down menu that opens, click the Reuse Slides option at the bottom. 

 In the Reuse Slides pane that opens on the right, click the Browse button and select 

Browse File. 

 Find the PowerPoint presentation file that contains the slide you want to add to the 

currently open presentation and click the Open button. 

 A preview of the slides is displayed below the Browse option. Left-click on the slide 

you want to insert into the currently open presentation. A new slide will be inserted 

with text from the selected slide included in the new slide. 

 To also apply the formatting of the selected slide to the newly inserted slide, right-click 

on the selected slide and select Apply Theme to Selected Slides. 

Move a slide- 

To move a slide to another location in a PowerPoint presentation, follow the steps below: 

 Open the PowerPoint presentation. 
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 In the left preview pane, find the slide you want to move. 

 Press and hold the left mouse button on the slide, then drag the slide up or down to 

where you want to move it. 

 Release the left mouse button when you have dragged the slide to its new location. 

Delete a slide- 

To delete a slide in a PowerPoint presentation, follow the steps below. 

 Open the PowerPoint presentation. 

 In the left preview pane, click on the slide you want to delete. 

 Press the delete key to delete the slide. 

[2] Working with new presentation- 

 Create presentations from scratch or a template. 

 Add text, images, art, and videos. 

 Select a professional design with a PowerPoint Designer. 

 Add transitions, animations, and motion. 

 Save to OneDrive to get to your presentations from your computer, tablet, or phone. 

 Share and work with others, wherever they are. 

Create a Presentation- 

 Select Blank Presentation to create a presentation from scratch. 

 Select one of the templates. 
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 Select Take a Tour, and then select Create, to see tips for using PowerPoint. 

Adding slide-  

 Select the slide you want your new slide to follow. 

 Select Home > New Slide. 

 Select Layout and then you type want from the drop-down. 
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Add text and format text-  

 Place the cursor where you want, and type. 

 Select the text, and then select an option on the Home tab: Font, Font size, Bold, Italic, 

Underline, etc. 

 To create bulleted or numbered lists, select the text, and then select Bullets or 

Numbering. 

Adding a picture, shape, or chart-  

 Select Insert tab, then to add a picture- Select Picture or Browse for the picture you 

want and select Insert. 

 To add a shape, art, or chart- Select Shapes, Icons, SmartArt, or Chart 

8.6 DESIGN TEMPLATES 
PowerPoint offers design templates to make it easy to create an attractive presentation. These 

templates come in a variety of colors and styles. You can apply a design to existing slides or 

begin a new presentation with a template. To begin a new presentation with a design 

template: 

 In the task pane under New, click Design Template. 

 A list of templates appears. 

 Move your mouse pointer through the different designs or use the scroll bar. 

 Click the down-pointing arrow in the gray box next to the template you like. 

 Choose Apply to All Slides. 

Adding a design to an existing presentation- 
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Do you have an existing presentation you want to add a design to? PowerPoint makes it easy 

to enhance existing slides with a design template. To apply a design to an existing 

presentation: 

 In the task pane, under Open a presentation, click the 

presentation you want. 

 Click the down-pointing arrow in the New 

Presentation pane and choose Slide Design - Design 

Templates. 

 A list of templates appears. 

 Move your mouse pointer through the different 

designs or use the scroll bar. 

 Click the down-pointing arrow in the gray box next 

to the template you like. 

 Choose Apply to All Slides. 

Applying a design template to selected slides- 

As you are working on your presentation, you can choose 

to apply a particular design template to selected Slides if 

you want one or more slides to have a different look. 

8.7 
APPLYING CUSTOM ANIMATION AND SLIDE 
TRANSITION 

Custom Animation- 

We can apply the custom animation with the certain steps given below: 

 Select the text or object. 
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 Select the Animation tab. 

 In the Animation group, click the Custom Animation. 

 Custom Animation task pane appears on the right. 

 Click the Add Effect. It will display four options that are further divided into different 

options. 

 Select the desired effect. 

Slide Transition- 

Transition effects appear, when one slide changes into the next slide in a slide show. 

 Select the slide to which you want to apply the effect. 

 Select the Animation tab. 

 In Transition to This Slide group, you will see the transition effects. 

 Click the drop-down arrow to see the menu of transition effects. 
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 Select the desired transition effect. 

 Click ‘Apply to All’ to apply the effect to all slides. 

8.8 MISCELLANEOUS POINTS- PRESENTATION 

Saving a presentation-  

PowerPoint offers two ways to save a file: Save and Save As. These options work in similar 

ways, with a few important differences. 

 Save: When you create or edit a presentation, you'll use the Save command to save your 

changes. You'll use this command most of the time. When you save a file, you'll only 

need to choose a file name and location the first time. After that, you can just click the 

Save command to save it with the same name and location. 

 Save As: You'll use this command to create a copy of a presentation while keeping the 

original. When you use Save As, you'll need to choose a different name and/or location 

for the copied version. 

Note- Using "Save As" to make a copy-  

If you want to save a different version of a presentation while keeping the original, you can 

create a copy. For example, if you have a file named Client Presentation you could save it as 

Client Presentation 2 so you'll be able to edit the new file and still refer back to the original 

version. To do this, you'll click the Save As command in the backstage view. Just like when 

saving a file for the first time, you'll need to choose where to save the file and give it a new 

file name. 

Running a Presentation 

Most PowerPoint presentations are created to run as a slideshow. Given all the advanced 

feature available in PowerPoint 2010 it is no surprise that there are many features related to 

running the slideshow that has been included in this program too. Most of these features are 

really to help you create a good slideshow without having to go through the entire 

presentation over and over again after every minor change. Features related to running the 

slideshow are grouped under the Slideshow ribbon. 
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Closing a Presentation- 

Closing a presentation is certainly easier than opening one. To close a presentation, save your 

file and use one of these techniques: 

 Click the Office button and choose Close on the drop-down list. The PowerPoint 

program remains open although the presentation is closed. 

 Click the Close button, the X in the upper-right corner of the PowerPoint window (or 

press Alt+F4). Clicking the Close button closes PowerPoint as well as your 

presentation. 

Opening an Existing Presentation- 

PowerPoint and Windows offer many shortcuts for opening an existing presentation. To open 

a presentation, click the Office button and choose Open - or take advantage of the numerous 

ways to open presentations quickly as followed- 

 Click the Office button and choose Open on the drop-down list (or press Ctrl+ O). You 

see the Open dialog box. 

 Locate and select the presentation you want to open and then click the Open button. 

You can also double-click a presentation name to open a presentation. 

8.9 POINTS TO REMEMBER 
 Microsoft PowerPoint is widely used for making professional quality presentations in a 

variety of formats, including onscreen computer slide shows, black-and-white or colour 

overheads, and 35 mm slides. You can also use it for notes and class presentations. 

Besides, PowerPoint can be used as a drawing package for preparing pictures, forms, 

posters, and leaflets. 

 Presentation is a powerful managerial tool of communication through which you can 

compile and deliver your ideas, concepts, plans, and products to the audience in a 

structured, effective, and impressive manner. 

 Slides and transparencies are used to projected in front of the audience using an 

overhead projector or otherwise. The operation of this equipment is mainly manual, 

semi-automated at the best. 

8.10 GLOSSARY 

 Title Bar: This is the top section of the window. It shows the name of the file followed 

by the name of the program which in this case is Microsoft PowerPoint. 

 Slide Area: This is the area where the actual slide is created and edited. You can add, 

edit, and delete text, images, shapes and multimedia in this section. 
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 Normal Layout View: This displays page in normal view with the slide on the right and 

a list of thumbnails to the left. This view allows you to edit individual slides and also 

rearrange them. 

 Slide Tab: This section is available only in the normal view. It displays all the slides in 

sequence. You can add, delete, and record slides from this section. 

 Quick Access Toolbar: The Quick Access Toolbar is located just under the ribbon. This 

toolbar offers a convenient place to group the most commonly used commands in 

PowerPoint. 

8.11 CHECK YOUR PROGRESS 

Objective type questions- 

a) Word documents consist of one or more pages, and PowerPoint presentations consist of 

one or more..... 

b) ..... This part position right side down and above the task bar. This is use to enlarge and 

decrease the view of your slide template at the center. 

c) ..... view is used to run the slideshow during a presentation. 

d) PowerPoint offers two ways to save a file..... and..... 

e) ..... View presentations you recently worked on in the dialog box. 

f) Each slide is consisting of text, graphics, animations, videos, and other information.   

g) reading view is the default view in PowerPoint and this is primarily used to create and 

edit slides 

h) Click the Office button and choose Close on the drop-down list for closing the 

presentation 

i) Broadcast slideshow Allows users to broadcast the slideshows using Microsoft's 

PowerPoint Broadcast Service 

j) Presenter View is used to define the resolution in the slideshow view. 

Descriptive type questions- 

a) What do you use MS PowerPoint for? Elaborate. 

b) What is MS PowerPoint? 

c) Explain the major functions used in MS PowerPoint. 

d) Create a MS PowerPoint Presentation with animated slides. 

e) What are the major features of MS PowerPoint? 
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Answers (Objective type questions) 

[a] Slides [b] zoom in and out sliding bar [c] slideshow view [d] save and save as [e] My 

Recent Documents Button [f] True [g] False [h] True [i] True [j] False 
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9.1 INTRODUCTION 
In today’s world we do most of our work online, for example, booking of bus, railway, and 

flight tickets, depositing electricity, water, mobile bill, etc. Government is trying to provide 

all their services online so that individuals can get their work done from any place and at any 

time. This is all possible just because of internet. Internet has changed the way people live 

their life. WhatsApp and Facebook are an essential part of people’s life. People share 

information from one corner of the world to another corner of the world within seconds. 

Today, we see the world as a global village internet is behind all these services. Thus, its 

really important for students to understand the basics of internet. Hopefully, this information 

will be quite helpful for them to go for further details in this field. 

9.2 OBJECTIVES 
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After the successful completion of this unit, you will be able to- 

 Define internet. 

 Elaborate on various applications of the internet. 

 Explain basic terms related to the internet. 

 Describe the meaning of the URL. 

 Elaborate the working of search engines. 

 Explain the usage of the internet in education. 

9.3 CONCEPT OF INTERNET 
In simple words, we can define internet as a way of connecting any number of computers 

situated at any place in the world. In other words, it is a global network of computers all over 

the world. Internet is a global network of a number of private, public, business, academic, 

government, and other networks connected by various technologies.  Internet can be used to 

send and receive different kinds of information such as text, graphics, voice, video, etc. 

Different users may have different platforms, and other issues related to intersystem 

communication in the internet. Thus, Transmission control protocol/Internet protocols 

(TCP/IP) are used to define the rules for communication on the internet so that these issues 

can be resolved. We need access to the internet service provider (ISP) to connect to internet. 

ISP works as a mediator between a user and the internet. 

9.4 APPLICATIONS OF INTERNET 
There are various applications of internet. It is the most useful technology of modern life 

which helps us not only in our daily life but also in personal and professional life. Some 

important applications of the Internet are as follows: 

[1] E-Mail  

Electronic mail (e-mail) is one of the important and frequently used applications of the 

internet. This provides a way of communication and sharing of information. With e-mail, one 

can send and receive information instantly. There are numbers of internet service providers 

that offer the service further nowadays there are many physical devices that support e-mail 

like mobile phones. 

[2] Web browsing 

Web browsing is another important application of  internet. It is a software application used 

to access information on the World Wide Web. A browser is used to display the information 

contained in a website. Google Chrome, Firefox, Internet Explorer, etc are some examples of 

web browsers. Google Chrome is the most popular browser.  
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[3] Education 

Internet is one of the main sources of getting information about a topic. Thus, it is quite 

useful for students, teachers, and researchers. Nowadays, online education has grown rapidly 

many are providing education through online video lectures and earning as well. Massive 

online open courses (MOOCs) have opened a new way of education worldwide. There are a 

number of courses of different subjects available through MOOCs. A student can do a course 

of any university from any place along with his usual work.  

[4] Video Conferencing 

Internet is also used for video conferencing. Whenever it is not possible to arrange a physical 

meeting in one place due to shortage of time, video conferencing is the best alternative. Many 

government and private sectors are using internet for video conferencing for their day to day 

work. It is a brilliant way of saving time and money.  

[5] E Commerce 

Internet has become a major platform for conducting commercial activities. Nowadays, most 

of the big companies rely on online business. With the help of internet anyone can shop 

online. Online stores and sites are used to purchase all the needed products. 

[6] Entertainment   

Internet has changed dramatically the scenario of entertainment methods. There are many 

videos and movies available in the web. Internet provides the facility to access wide range of 

audio and video songs, movies, and other television programs. Many websites provide the 

facility to upload videos. YouTube is the leading website for such purposes. Now, people are 

making entertainment videos and uploading them into the web. This becomes a means of 

earning as well. 

[7] Communities  

Social media allows people across the world to connect with each other via internet. A person 

can share text, photos, videos, etc through social media and may connect with the people 

sitting at any place in the world. Social media has a great impact on people’s life. Social 

media has the power of campaigning in favour or against any particular thing, thus this 

application of internet should be used carefully. 

[8] Services  

We use internet for many services like banking, online submission of bills, online purchasing 

tickets of train, aeroplane, movie and hotel reservation, etc. Thus, internet has made these 

tasks time and money-saving. 

9.5 CONNECTING TO THE INTERNET 
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There are many ways to connect to the internet.  They all use different hardware and each has 

a different range of connection speed.  As technology changes, faster internet connections are 

needed to handle things, following are some main services to connect to the internet: 

[1] Dial Up 

This is low-cost but the slowest type of internet connection. A modem is required to connect 

to the internet for this type of connection. It requires a wired phone line to make internet 

connection. The phone lines regularly experience disturbance which affects the speed of the 

internet due to poor connection. In this connection, one cannot use land line phone and 

internet service simultaneously. 

[2] Digital subscriber line (DSL) 

The digital subscriber line uses a broadband connection, thus, it is faster than dial up 

connections. It uses two lines one for internet and one for phone calls as a result both using 

internet and making calls can be done simultaneously. The speed of connection depends on 

the service offered. 

[3] Cable   

Cable service provides an internet connection through cable TV lines. The speed of internet 

connection may be different for upload or download transmission of data. It may have a faster 

connection in comparison to dial up and DSL services.  

[4] Wireless   

Wireless or Wi-Fi uses radio frequency and it does not require use telephone lines or cables 

for connection to the internet. Through a wireless network, internet can be accessed at any 

point within the coverage of the network. Thus, there is no need to fix at a point to access 

internet.  

[5] Satellite 

Satellite internet connection uses satellites that are moving and working in the orbit of the 

earth. Thus, in this type of connection we need not cable or phone line. It can be used 

anywhere in the world. However, weather may play some role in the connection. In general, 

this type of connection is slow in comparison to DSL or cable. 

[6] Cellular 

These services are used with mobile phones. It provides a wireless internet connection. The 

speed of the connection may vary and depends on the service provider. The most common are 

3G (3rd generation cellular network) and 4G (4th generation cellular network). 

9.6 BASICS OF COMPUTER NETWORKS 
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A computer network is a set of computers connected to each other in different ways. 

Connections may be through wires, optical fibers, wireless etc. The purpose of a computer 

network is to make interaction possible among different computers. When we interact or 

communicate, we share information. We frequently use the term ‘data’, which refers to the 

information shared and it may be in any form as decided by the communicator. Data may be a 

piece of text, numbers, images, audio, or video.  First, we understand data communication 

which has five components: message, sender, receiver, transmission medium, and protocol. 

We can understand these in simple words as follows: 

Message is the data communicated between two devices. 

Sender is the device sending the data. 

Receiver is the device receiving the data. 

Transmission medium is the physical medium over which the data travels. 

Protocols are a set of rules to make communication possible. 

Modes of data communication- 

Now, we discuss the different modes of data communication.  There are three modes of data 

communication: simplex, half-duplex, and full-duplex. 

Simplex  

In simplex mode, the communication takes place in one direction only. If the communication 

is taking place between A and B, then only one can transmit the information and the other can 

receive the information, i.e., if A transmits the information then B receives the information. 

We can say that, it is a unidirectional mode. 

Figure 9.1 Simplex Mode of Communication. 

Half-duplex-  

In half-duplex mode, both the devices can transmit as well as receive the information but at a 

time, communication will take place in one direction only, i.e., A and B both can transmit and 

receive the information but at a time. Either A can transmit information to B or B can 

transmit information to A only. We can say that, it is a restrictive bi-directional mode. 

Figure 9.2 Half-duplex Mode of Communication. 
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Duplex or Full-duplex-  

In full-duplex mode, both the devices can simultaneously transmit and receive the 

information. We can say that, it is bidirectional mode. 

Figure 9.3 Duplex or Full duplex Mode of Communication. 

Physical Structure of network  

Now, we discuss the physical structures of a network. In a network devices are connected 

through links. Link is nothing but a medium of transferring data between devices. There are 

two possible connections: point-to-point and multipoint. 

Point-to-Point-  

In a point-to-point connection, there is a dedicated link between two devices. The whole 

capacity of the link is used to transmit data between the two devices. 

Figure 9.4 Point-to point connection. 

Multipoint connection-  

In a multipoint connection, two or more devices share a link. The capacity of the link is 

shared by different devices. 

Figure 9.5 Multipoint connection. 

Topology of a network 

The geometrical representation of the links and their relationship is known as the topology of 

a network. To discuss the topology of a network, we can assume a device as a vertex (nodes) 

and a link as an edge between to vertices. There are four basic topologies: 

Mesh Topology- In a mesh topology, there is a point to point link between every two 
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devices. If there are 𝑛 nodes in the network, every node will be joined through every other 

𝑛 − 1 node. Thus, there will be 𝑛(𝑛 − 1) links. In this number, every link is counted twice as 

a link between A and B is the same as the link between B and A, thus there will be 
௡(௡ିଵ)

ଶ
 

links. For example, mesh topologies of three and four nodes are given in the following 

figures: 

Figure 9.6 Mesh topology. 

Star Topology- 

In a star topology, there is a central device and all other devices have a point to point link to 

the central device. The central device is usually known as a hub and will be discussed later 

on. In a star topology two devices cannot make communication directly but through a central 

device. 

Figure 9.7 Star topology. 

Bus Topology- 

In a bus topology, all the devices are connected through a cable and this cable act as a 

backbone to all the links. 

Figure 9.8 Bus topology. 

Ring Topology- 

In a ring topology, devices are connected in a ring, i.e., each device has a point to point 

connection to two devices only, one in one side of it and second on the other side of it. 

Figure 9.9 Ring topology. 
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Note- A hybrid topology can be formed by using one or two above topologies. 

Components of Computer Network 

Here, we discuss the different components of a computer network. Before describing the 

different components, the various major components can be seen in the Figure 9.10, as- 

Figure 9.10 Components of Computer Networks. 

Network interface card (NIC)- 

Network interface card is a device that helps the computers to communicate with each other. 

It contains the hardware address which is used by the data-link layer protocol to identify the 

system on the network so that the data can be transferred to the correct destination. NIC has 

two types; wireless NIC and wired NIC. In a wireless NIC, connection is made using an 

antenna and the radio wave technology. Wireless NIC is used in all modern laptops. In wired 

NIC cables are used to transfer the data over the medium. 

Hub- 

A Hub is a device used to divide a network connection among multiple computers. A request 

from a computer in the network first goes to the hub through cable and then the hub 

broadcasts this request to the entire network. The request is checked by all the computers in 

the network for the belongingness of the request with them. The request is dropped in case it 

does not belong to any computer. 

Switches- 

A switch is an advanced version of a hub. In place of broadcasting the message to the entire 

network like a hub, it contains an updated table to decide the destination of the data. Using 

the information from the table, a direct connection between the source and destination is 
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created. This helps to increase the speed of the network. A switch works as a controller. It 

connects various devices like, computers, printers to a network in a premise.  

Routers- 

A router is a device that can connect multiple networks. It is used to forward data packets 

among multiple networks. It regenerates the signals it receives, checks the physical addresses 

of the source and destination and forwards the signal to its destination through the best 

possible route. 

Modem- 

A modem is known as a modulator/ demodulator. It converts the digital data into an analog 

signal and vice versa. It is used to make a connection between the computer and the internet 

over the telephone lines.   

Cables- 

Cables are used for transmitting a signal. Cables work as a carrier to interconnect computers 

in a network. 

9.7 UNDERSTANDING URL 
URL stands for ‘Uniform Resource Locator’. It is the address of a document on the web and 

it is unique for every document. A URL has several parts; each part provides some 

information to the web browser that helps to find the page. Look at the following address- 

http://www.uou.ac.in/school/school-computer-sciences-information-technology  

We can break the address into three parts- (i) http:// (ii) www.uou.ac.in (iii) /school/ school-

computer-sciences-information-technology. 

The scheme  

The first part of the URL is ‘http://’. This string is the scheme that identifies the protocol to 

be used to access the page on the Internet. The most commonly used protocols are http 

(Hyper Text Transfer Protocol) and https (Secure Hyper Text Transfer Protocol). Sometimes 

ftp (to handle a basic file transfer) and mail to (to open a mail client) are also used. After the 

string, colon ‘:’ is used as URL scheme separator and the paired slashes ‘//’ indicates the 

beginning of the local hostname. 

Domain name   

The second part is ‘www.uou.ac.in’. It identifies the hostname where the resource is located. 

We can further categorise it into three parts, (i) www (ii) uou (iii) ac.in.  The first part ‘www’ 

is the sub-domain that defines the hosts; here it is World Wide Web. It may be changed like 

support.uou.ac.in to access the internal support page of the website.  The second part is the 

address of the web server that serves the website. The third part gives the general information 
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about the website, for example ‘.gov’ shows a government website, ‘.ac’ shows website 

related to academics etc. The extension ‘.in’ shows the region, here it is for India. The 

domain name is basically an IP address of the web server but as it is not easy to remember an 

IP address, a simple text is used.  

File-path 

The third part is the path of the page that needs to be loaded. If we do not use the file path, 

then the home page will be loaded from where we navigate for the required page. 

9.8 SEARCH ENGINE 
A web search engine is software designed to carry out web search on the internet to provide a 

user the relevant information in response to his query. A search engine extracts requested 

information from the huge database web pages available on the internet. The search is based 

on matching the user’s query with the available pages. There is a mathematical procedure for 

matching the query with the documents available on the internet. After matching the 

documents, search engines return a list of documents in descending order of their matching 

score. Nowadays, there are many different search engines available on the internet, with each 

search engine having its own ability and feature. Google is the most popular search engine. 

Some other search engines are Bing, Yahoo, Ask, etc. Let us understand the architecture of a 

web search engine. It has the following modules: 

[1] Crawler Module 

In the World Wide Web, web pages are stored in a decentralized way in computers across the 

world. Thus, a search engine has to collect information from these documents. This task is 

performed by the crawler module. This module consists of a specialized computer program 

that runs uninterruptedly. Virtual robots, we call them spiders walk through the web, visit 

pages on the web, download them, and send them to repository. 

[2] Repository 

Repository indicates the computer disks on the computers of the company that runs a search 

engine. Repository stores the web pages downloaded by the spider. The pages stored in the 

repository are sent to the indexing module for further processing. 

[3] Indexing Module 

The indexing module consists of a computer program to extract important information from 

the web pages. The basic work of this module is to prepare a compressed representation 

(index) of the web pages stored in the repository.  

[4] Query Module 
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The query module reads the query written by a user. It analyses and converts it into a specific 

format so that it can be matched with index to find the related web pages. The retrieved web 

pages are then sent to the ranking module. 

[5] Ranking Module  

Ranking module provides ranking a similarity score to the web pages sent by query module 

and sort them in descending order of their ranking (highest ranking to lowest ranking). The 

list known as the hit list is returned to the user against his query on the computer screen that 

contains the URLs together with the excerpt from the pages called a snippet.  The similarity 

score is based on some mathematical concepts and web-specific factors. 

9.9 INTERNET AS AN EDUCATIONAL TOOL 
Internet has a tremendous power to disseminate information worldwide within a short period. 

Thus, it has emerged as an important tool for education. For every level of education whether 

child education, school level, or college level, internet plays a vital role. For you any query, 

you can ask to Google search engine, you get some answer to your query. Children can easily 

learn their subjects by visualizing it. With the incorporation of the visualization effect 

learning becomes more effective. There are many websites available that assist in learning 

particularly for children.  

In remote areas where faculty members are not available for students, internet is like a gift to 

the education system that can be used to fill the gaps between the knowledge seekers and 

providers. Nowadays, video lectures of renowned professors in almost every field are 

available on the internet. A person sitting in one corner of the world can watch and learn from 

another sitting in another corner of the world. A number of lectures for a single topic by 

different experts are available on the internet that provides us the freedom of choosing the 

best lecture. Massive online open courses (MOOCs) are growing rapidly worldwide. One can 

learn and earn a certificate or degree from home by choosing a MOOC. There are different 

platforms that are providing MOOCs, like SWYAM, NPTEL, COURSERA, etc. MOOCs are 

not only useful for students but also for persons those who are in jobs and wish to enhance 

their carrier in a particular field. We can summarize the advantages of online education as 

follows: 

[1] Access to cost-effective education 

Due to the availability of online courses, students can get a certificate from a reputed 

institution with minimum cost that has made education accessible to everyone. 

[2] Effective teaching and learning 

Due to the advancement of technology, a lecture can be made very effective by introducing 

audio, video, and other advance tools. 
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[3] Updated information 

With the help of internet, one can get the latest information on any field as internet is the 

major source of information, and every minute huge data is uploaded to the internet. 

[4] Learning freedom 

The most important thing about online education is the freedom of learning. One can choose 

one’s own time and place to study the online material. Whether you are working, non-

working, or you have any profession, you can manage your own time to complete a course. 

9.10 POINTS TO REMEMBER 
 We have learned the basic concepts of internet and its applications to various fields.  

 We knew the various services to connect internet and basics terms of a computer 

network.  

 We also learned the meaning of different parts of URL.  

 We got the knowledge of the working of search engines 

 We saw that Internet is a powerful tool for education as well. 

9.11 GLOSSARY 

 MOOC- Massive online open courses. 

 URL- Uniform Resource Locator. 

 NIC- Network interface card. 

 4G- 4thh generation cellular network. 

 DSL- Digital subscriber line. 

 TCP/IP- Transmission control protocol/Internet protocol. 

9.12 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) Explain the concept of internet. Describe various applications of internet. 

b) Describe various services that are used to connect to the internet. 

c) Describe various modes of data communication.  

d) Describe the meaning of the physical structure of a network. 

e) What do you mean by the topology of a network? Discuss various network topologies. 

f) Describe various components of a computer network. 
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g) Explain the meaning of URL. 

h) What do you mean by search engines? Explain its various modules. 

i) Discuss the usage of internet in education. 

Objective type questions- 

a) Internet is a global network of computers. (True/False) 

b) Commercial activities are not possible through internet. (True/False) 

c) A modem is required to connect to the internet for the dial up connection. (True/False) 

d) In DSL use of internet and making calls, cannot be done simultaneously. (True/False) 

e) Wi-Fi uses radio frequency. (True/False) 

f) In simplex-mode the communication takes place in one direction only. (True/False) 

g) In full-duplex mode both the devices can simultaneously transmit and receive the 

information. (True/False) 

h) In a star topology with n points, there will be (n(n-1))/2 links. (True/False) 

i) In a ring topology, each device has a point to point connection to two devices only. 

(True/False) 

j) Hub is a device used to divide a network connection among multiple computers. 

(True/False) 

k) A router converts the digital data into an analog signal and vice versa. (True/False) 

l) In URL the string ‘https’ represents secure hypertext transfer protocol. (True/False) 

m) The work of Crawler is matching a page on the internet with the query. (True/False) 

n) MOOCs stand for massive open organised courses. (True/False) 

Answer (Objective type questions)- 

[a] True  [b] False  [c] True  [d] False  [e] True  [f] True 

[g] True  [h] False  [i] True  [j] True  [k] False  [l] True  

[m] False  [n] False 
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10.1 INTRODUCTION 
Communication is a process of sharing the information and ideas from one place or person to 

another. A network is required for proper communication. A network consists of multiple 

devices that communicate with one another. A computer network is an interconnection of 

computers and computer resources for sharing of data and resources. The devices connected 

in the network are called nodes. Nodes may be a computer, printer, or any other device 

capable of sending or receiving data. Computer networks can be classified on the basis of 

their size and purpose. The computer networks are of three types Local Area Network (LAN), 

Metropolitan Area Network (MAN), and Wide Area Network (WAN). 

The Internet is the global ‘network of networks’ that connects millions of computers all over 

the world. The computers and computer networks interchange information using TCP/IP 

(Transmission Control Protocol/Internet Protocol). The computers are connected through the 

telecommunication networks and  Internet is used for various purposes like e-mailing, sharing 

files and gathering information, etc over World Wide Web (WWW). 
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10.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Define data communication and computer network.  

 Define the types of networks and their characteristics.  

 Define the Internet and its services.  

 Explain the concept of TCP/IP suite. 

 Describe the OSI reference model. 

10.3 COMPUTER NETWORKS 
A computer network is a collection of several computers and other devices which are 

interconnected in such a manner that allow easy exchange of data and resources. Main 

objectives of the computer network are exchange of data or information, sharing software and 

hardware resources like printer, and distribution of the processing load. 

Advantages of a computer network- 

The main advantages of a computer network are: 

 Central storage of data: A computer network allows storing of data files in a central 

computer of a network shared by all the nodes of a network. 

 Resource Sharing: A computer Network enables us to share resources such as storage 

space, processing units, and peripherals like printers, scanners fax, etc. 

 Sharing of software: A user in a network can use the software installed in any of the 

computer or file servers in the network. 

 Communication:  Different users connected through the network can communicate with 

each other through voicemail, e-mail, messaging, video conferencing, etc. 

 Electronic Commerce: Computer networking (Internet) provides the facility of 

electronic commerce. 

Types of networks 

There are mainly three types of computer networks based on their size: (i) Local Area 

Network (ii) Metropolitan Area Network, (iii) Wide area network (WAN). 

[i] Local Area Network 

A Local Area Network (LAN) is a group of computer and peripheral devices that are 

connected in a small limited geographical area such as school, laboratory, home, and office 

building. A LAN is used to connect computers and other network devices so that the devices 
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can communicate with each other to share the resources. The resources to be shared can be a 

hardware device like printer and software like an application program or data. The size of a 

LAN is usually small. The various devices in LAN are connected to central devices called 

hub or switch using a cable. 

Characteristics of LAN: 

 LAN is used for connecting two or more personal computers through a communication 

medium such as twisted pair, coaxial cable, etc. 

 It is cheaper as it is built with inexpensive hardware such as hubs, network adapters, 

and Ethernet cables. 

 The resources to be shared can include hardware (e.g. printers), software (e.g. an 

application program), or data. 

 LAN enables the sharing of resources such as files or hardware devices needed by 

multiple users. 

 Is limited in size, typically spanning a few hundred meters, and no more than a mile. 

 LAN due to its small size is faster than the other networks. 

 Local Area Network provides higher security. 

 LAN can be either wired or wireless. 

 Different devices (nodes) in a LAN can be connected with certain topologies like BUS, 

RING and STAR. 

[ii] Metropolitan Area Network 

A metropolitan area network is designed to extend the network over an entire city.  

Metropolitan area network (MAN) is a computer network that spans over larger geographical 

region than LAN. It covers several buildings or an entire city. This network is used to share 

regional resources among network users. It may be a single network such as a cable television 

network or connecting a number of LANs into a larger network so that resources are shared 

from LAN-to-LAN as well as device-to-device. 

Characteristics of MAN: 

 MAN covers a larger geographical region than LAN usually covering a city or several 

buildings. 

 It is a high-speed network than WAN. 

 Users can share regional resources through MAN. 

 MAN normally covers an area ranging 5 to 50 km in diameter. 
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 Less expensive than WAN. 

 Composition of various small Local Area Networks. 

[iii] Wide Area Network 

Wide Area Network is the largest computer network that covers a large geographical area 

such as different countries or even whole world. Generally, WAN is an interconnection of 

several LANs and MANs distributed all over the world. A WAN provides long-distance 

transmission of data, voice, image, or other information over large geographical areas that 

may cover a country. Several local networks can be connected using network devices like 

routers, gateways, bridge, etc. to form a WAN. Computers are connected to a wide area 

network through leased lines or satellites. Internet is the most popular wide area network. 

Characteristics of WAN: 

 A wide area network (WAN) is a computer network that spans over a wide 

geographical region. 

 WAN is an interconnection of several LANs and MANs. 

 The data through the WAN can be transmitted over high speed leased phone lines or 

wireless links such as satellites. 

 WAN provides various network services used by a variety of protocols. 

 Through a wide area network, different computers are linked to a remote central 

database managed by a system server. 

10.4 HISTORY OF INTERNET 
Internet is the interconnection of computer networks. It is a very large hardware combination 

of millions of personal, business, and government computers. Internet is the major technical 

infrastructure that allows millions of users throughout the world to get connected with people, 

product, and services at various parts of the globe. 

Evolution of Internet- 

In the late 1960s, US department of Defence became interested in computer networking and 

formed a research agency known as the Advanced Research Project Agency (ARPA) to 

research on networking. ARPA projects included a wide area network called ARPANET- Ist 

version of the internet. ARPANET was used to connect computer at different geographical 

locations and move data among those locations. 

Robert Kahn and Vinton Cerf in 1973, worked together to develop a protocol for connecting 

several networks together. These protocols are Transmission Control Protocol/Internet 

Protocol (TCP/IP). Over the next few years, Robert Metcalfe developed a system allowing 

data transmission over a network through cables called Ethernet. 
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In 1982, the first commercial network was developed and allowed for email communication. 

In 1983, Domain name system was introduced to allow domain names to automatically assign 

an IP number. In 1990s, the Hypertext Markup Language (HTML) and the Uniform Resource 

Locator (URL) was developed by Tim Berners and his team. 

10.5 THE OSI MODEL 
The Open System Interconnection (OSI) model is a layered framework for the design of 

network systems that allows for communication across all types of computer systems. This 

model describes how information from a software application in one computer moves 

through a physical medium to the software application in another computer. This model was 

introduced by ISO (International Organization for Standardization). The OSI model includes 

seven different layers and each layer performs a well-defined function. 

APPLICATION LAYER 

PRESENTATION LAYER 

SESSION LAYER 

TRANSPORT LAYER 

NETWORK LAYER 

DATA LINK LAYER 

PHYSICAL LAYER 

Figure 10.1 The OSI model. 

[1] Physical Layer- 

A physical interface between the network devices is provided by the physical layer. This 

layer is responsible for transmitting row bit streams over a communication channel between 

two nodes. It converts streams of binary bits into electrical or electromagnetic signals. 

Functions of the physical layer are- 

 Representation of bits 

 Determine physical topology 

 Physical characteristics of interface and transmission channel 

 Transmission mode 

[2] Data Link Layer- 

The error-free communication path between nodes over the physical channel is established by 

the data link layer i.e. the error detection and correction in the transmitted data is performed 

by the data link layer. The data link layer splits the bit streams into data frames that are 

transmitted sequentially. Functions of a data link layer are- 

 Data framing 
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 Error control 

 Flow control 

 Access control 

 Physical addressing 

[3] Network Layer- 

A network layer builds the logical path between the source and the destination nodes of the 

network. In the network layer first, the transmitted message is fragmented into packets. Then, 

sequencing and error control of these packets is performed. Thus, the routing decisions are 

taken at the network layer. The main network layer protocol is the Internet Protocol (IP). 

Functions of a network layer are- 

 Routing 

 Translation of  logical network address into a physical address 

 Packet switching and sequence control 

 Network layer flow control 

 Network layer error control 

[4] Transport Layer- 

Once a path is established between the sending and receiving stations, the transport layer 

provides control standards for a communication session for enabling processes to exchange 

data reliably and sequentially. The transport layer accepts data from the above session layer, 

splits it into smaller units, and pass the data units to the lower layer (network layer). 

Transport layer protocols are Transport Control Protocol (TCP) and User Datagram Protocol 

(UDP). Functions of the transport layer are- 

 Service point addressing 

 Segmentation and reassembly 

 Connection control 

 Flow and error control 

[5] Session Layer- 

A session between two end users is established, maintained and terminated by the session 

layer. It manages and synchronizes the conversation between two different applications. 

Functions of the session layer are- 

 Dialog Control 

 Synchronization 

[6] Presentation Layer- 
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A presentation layer is responsible for converting the message data in a form easily 

recognized by the receiver. For this, it may perform code conversion, compression & 

decompression, encryption & decryption on message data depending on the requirement of 

the applications. Functions of the presentation layer are- 

 Data encoding and decoding 

 Compression and decompression 

 Encryption and decryption 

[7] Application Layer- 

Various network services that support the user of the network are provided by the application 

layer. The most common services provided by this layer include e-mail, transfer of files, 

directory services, remote login, network resources, etc. Some application layer protocols are 

FTP (File Transfer Protocol), HTTP (Hypertext Transfer Protocol), SMTP (Simple Mail 

Transfer Protocol), TELNET, etc. Functions of the application layer are- 

 File transfer 

 Mailing service 

 Directory service 

 Remote login 

10.6 TCP/IP PROTOCOL SUITE 
Network protocols are the set of rules, procedures, and standards to determine the way 

systems communicate and data is transferred from one system to another. The collection of 

protocols that are designed to work together is called a protocol suite. The TCP/IP is a 

protocol model defined with four layers. Each layer of the TCP/IP suite contains relatively 

independent protocols. 
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Figure 10.2 The TCP/IP Suite 

[1] Network Access Layer (Physical and Data Link Layers)- 

This is the lowest layer of the TCP/IP model. The physical and data link layers together is 

called network access layer in TCP/IP suite. This layer is responsible to determine the 

transmission of data between the two devices on the same network. This layer receives the 

data packets from the network layer (Internet Layer) and sends it to the destination over a 

physical media. 

[2] Network Layer (Internet Layer)- 

Internet or Network layer form the data packets called IP datagrams that include source and 

destination address (IP address). Network layer protocols are: 

 Internet Protocol (IP) - IP defines the host’s logical address called IP address. This 

address is used by the network to identify the device. This protocol is responsible to 

route the data packet to its respective destination. 

 Address Resolution Protocol (ARP) - This protocol links logical address (IP address) to 

physical address. 

 Internet Control Message Protocol (ICMP) - ICMP is used to send notification of 

datagram problems back to the sender. It is responsible to send the query and error 

reporting messages. 

 Internet Group Message Protocol (IGMP) - IGMP is a group management protocol that 

manages group membership in a multicast network. 

[3] Transport Layer- 

The transport layer is responsible to form end-to-end connections between the source and the 

destination. The protocols of the transport layer are: 

 Transmission Control Protocol (TCP) - TCP is a connection based and reliable 

protocol. It provides full transport layer services to the application. It provides host-to-

host communication. 

 User Datagram Protocol (UDP) - UDP is a connectionless unreliable protocol. It 

provides the procedure to process communication. 

[4] Application Layer 

In a TCP/IP model the application layer is equivalent to the combinations of session, 

presentation and application layers of the OSI model. It performs all the responsibilities of 

sessions, presentation, and application layers. The main protocols of the application layer are: 

 Hypertext Transfer Protocol (HTTP) - It is a communication protocol that is used to 

transmit the contents of web pages called hypertext from web servers to web browsers. 
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 Simple Mail Transfer Protocol (SMTP) - It is a communication protocol for electronic 

mail. SMTP is used to send messages from one server to another.  

 Domain Name System (DNS) - The main function of DNS is to translate the domain 

names into IP addresses on the internet. 

 File Transfer Protocol (FTP) - FTP allows the users to move files from one computer to 

another on the internet. FTP provides the facility of uploading and downloading. 

 Terminal Network (TELNET) - Telnet service allows the user to log in to a remote 

computer from a local machine on the internet. 

10.7 POINTS TO REMEMBER 
 Data communication is the process of transferring data and information from one 

computer to another. 

 The main components of a communication system are the source, medium, and 

receiver. 

 A computer network is a collection of computers and other devices which are linked 

together for data communication.   

 The main objective of a computer network is sharing of information, resources, and 

distribution of the processing load. 

 Networks are of three types: Local Area Network (LAN), Metropolitan Area Network 

(MAN) and Wide Area Network (WAN) 

 LAN is a computer network within a campus, building, and group of buildings in a 

limited geographical area. 

 A metropolitan area network (MAN) is similar to a local area network (LAN) but spans 

an entire city or campus. MANs are formed by connecting multiple LANs. 

 A wide area network (WAN) is a computer network spanning over states, countries, or 

all over the world. 

 The arrangement of computers and other devices in a network is called topology. 

 Some common network topologies are BUS, STAR, RING, MESH, TREE, etc. 

 Internet is an interconnected network of computers and other resources all over the 

world. It is a collection of many separate networks. 

 Internet has its root in the US army. Internet started in 1960s, under the original name 

ARPA (Advances Research Project Agency). 

 In 1973, Robert Kahn and Vinton Cerf developed Transmission Control 

Protocol/Internet Protocol (TCP/IP) for connecting several networks together.  

 In 1990s the Hypertext Markup Language (HTML) and the Uniform Resource Locator 

(URL) was developed by Tim Berners and his team.  



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 10: Layered Architecture of Internet and Protocols- I Page 131 of 166 

 The Open System Interconnection (OSI) model provides a standard for layered 

protocols for a computer network. This model is created by the International Standards 

Organization (IOS). 

 The seven layers of OSI model are physical, data link, network, transport, session, 

presentation, and application. Each layer has some specific functionality.  

 The bottom three layers of OSI model (physical, data link, and network) are network 

support layers. 

 The top three layers of OSI model (session, presentation, and application) are the user 

support layers. 

 The network support layers and user support layers are linked by the transport layer. 

 The physical layer is responsible for the movement of individual bits from one node to 

the other. 

 The data link layer splits the bits stream received from the network layer into data units 

called frames and responsible for moving these frames from one node to the next 

without error. 

 The network layer is responsible for the delivery of individual packets from source host 

to the destination host. 

 The main function of the transport layer is the delivery of the message from process to 

process. 

 The session layer establishes, maintains, and synchronizes the interactions between 

communicating devices. It allows a process to add checkpoints. 

 The main functions of the presentation layer are data translation, compression, and 

encryption. 

 The application layer enables users to access the network. It provides network services 

such as e-mail, file transfer, remote login, etc. 

 TCP/IP reference model is a four layered protocol suite developed by the department of 

US defence in 1960s. 

 The four layers of TCP/IP model are the Host-to-Network layer, Internet/Network 

layer, Transport layer, and Application layer. 

 The lowest layer of TCP/IP is the Host-to-Network layer which combined the physical 

and data link layers of the OSI model. This layer is concerned with the physical 

transmission of data. 

 Internet or Network layer defines protocols for logical transmission of data. Internet 

Protocol (IP) is the main protocol in this layer. 

 Transport layer defines Transport Control Protocol (TCP) and User Datagram Protocol 

(UDP) for end-to-end error free delivery of data. 

 The application layer in a TCP/IP model combines the functionalities of the session, 

presentation, and application layers of the OSI model. This layer includes several 
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protocols like HTTP, FTP, SMTP, TELNET, etc to allow access to network resources 

and services. 

10.8 GLOSSARY 

 Peripheral Devices- Peripheral devices are the internal or external devices that connect 

to the computer to perform computer’s primary functions such as input, output, and 

storage. Some common peripheral devices are keyboard, mouse, printer, CD-ROM and 

DVD drives, flash memory drives, etc. 

 Electronic Commerce- Electronic commerce or E-commerce is defined as the trading of 

goods, services, information, or anything else of value between two entities over the 

internet. 

 Topology- The physical and logical arrangement of computers and other resources in 

the network is called a network topology. Some basic topologies are bus, ring, star, tree, 

mesh, etc. 

 Uniform Resource Locator (URL) - A URL is the address of a specific webpage or file 

on the internet. It is a reference to a web resource that specifies its location on the 

computer network. An example of URL is https://www.Myweb.com  

 Data Transmission Modes- The direction of the flow of information between two 

communicating devices can be determined by the data transmission modes. Data 

transmission modes are simplex, half-duplex and full-duplex. In simplex mode, data 

can flow only in one direction. In half-duplex mode, data can flow in both directions 

but in one direction at a time. In full-duplex mode, data can flow in both the directions 

at the same time. 

 Synchronization- To transmit a long file, the session layer allows a process to add 

checkpoints. So, if a crash encounters during data transmission, the transmission of the 

file resets from the last checkpoint. This process is called data synchronization. 

 Encryption and Decryption- The network layer adopts a privacy policy to transmit 

sensitive information. Encryption is the process of converting the original message in 

some other meaningless form called ciphertext. Decryption is the process of converting 

the meaningless message (ciphertext) into its original form at the receiver end. 

 Data Compression- Compression is the process of reducing the number of bits 

contained in the message to be transmitted. 

10.9 CHECK YOUR PROGRESS 

Objective type questions- 

a) An interconnected network of networks is known as..... ..... ..... 
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b) IP stands for ..... ..... ..... 

c) A ..... ..... ..... is a collection of local area networks within a city. 

d) The internet is an example of a ..... ..... ..... network. 

e) ..... ..... ..... layer of TCP/IP model deals with TCP and UDP protocols. 

f) A single computer on a network is known as a ..... ..... ..... 

g) Bits are packaged into frames at ..... ..... ..... layer of OSI model. 

h) The physical layer is concerned with the movement of ..... ..... ..... over the physical 

medium. 

i) The ..... ..... ..... layer of OSI model is responsible for encryption and decryption. 

j) ARPA stands for ..... ..... ..... 

Descriptive type questions- 

a) What is a computer network? Describe the types of computer networks? 

b) Explain the brief history of Internet? 

c) Describe the OSI model with the functionality of each layer? 

d) List the services of internet? 

e) What protocols are parts of different layers of TCP/IP suite? 

Answer (Objective type questions)- 

[a] Internet  [b] Internet Protocol  [c] MAN  [d] Wide Area  [e] Transport 

[f] Node  [g] Data Link   [h] Bits  [i] Presentation  

[j] Advanced Research Project Agency 
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11.1 INTRODUCTION 
Knowledge and information can be sourced by utilizing e-content technology. E-Content is a 

web-based blended interactive way of digital content that is electronically delivered. For 

electronic learning, it becomes essential to develop e-content with the varieties of tools 

available. There exist many e-content delivery platforms to exhibit our content. Some of the 

basic tools for developing interactive e-content, simple delivery platforms, and grading tools 

are explained in this unit. In a developing country like India e-learning can raise the level of 

education, literacy, and economic development. Learning anything, anywhere, at any time is 

the current scenario. 

E-Contents provided through e-learning are the future content system for school education to 

higher education and even for faculty members. Currently, e-contents are available for 
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school education, diploma, degree, postgraduates, research scholars, and faculty 

members. There is an enormous growth rate in the tools used for designing a learning 

management system. The actual challenge here is the need to develop interactive 

courses that are both rich in content and interesting to the viewer. Many tools such as 

e-content generators, screen casting tools, audio and video creator, animations, 

simulators, grading tools, content management tools, survey tools, editorial calendars, 

and many more are available to create a rich and powerful delivery platform. The e-

content growth rate in India is less compared to other developing countries. 

11.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Know the basic tools and techniques of e-content development. 

 Define the benefits and importance of e-content development. 

 Understand the basic concepts of HTML.  

 Understand the basic concepts of website planning for e-content/e-tutorials. 

11.3 E-CONTENT 
The rapid development in computer technology, together with the use of computers by the 

teachers paved the way for the introduction of computers in teaching and learning. With the 

advancement of technology, the computer has become more user-friendly so teachers can 

develop e-content easily. E-content is a very powerful tool of education. E-content is valuable 

to the learners and also helpful to teachers of all individual instruction systems. E-content is 

the latest method of instruction that has attracted more attention to gather with the concept of 

models. 

E-content can be defined as the digital content (electronic-content) that can be transmitted 

over a computer network such as the Internet. (Source- Wikipedia) 

Types of E-content- 

E-content is termed as electronic content including text, image, graphics, animation, audio, 

and video. Sometimes, e-content can be carrying any one of the above elements or all of the 

above together to display offline or online web-pages and also to be transferable to computer 

to another computer and internet. 

Electronic content (e-Content) or digital content is defined by those involved in creating, 

providing, and distributing information 4 as the digitized content, which is viewed on screen 

and not on paper. Contents that are produced and stored electronically rather than in print are 

the result of electronic publishing (e-publishing). The contents can be in any of the following 

forms:   
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[i] Any one information type (for example fully textual, only graphics content, or only audio 

content)   

[ii] Multimedia or hypermedia (i.e. mixing more than two information type) 

E-Resources- 

Pictures, photos, audios, videos, demonstrations, animations, graphics, etc can be included 

based on the interest of the investigator or producer. The most important aspect is that the 

material should be accessible and knowledge based and also help induce individual’s interest 

to learn. These things must be kept in mind while preparing a perfect content based on the 

learner’s level of understanding. 

Text format- 

Text font selection is the main area of concern regarding the e-content presentation while 

developing a package. The preferred font may be taken as Times new roman, Bookman Old 

style, San serif, Serif, etc. The font visionary and style can also form an important aspect 

during development. 

Video- 

Avoid ambiguity while preparation, casual, providing enough spacing between words and 

sentences, correct pronunciation for the words, relevance, modulation, voice pitch 

corrections, clarity in visual presentation mode, etc should be done for perfection. 

Image, photo, and picture- 

Quality items should be selected while downloading. High-resolution formats are fairly 

preferred and pixels should be high rated so that magnification or zooming done during 

learning leads to usefulness for learners. 

Script writing- 

It’s an art. The script writing reveals the interest of the investigator and helps the developer as 

well in the successful development of a package. Relevant sentences with simple meaning are 

usually accepted. Being a writer, one should not include his/her higher level language to 

complete the work. The script should be easy to read and the learner should not have 

difficulty in understanding its meaning. A higher level of language style or tough words 

should not be used anywhere. Most important is the script should be written according to the 

level of the learner’s class. Precision is another equally important attribute. It should be like 

an actual classroom practice environment. 

11.4 
BENEFITS AND IMPORTANCE OF E-CONTENT 
DEVELOPMENT 

Advantages of E-Content- 
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Many institutions publish books, research reports, lecture modules, and other information for 

academic purposes. All these publications are usually in-print form and stored in the library 

for fellow lecturers, researchers and students use. Are there compelling reasons why these in-

print publications should be in electronic form? To answer this, it is necessary to identify the 

advantages and disadvantages of printed content (p-content) and e-content. According to 

Bonime and Pohlmann, (1998) e-contents benefit from- 

 Hyper linking - contents can be linked to other pages inside and outside the book. 

 Non-linearity - the order of access can be determined by users.  

 Addition of multimedia - content presentation is enhanced by mixing information type 

(i.e. sound, video and so on) data density - storage capacity is decreased increasing 

portability simultaneously. 

 Searching - the usefulness of the content is enhanced by the ability of the users to locate 

any piece of information or to access any section instantly. 

Importance of E-Content 

 E-content is user friendly and one can download and use text materials on any 

computer independently. 

 E-content being learner friendly is easy to navigate.   

 Another important feature of e-content is that being learner-centric it proves quite 

useful in the self-instructional model.   

 E-content is also teacher’s friendly and can used in various teaching- learning methods 

such as classroom, lecturing to a group, lab session. 

11.5 
TOOLS AND TECHNIQUES OF E-CONTENT 
DEVELOPMENT 

Nowadays, a wide range of tools are present to help create e-content from simple PowerPoint 

presentations to 3D animations. The E-content is actually a virtual teacher which provides us 

high-quality digital content that is well designed, developed, and validated. Various factors 

like the subject, its complexity, learner, and nature of the content influence the design. 

Several models and design strategies are available to develop the e-content. The general steps 

that are mostly followed are analysis, design, development, implementation, and evaluation. 
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Articulate Storyline is easy to use software that helps create virtually powerful content that is 

both interactive and easily accessible to mobile users. An optimal view is automatically 

provided to mobile users. The triggers are used to create effective interactivity in storyline. 

We can decide when an action should take place, where should it take place (like in the same 

layer or other layers) and what should be the action that is possible only with triggers. It is 

also possible to create a questionnaire that may include true/false, MCQs, match the 

following, image matching, etc. Simple animations can be created here as well. The tables are 

used here to organize the content and present them neatly to the user. 

Figure 11.1 Articulate Storyline Screen Shots 

[1] Screen Casting Tools 

The screen output is the video screen capture along with the audio that can be digitally 

recorded. This is known as screen casting. Many softwares are available for screen casting 

some of them include CamStudio, Screencast-O-Matic, Screenr, and Jing which are available 

free. Some are free web-based software. The Screencast-O-Matic is easy to use free web-

based casting tool. By simply clicking the ‘Start Recording’ one can activate the online 

recorder. The user can choose the recording mode. They can record only the screen, webcam, 

or both and can select the region for recording on the screen. This can be saved on their 

computer or can be directly uploaded. Wevideo, Magisto, Videopad, Openshot are some 

video creators and editors. 

[2] Audio Generators 

The presentation will be powerful when we have audio accompanied with it. Many free 

software such as Free Sound Recorder, Audacity, and WavePad are available to record our 
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audio. Audacity is open source software that allows us to record live audio and comes with 

several features. The recorded audio can be cut, copied, and mixed with other sound effects. 

We can also change the speed or pitch of a recording. It is also possible to convert old 

recordings into digital form and edit any type of sound file formats. 

[3] Animations  

A picture is worth a thousand words similarly, an animation can make us understand even a 

complex system. Simulations or movement can be created by generating a chain of pictures 

and giving effects that create an optical illusion of movement. The common methods of 

presenting animations include video programs, motion picture, and various other forms are 

available. We can have a 2D or 3D animation in our presentation. A 2D animation creates 

movement in a two-dimensional space and allows us to create characters, storyboards, and 

backgrounds. In 2D animation the objects can move up, down, left, and right. 2D animation 

uses bitmap and vector graphics to create and edit animated images. Some of the popular 

software available are: Adobe Photoshop, Flash, Synfig, and Encore. 2D animations are easy 

to generate whereas 3D animation requires deep knowledge and skill in modelling 3D 

objects. Modelling, animation, and rendering form the basics of 3D animations. 

There are many 2D to 3D open source converter software available. The convertor tool adds 

depth information to the 2D image. Different algorithms and techniques are used by different 

converters to convert a given 2D image into a 3D image. Some of the popular software 

available are: Blender, Make3D, 3DShade, Recap pro, Insight3D, ConvertImage, etc. Some 

of them are fully automatic and automatically estimates depth for an image. Most of the 

convertors get 2D images captured from a normal camera and store them in PC in standard 

image formats as input while adding depth using various techniques. Others are semi-

automatic; we have to assign depth to various parts of the image. We need to define a few 

parameters like width, depth and the position of object explicitly. 

[4] Grading Tools 

To know the real outcome and to evaluate the student performance, grading becomes 

essential. It is a prime concern in deciding student success. Grading gives feedback to 

students on their performance and helps them know their strengths and weaknesses. Some of 

the tools available for grading are: ActiveGrade, LearnBoost, JumpRope, Answer pad, and 

FreshGrade. Rubric is a popular grading tool used for marking assignments, class 

participation, or overall grades. There are two types of rubrics namely holistic rubric and 

analytical rubric. They help us decide what criteria or essential elements must be present in 

the student’s work to ensure that it is high in quality. A rubric allows us to the decide number 

of levels of achievement, components at each level, and their relation to the grading scheme. 

We can also add comments. 
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11.6 E-CONTENT DELIVERY PLATFORMS/TOOLS 
The E-content delivery platform known as LMS (Learning Management System) is a server-

based or cloud-based software program. LMS has information about courses, users, and 

course content. A learning management system provides a platform to teach and learn 

without depending on the time and space boundaries. Anybody can take any course in they 

are interested in. Learning Management System is a software application that manages 

various functions like administration of classrooms online, documentation of various courses, 

tracking the progress of the user, reporting of training programs, online events, and grading 

the users. Most of the LMS has the following features: Registration and Enrolment options to 

teachers and students, adding and deleting courses by Universities and other educational 

bodies, set different roles for users and managing user account, setting the course calendar, 

uploading and retrieving assignment, and resources. LMS is used by students, teachers, and 

administrators. LMS can be used by anyone interested in conducting online classes and 

storing or retrieving student’s documents. The modules can be grouped under the following 

categories: 

 Content Manager  

 Course Manager  

 Catalogue Manager  

 User Profile Manager  

 University Consortium Manager  

 Learning Planner and Calendar  

Some popular LMS software available in the market are: Canvas, MindFlash, LearnUpon, 

Moodle, Blackboard, Talentless, and BridgeLMS. One of the easy to work with and free 

online software available is the Canvas. Canvas upon simple registration allows us to create 

our own course in teacher’s mode and as a student we can join n number of courses. It 

supports content in various formats, e.g. multimedia, video, and text. Users can have any 

number of modules and pages inserted into it. The option provides a way to insert any 

number of files uploaded to the Canvas which can be viewed by the student. Animations, 

simulations, interactive contents, audio files, and screen casting can be added to our course. 

This paves the way for the learner to properly understand the concept and have a clear idea. It 

also offers assignments to the students in order to evaluate and grade them easily. Teachers 

can modify information according to the need of the student. 

Using the proper learning strategies, LMS can increase the motivation of learners, promote 

learning, encourage interaction, provide feedback and support during the learning process. 

However, improvement in teaching methodology and the outcomes of the learning are not 

guaranteed through the learning management system. This kind of teaching involves reuse of 
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the content and thus saves cost, effort, and time. Various innovative activities are offered to 

the learners to make learning active and interesting. 

Figure 11.2 Canvas Instructure Screen Shots 

11.7 OPEN SOURCE E-CONTENT DEVELOPMENT TOOLS 
The e-learning community has several sets of technology standards and is currently 

developing additional standards. The ultimate vision is to have interoperability throughout the 

entire e-learning market. Until then, the e-learning community is fragmented into different 

systems adhering to various standards. The four most common standards are Aviation 

Industry Computer-based Training Committee (AICC), Sharable Content Object Reference 

Model (SCORM), IMS Global Learning Consortium, and Microsoft LRN. Many of the 

products offered in today's e-content marketplace are shifting from proprietary apps to open 

standards like HTML5. Open-standard products and software offer many of the same features 

as closed applications but provide the additional benefit of working across the most common 

device platforms. Open-standard products and software also allow for greater longevity, since 

the e-content can continue to be accessed through various devices even as technologies 

develop further 

[1] eXe 

eXe stands for e-learning xhtml editor, an authoring application to assist teachers and 

academics in the publishing of web content without the need to become proficient in HTML 

or XML markup languages. eXe grew out of the New Zealand Government Tertiary 



CVTEE / DVTEE- 101: ICT Resources and Applications- I UOU 

Unit 11: E-Content Development Page 143 of 166 

Education Commission's e-collaboration fund led by the University of Auckland, Auckland 

University of Technology, and Tairawhiti Polytechnic. It was later supported by CORE 

Education, a New Zealand-based not-for-profit educational research and development 

organisation. It has also been greatly assisted by a global group of participants and 

contributors. 

[2] Xerte 

Xerte is an open-source content creation tool that allows non-technical staff to quickly and 

easily create built-in rich, interactive, and engaging resources with high levels of 

accessibility. Xerte was developed by the University of Nottingham supported by JISC 

Techdis. 

[3] GLO Maker  

GLO Maker is an authoring tool for creating rich, interactive learning resources. It builds on 

the extensive experience of the Centre for Excellence in Teaching and Learning (CETL) in 

Reusable Learning Objects. It is an open source and free for educational use. GLO Maker 

authoring tool is based on the new concept. Generative Learning Objects (GLO) approach 

inverts the traditional approach for reusability. The traditional approach to the reuse of 

learning objects has been to separate content from the context to make the content reusable. 

However, in GLO, it extracts successful pedagogical designs and makes these the basis for 

reuse (GLO Maker 2009). In this design-based approach for learning objects, designs have to 

be rendered explicit in two distinct ways. The first form relates to human understanding 

which is pedagogical design. Then, the design should be rendered to produce a learning 

object based on that design. GLO Maker was developed by London Metropolitan University. 

[4] Course Lab  

Course Lab is a powerful, easy-to-use, e-learning authoring tool that offers programming-free 

and WYSIWYG environment for creating high-quality interactive e-learning content. 

Features:  

 Publish to HTML package.  

 Publish to CD-ROM.  

 Publish to SCORM 1.2 and SCORM 2004 package for import to any LMS supporting 

this standard. 

[5] LAMS  

LAMS, the Learning Activity Management System, is an open source Learning Design 

system for designing, managing, and delivering online collaborative learning activities. It 

provides teachers with an intuitive visual authoring environment for creating sequences of 

learning activities. These activities can include a range of individual tasks, small group work, 
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and whole class activities based on both content and collaboration. LAMS is inspired by the 

concept and principles of IMS Learning Design. LAMS was developed in collaboration with 

the LAMS Foundation, LAMS International, and the Macquarie E-learning Centre of 

Excellence (MELCOE), all based in Sydney, Australia, in affiliation with Macquarie 

University. LAMS have been developed since 2003. 

11.8 INTRODUCTION TO HTML 
Hypertext Markup Language (HTML) is the standard markup language for creating Web 

pages. HTML can be described as follows- 

 HTML stands for Hypertext Markup Language. 

 HTML describes the structure of a Web page. 

 HTML consists of a series of elements. 

 HTML elements tell the browser how to display the content. 

 HTML elements are represented by tags. 

 HTML tags label pieces of content such as "heading", "paragraph", "table", and so on. 

 Browsers do not display the HTML tags but use them to render the content of the page. 

The HTML Documents- We can use any text editor to write HTML over it, and save the 

document with dot html (.html) file extension. All HTML documents must start with a 

document type declaration: <!DOCTYPE html>. The HTML document itself begins with 

<html> and ends with </html>. The visible part of the HTML document is between <body> 

and </body>. Example- 

<!DOCTYPE html> 

<html> 

<body> 

<h1>My First Heading</h1> 

<p>My first paragraph</p> 

</body> 

</html> 

Html Elements and Attributes 

An HTML element usually consists of a start tag and an end tag, with the content inserted in 

between- <tagname> Content goes here...</tagname> 

The HTML element is everything from the start tag to the end tag: 
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<p>My first paragraph. </p> 

HTML elements with no content are called empty elements. Empty elements do not have an 

end tag, such as the <br> element (which indicates a line break). 

Nested HTML Elements- HTML elements can be nested (elements can contain elements). All 

HTML documents consist of nested HTML elements. 

HTML Attributes- HTML attributes can be described as follows- 

All HTML elements can have attributes 

Attributes provide additional information about an element 

Attributes are always specified in the start tag 

Attributes usually come in name/value pairs like: name="value" 

Commonly used attributes in html are as follows- 

[1] The href Attribute 

HTML links are defined with the <a> tag. The link address is specified in the href attribute: 

Example 

<a href="https://www.w3schools.com">This is a link</a> 

[2] The src Attribute 

HTML images are defined with the <img> tag. 

The filename of the image source is specified in the src attribute: 

Example 

<imgsrc="img_girl.jpg"> 

[3] The width and height Attributes 

HTML images also have width and height attributes, which specifies the width and height of 

the image: 

Example 

<imgsrc="img_girl.jpg" width="500" height="600"> 

[4] The alt Attribute 

The alt attribute specifies an alternative text to be used if an image cannot be displayed. 

The value of the alt attribute can be read by screen readers. This way, someone "listening" to 

the webpage, e.g. a visually-impaired person can hear the element. 

Example 
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<imgsrc="img_girl.jpg" alt="Girl with a jacket"> 

[5] The style Attribute 

The style attribute is used to specify the styling of an element, like color, font, size, etc. 

Example 

<p style="color:red">This is a red paragraph.</p> 

HTML Tags- Some commonly used html tags are as follows- 

Tag Description 

<!--...--> Defines a comment 

<!DOCTYPE> Defines the document type 

<a> Defines a hyperlink 

<area> Defines an area inside an image-map 

<b> Defines bold text 

<body> Defines the document's body 

<br> Defines a single line break 

<button> Defines a clickable button 

<center> Defines cantered text 

<figure> Specifies self-contained content 

<font> Defines font, colour, and size for text 

<footer> Defines a footer for a document or section 

<form> Defines an HTML form for user input 

<h1> to <h6> Defines HTML headings 

<head> Defines information about the document 

<header> Defines a header for a document or section 

<html> Defines the root of an HTML document 

<i> Defines a part of text in an alternate voice or mood 

<img> Defines an image 

<link> Create link between a document and an external resource 

<p> Defines a paragraph 

<table> Defines a table 

<title> Defines a title for the document 
 

11.9 
WEBSITE PLANNING AND STRUCTURE FOR E-
CONTENT/E-TUTORIALS 

Guideline for Website Planning- 

Basically, it’s how your website is connected. How your main pages lead to deeper pages on 

your website. You can see it as how your navigation and sitemap are built.  
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Why Plan a Website Structure? 

Well, you wouldn’t build a house without a plan, so why would you want to build your 

business website without it. It can help to improve your user experience, your SEO, your 

internal linking and the simplicity of usage. You should understand that planning a structure 

isn’t just about the main website it’s also about the blog and internal linking. 

Creating a website is a complex endeavour to embark on. Every change, every added 

functions, every addition of content increases the workload, time, and expense of a website, 

but all of that can be managed with a website plan. Creating a website plan saves you 

countless headaches down the road. 

Steps for Creating Website Structure-  

The essential steps for creating website structure are- 

 Start by getting the basic insights to your business/applications- This means getting to 

know your own business. It’s not just important when you talk to a designer or whoever 

will create your website. This is important when for you too. 

 Start doing your keyword research- Next step would be to dive into the keyword 

research. Paid tools have even more data to give a bigger edge when researching for 

your business keywords. 

 Competition research- In this step, we are technically still at keywords research, but we 

are going to go further into the competition of your website. 

 Create your website’s URL structure- Most common URL structure looks like this. You 

have a homepage, services, about us, references/work, blog, and contact. This will 

represent your hierarchy, URL structure, and the main navigation. You get something 

like this, a simple website diagram. 

Figure 11.3 Sample website planning diagram 
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 Create a Simple and Logical Navigation- If you plan your website structure as shown 

above you shouldn’t have any trouble creating the navigation for your website. 

 Create Your Navigation with HTML and CSS- The safest way for crawlers to be able to 

read your navigation is to create your navigation with HTML and CSS. 

 Create an Internal Linking Strategy- Internal linking is what makes your website 

structure to work for your website. 

 It helps the structure to be logical, helps users navigate your website and establishes 

your shared information’s hierarchy. 

 Create a Sitemap for Your Website- The thing is that most search engines use sitemaps 

to find out about your new pages. It also helps search engines to index your pages faster 

than if you don’t have one. There are many tools (Sitemap Generator) to do that. 

Figure 11.4 Website information hierarchy. 

11.10 POINTS TO REMEMBER 

 E-Content is a web-based blended interactive way of digital content that is 

electronically delivered. 

 E-content technical definition: (Electronic-content) Digital content that can be 

transmitted over a computer network such as the Internet. 

 E-content is termed as Electronic content that includes text, image, graphics, animation, 

audio, and video. 
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 There exit wide varieties of tools to create e-content from simple PowerPoint 

presentations to 3D animations which create virtual reality of the object under study. 

 Some of the tools available for grading are: ActiveGrade, LearnBoost, JumpRope, 

Answer pad, and FreshGrade. 

 The E-content delivery platforms like LMS (Learning Management System) are a 

server-based or cloud-based software programs. 

 Open source software is a software with free to access to the public and lots of people 

in the world. 

 HTML is the standard mark-up language for creating web pages. 

 Creating a website is a complex endeavour to embark on. Every change, every added 

functions, every addition of content increases the workload, time, and expense of a 

website, but all of that can be managed with a website plan. 

11.11 GLOSSARY 

 CSS- Cascade Style Sheet. 

 URL- Uniform Resource Locator. 

 DOCTYPE- Document Type. 

 LAMS- Learning Activity Management System. 

 AICC- Aviation Industry Computer-based Training Committee. 

 SCORM- Sharable Content Object Reference Model. 

 LMS- Learning Management System. 

 2D- Two Dimensional. 

 3D- Three Dimensional. 

11.12 CHECK YOUR PROGRESS 

Objective type questions- 

a) Electronic-content Digital content that can be transmitted over a computer network 

such as the Internet. (True/False) 

b) E-content is termed as special content that include text and image only. (True/False) 

c) The E-content delivery platform is known as FMS (File Management System). 

(True/False) 

d) Open-source software is a software which codes are free – to – access to the public; and 

lots of people in the world. (True/False) 
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e) HTML stands for Hyper Text Makeup Language. (True/False) 

Descriptive type questions- 

a) What do you mean by E-Content? Why it is important for today’s education system? 

b) What are the tools and techniques used for E-Content development? 

c) Describe Open Source E-Content development tools. 

d) What is HTML? What is the difference between html element and html attribute? 

e) Why do we need to plan a website before design it? Explain. 

f) What are the steps to design a website structure? 

Answers (Objective type question) 

[a] True  [b] False [c] False  [d] True  [e] False 
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12.1 INTRODUCTION 
E-governance because of its scope and aims is highly relevant in today’s era.  In simple 

terms, it is the use of information communication technologies (ICTs) to carry out public 

services, that is to say, the use of the internet to ensure that services are delivered in a much 

more convenient, customer-oriented, and cost-effective manner. In other words, the e-

governance is the application of Information Technology to the processes of government 

functioning in order to achieve a Simple, Moral, Accountable, Responsive, and Transparent 

(SMART) Governance. 

In the overall perspective, the e-governance is simply the use of ICTs in the operations of 

government businesses, put in another way, it is the shift from the traditional method of 

carrying out government activities which is mainly hierarchical, linear, and one-way to the 

use of internet which enables the public to seek information at their own convenience and not 

really having to visit the office in person or when government office is open. 
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The major objectives of e-governance are to improve government processes (e-

administration), connect citizens (e-citizens and e-services), and build external interactions 

(e-society). Despite these objectives, making and implementing decisions, proper leadership, 

putting in place organizational arrangements, ensuring resources and funding, establishing 

accountability and measuring success, telecommunications network, internal agency systems, 

cross-government systems, service delivery network access points, internet access, and 

skilled staff, better delivery of government services to citizens, improved interactions with 

business and industry, citizen empowerment through access to information, and more 

efficient government management are the factors that must be taken into consideration for the 

success of e-governance implementation. 

12.2 OBJECTIVES 
After the successful completion of this unit, you will be able to- 

 Understand the role of e-governance for smart administration. 

 Define the importance of e-governance. 

 Explore e-governance projects in India. 

 Define the types and applications of e-governance. 

 Know the challenges of e-governance in India. 

12.3 E-GOVERNANCE: AN OVERVIEW 
The ‘e’ in e-Governance stands for ‘electronic’. Thus, e-Governance is basically associated 

with carrying out the functions and achieving the results of governance through the utilization 

of Information and Communications Technology (ICT). Why countries around the world are 

increasingly opting for ‘e-Governance’? In the last few decades, the expectations of citizens 

from the government have increased manifold. ICT facilitates efficient storing and retrieval 

of information, instantaneous transmission of information, processing information & data 

faster than the earlier manual systems, speeding up governmental processes, taking decisions 

expeditiously & judiciously, increasing transparency, and enforcing accountability. 

The primary purpose of governance is the welfare of citizens. While one aspect of 

governance relates to safeguarding the legal rights of all citizens, an equally important aspect 

is concerned with ensuring equitable access to public services and the benefits of economic 

growth to all. It is expected that e-governance would enable the government to discharge its 

functions more effectively and can be able to work with more transparency. 

In India, during the initial stage of introduction of ICT in governance there was some 

resistance. There were also serious doubts about whether government employees at all levels 

would be able to handle computers. As time passes, all goes beyond and fortunately all these 

misgivings have proved wrong. 
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Today, new technology makes the machine-human interface very user-friendly. The 

Information Technology (IT) and Information Technology Enabled Services (ITES) sectors 

have created millions of jobs besides improving vastly on the services provided by 

government undertakings like Banks, Airlines, Railways, etc.  

As a country like India, with 1.3 billion population, more than 600,000 villages, growing 

economy coupled with increasing aspirations of the citizens for a better quality of life – use 

of Information Technology in improving government processes is not just become vital but 

essential and without which it would be extremely difficult, if not impossible, to serve its 

citizens efficiently and transparently and ensure participation of a larger number of people in 

decision making at all levels of government– Centre, State and local. 

The National e-Governance Division (NeGD) is providing strategic direction in terms of 

framing policies and implementation strategy for the Digital India Programme in different 

domains of e-Governance. And also provides, proactive support to Central and State 

Governments for Mission Mode Projects (MMPs) and other e-Governance projects acting as 

a facilitator and catalyst for the implementation of the Digital India Program by various 

Ministries and State Governments. 

The NeGD also ensures effective citizen engagement and communication with all 

stakeholders using offline and Social Media channels. The role of NeGD in training and 

development initiatives, including- development of competency frameworks, training 

guidelines, case studies, etc. and developing online and web-based training and setting up of 

Learning Management System, knowledge management and sharing through workshops, 

development of case studies, sharing best practises, creation of knowledge repositories, etc. 

The e-governance is, in essence, the application of Information and Communications 

Technology to government functioning to create ‘Simple, Moral, Accountable, Responsive, 

and Transparent (SMART) governance. The e-governance involves the use of ICTs by 

government agencies for any or all of the following reasons, as- 

 Exchange of information with citizens, businesses, or other government departments. 

 Speedier and more efficient delivery of public services. 

 Improving internal efficiency. 

 Reducing costs/increasing revenue. 

 Re-structuring of administrative processes and improving the quality of services. 

The e-governance aims to make the interaction between government and citizens (G2C), 

government and business enterprises (G2B), and inter-agency relationships (G2G) more 

friendly, convenient, transparent, and inexpensive. The goals of e-Governance are- 

 Better service delivery to citizens. 
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 Ushering in transparency and accountability. 

 Empowering people through information. 

 Improved efficiency within Governments. 

 Improve interface with business and industry. 

12.4 IMPORTANCE AND BENEFITS OF E-GOVERNANCE 
E-governance is about reforms in governance, facilitated by the creative use of Information 

and Communications Technology (ICT). The importance and benefits of e-governance are 

not limited in respect to good governance, and citizen empowerment, few of them are as 

follows-   

 E-Governance brings governments closer to the citizens. 

 Provide simplicity, efficiency, and accountability in the government- Applications of 

ICT to governance combined with detailed business process re-engineering would lead 

to simplification of complicated processes, weeding out of redundant processes, 

simplification in structures & changes in statutes, and regulations. The end result would 

be the simplification of the functioning of government, enhanced decision-making 

abilities, and increased efficiency across government– all contributing to an overall 

environment of more accountable government machinery. This, in turn, would result in 

enhanced productivity and efficiency in all sectors of government functioning. 

 E-governance empowers people to gather information regarding any department of 

government and get involved in the process of government decision making. 

 E-Governance strengthens democracy by ensuring greater citizen participation at all 

levels of governance. 

 E-Governance leads to automation of services, ensuring that information regarding 

every work of public welfare is easily available to all citizens. 

 E-Governance revolutionizes the way governments function, ensuring much more 

transparency in the functioning, thereby eliminating corruption. 

 If the information regarding every activity of government is easily available, it would 

make every government department responsible as they know that every action of theirs 

is closely monitored. 

 Expanded reach of governance- Rapid growth of communications technology and its 

adoption in governance would help in bringing government machinery to the doorsteps 

of the citizens. Expansion of telephone network, rapid strides in mobile telephony, the 

spread of internet, and strengthening of other communications infrastructure would 

facilitate the delivery of a large number of services provided by the government. 
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 Proper implementation of e-Governance practices makes it possible for people to get 

their work done online thereby sparing themselves of unnecessary hassles of travelling 

to the respective offices. 

 Successful implementation of e-Governance practices offers better delivery of services 

to citizens, improved interactions with businesses, and industries. 

 E-governance helps citizen empowerment through access to information, better 

management, greater convenience, revenue growth, cost reductions, etc. 

 Enabling Environment for Promoting Economic development- Technology enables 

governments to create positive business climates by simplifying relationships with 

businesses and reducing the administrative steps needed to comply with regulatory 

obligations. There is a direct impact on the economy, as  e-procurement creates wider 

competition and more participants in the public sector marketplace. 

12.5 TYPES OF INTERACTIONS IN E-GOVERNANCE 
The e-governance facilitates interaction between different stakeholders in governance using 

ICT, such types of interactions are grouped into the following, as- 

Government to Government Model (G2G)- 

The G2G refers to the online communications between government organizations, 

departments, and agencies based on a super-government database. Moreover, it refers to the 

relationship between governments. G2G model of e-governance aims to enhance and improve 

inter-government organizational processes by streamlining cooperation and coordination 

among various government departments/organizations. The efficiency and efficacy of 

processes are enhanced by the use of online communication and cooperation which allows for 

the sharing of databases and resources and the fusion of skills and capabilities. 

Government-to-Business (G2B)- 

Government to business is another type of e-governance model which enables significant 

efficiencies to both governments and businesses. G2B includes various services exchanged 

between government and the business sector services. The business services offered include 

obtaining current business information, new regulations, downloading application forms, 

lodging taxes, renewing licenses, registering businesses, obtaining permits, and many more. 

Nowadays, the government-to-business (G2B) model has been receiving a significant amount 

of attention. 

Government-to-Citizens (G2C)- 

Government-to-Citizens (G2C) model of governance has been designed to facilitate citizen 

interaction with the government. It allows citizens to access government information and 
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services instantly, conveniently, from everywhere. The government-to-citizen model of 

governance focuses on customer-centric and integrated electronic services where public 

services can be provided based on a ‘one-stop solution’ concept. This implies that every 

citizen can get single window access to government services. G2C model of governance 

facilitates several services to the citizens, e.g. certifications, paying governmental fees, and 

applying for benefits schemes of government, etc. 

Government-to-Employees (G2E)- 

Government is by far the biggest employer and like any organization, it has to interact with 

its employees on a regular basis. This interaction is a two-way process between the 

organization and the employee. Use of ICT tools helps in making these interactions fast and 

efficient on the one hand and increase satisfaction levels of employees on the other so that the 

G2E model of governance is a valuable model of smart administration. 

12.6 E-GOVERNANCE PROJECTS IN INDIA 
The Government of India (GoI) established the Department of Electronics in 1970. The 

subsequent establishment of the National Informatics Centre (NIC) in the year 1977 was the 

first major step towards e-Governance in India. In the early 1980s, the use of computers was 

confined to very few organizations. The advent of personal computers brought the storage, 

retrieval, and processing capacities of computers to Government offices. By the late 1980s 

gradually, with the introduction of common use software such as word processing and other 

kinds of software, the computers were put to other uses like managing databases and 

processing information, etc. 

Advances in communications technology further improved the versatility and reach of 

computers, and many government departments started using ICT for a number of applications 

like tracking movement of papers and files, monitoring of development programmes, 

processing of employees payrolls, generation of reports, etc. 

The main thrust for e-governance was provided by the launching of the National Informatics 

Centre Network (NICNET) in 1987, the national satellite-based computer network. This was 

followed by the launch of the District Information System of the National Informatics Centre 

(DISNIC) programme to computerize all district offices in the country for which free 

hardware and software was offered to the State Governments.  

A National Task Force on Information Technology and Software Development was 

constituted in May 1998, while recognizing Information Technology as a frontier area of 

knowledge per se, it focused on utilizing it as an enabling tool for assimilating and processing 

all other spheres of knowledge. It recommended the launching of an ‘Operation Knowledge’ 

aimed at universalizing computer literacy and spreading the use of computers and IT in 

education. 
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In the year 1999, the Union Ministry of Information Technology was created. By the year 

2000, a 12-point minimum agenda for e-Governance was identified by the Government of 

India for implementation in all the Union Government Ministries/Departments. Some 

glimpse of the agenda- 

 Each Ministry/Department must provide Personal Computers (PCs) with necessary 

software up to the Section Officer level. Besides, Local Area Network (LAN) must also 

be set up. 

 It should be ensured that all staff with access and need to use computer for their office 

work are provided with adequate training. To facilitate this, inter alia, 

Ministries/Departments should set up their own or share other’s Learning Centres for 

decentralized training in computers as per the guidelines issued by the ministry. 

 Each Ministry/Department should start using the Office Procedure Automation 

software developed by NIC to keep a record of receipt of ‘dak’, issue of letters, as well 

as the movement of files in the department. 

 Payroll accounting and other house-keeping software should be put to use in day-to-day 

operations. 

Emergence of the National e-Governance Plan (NeGP)- 

About the future of e-governance, the lighting words by the great visionary Dr. APJ Abdul 

Kalam, former President of India, in his inaugural address at IIT Delhi (India) during 2003 at 

International Conference on 'e-governance' can be summarized as- “E-governance has to be 

citizen-friendly. Delivery of services to citizens is considered a primary function of the 

government. In a democratic nation of over one billion people like India, e-governance 

should enable seamless access to information and seamless flow of information across the 

state and central government in the federal set up. No country has so far implemented an e-

governance system for one billion people. It is a big challenge before us.” 

About National e-Governance Division (NeGD)- 

In the year 2009, National e-Governance Division was established by the Ministry of 

Electronics & Information Technology (MeitY) as an Independent Business Division under 

the Digital India Corporation. NeGD has played a pivotal role in executing e-governance 

Projects and initiatives undertaken by Ministries/ Departments, both at Central and State 

levels. The roles and responsibilities of NeGD are- 

a) Providing strategic direction in terms of framing policies and implementation strategy 

for the Digital India Programme in different domains of e-Governance. 

b) Proactive support to Central and State Governments for Mission Mode Projects 

(MMPs) and other e-governance projects. 
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c) Acting as a facilitator and catalyst for the implementation of the Digital India Program 

by various Ministries and State Governments. 

d) Providing technical assistance to Central Ministries/ State Line Departments in their e-

governance projects either directly or in collaboration with professional consultants. 

e) Undertaking technical appraisal of e-governance projects for examining issues like 

overall technology, architecture, framework standards, security policy, service delivery 

mechanism, sharing of common infrastructure, etc. 

f) Developing generic / model Expression of Interest (EoI), Request for Proposal (RFP), 

Standard Contracts, PPP Models, and other related documents for various stages and 

requirements of projects for the use of States. 

g) Ensuring effective citizen engagement and communication with all stakeholders using 

offline and Social Media channels 

h) Impact assessment and e-Readiness measurement of e-Governance projects of all States 

/ UTs. 

i) Recruitment, deployment and HR management of specialised resources in the State e-

Governance Mission Teams (SeMTs) in all States and UTs 

j) Training and development initiatives, including- (i) Development of competency 

frameworks, training guidelines, case studies, etc. (ii) Developing Online and Web-

based Training and set up Learning Management System (iii) Knowledge management 

and sharing through workshops, development of case studies, sharing best practises and 

creation of knowledge repositories, etc 

Implementation Strategy for E-governance- 

The approach and methodology adopted for NeGP contains the following elements- 

 Common Support Infrastructure. 

 Governance- Suitable arrangements for monitoring and coordinating the 

implementation of NeGP under the direction of the competent authorities have been set 

up. 

 Centralized Initiative, Decentralized Implementation. 

 Public-Private Partnerships (PPP) model is to be adopted wherever feasible to enlarge 

the resource pool without compromising on the security aspects.  

 Programme Approach at the National and State levels. 

 Ownership of Ministries- Under the NeGP, various Mission Mode Projects (MMPs) are 

owned and spearheaded by the concerned line ministries. 
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Some Mission Mode Projects implemented by NeGD- 

[1] Unified Mobile Application for New-age Governance (UMANG)- 

UMANG is envisaged to make e-governance. It provides a single platform for all Indian 

citizens to access pan India e-Gov services ranging from central to local government bodies 

and other citizen-centric services. UMANG intends to provide major services offered by 

central and state government departments, local bodies, and other utility services from private 

organizations. It provides a unified approach where citizens can install one application to 

avail multiple government services. UMANG service has been made available on multiple 

channels like mobile application, web, IVR, and SMS which can be accessed through 

smartphones, feature phones, tablets, and desktops. 

Note- Download UMANG App by giving us missed call on 97183-97183 or Visit- 

https://web.umang.gov.in/web/#/ 

[2] DigiLocker- 

DigiLocker system is a flagship initiative of the Ministry of Electronics & IT under the 

Digital India Programme. Targeted at the idea of paperless governance, DigiLocker aims to 

provide a digital wallet to every citizen of the country so that all lifelong 

documents/certificates can be electronically held under a single secure digital wallet. 

DigiLocker is a platform for issuance and verification of documents & certificates digitally, 

eliminating the use of physical documents. Indian citizens who sign up for a DigiLocker 

account get a dedicated cloud storage space that is linked to their Aadhaar(UIDAI) number.  

Note- To access Digilocker visit at- https://digilocker.gov.in 

[3] National Centre of Geo-informatics (NCoG)- 

NCoG is a single source Geographic Information System (GIS) platform for sharing, 

collaboration, location-based analytics, and decision support system, catering to central and 

state ministries/departments/agencies across the country. Under this project, location-based 

datasets such as data related to central government land banks, mining, forests, industrial 

parks, water resources, etc. are collated with attribute related data to bring out insights that 

are useful to support decision making. User departments can now pinpoint their operations, 

assets on a map, and plan better. NCoG has provided mobile applications for geo-tagging and 

creating evidence of completed operations under the Government schemes. 

Note- To access NCoG visit at- https://ncog.gov.in/ 

[4]- Rapid Assessment System (RAS) 

RAS is an online instant feedback for e-services (online as well as offline through counters) 

delivered by the Government of India and State Governments. The main objective of RAS is 
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to continuously assess the quality of e-Services, through feedback, under each e-governance 

project and realign processes to achieve targeted benefits. RAS interface prompts the citizens 

to provide feedback about the quality of service immediately after the citizen avails an e-

service of the Government. The analytic features of RAS help integrated departments in 

system improvement and better delivery of services. 

Note- To access RAS visit at- https://ras.gov.in/ 

[5]- Program Management Information System (PMIS)- 

PMIS build using open source technologies is used to track and monitor project initiation, 

planning, execution, and management. It can be utilized for Central/State/Integrated MMPs, 

Departmental and Adhoc projects under the Digital India programme. 

Note- To access PMIS visit at- https://pmis.negd.gov.in/ 

[6]- OpenForge platform- 

The objective of the OpenForge platform is to promote sharing and reuse of e-governance 

application source code. In 2015, the Ministry of Electronics & IT, Government of India 

rolled out the ‘Policy on Collaborative Application Development by Opening the Source 

Code of Government Applications’, which provides a framework for archiving government 

custom-developed source code in repositories and opening these repositories for promoting 

reuse, sharing and remixing. By opening the source code, the Government wants to 

encourage collaborative development between Government departments/agencies and private 

organizations, citizens, and developers to spur the creation of innovative e-governance 

applications and services. 

The scope of the project includes the development of a Collaboration Platform under the 

‘Source Open Policy’. Further, it includes the creation of a project team, development and 

maintenance of the platform, on-boarding of departments, promotion of the platform, and 

community management. The community to be created and managed through the platform 

will be a key driver in bringing agility and quality to the application development process. It 

will also lead to further reuse and value addition to the e-governance software landscape. 

Note- To access OpenForge visit at- https://openforge.gov.in/ 

[7]- Learning Management System (LMS)- 

LMS is a software application that automates the administration, tracking, and reporting of 

training events. LMS is a pioneer project under e-Kranti (an e-governance plan initiated by 

the Government of India). It is widely recognised that there is a tremendous need to enhance 

the skill sets and to develop an adequate number of appropriately trained resources for 

handling a variety of tasks including those who are expected to design and deliver 

Government services to the citizens. 
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Note- To access LMS visit at- https://lms.gov.in/ 

[8]- Miscellaneous e-governance Projects in India- 

 Passport Seva Project. 

 Immigration, Visa and Foreigners Registration & Tracking (IVFRT). 

 Insurance (Department of Banking) 

 Income Tax (Ministry of Finance/Central Board of Direct Taxes) 

 National Citizen Database/UID (Ministry of Home Affairs/Registrar General of India 

(RGI)/ Planning Commission, Now NITI Aayog). 

 Central Excise (Department of Revenue/Central Board of Excise & Customs) 

 Pensions (Department of Pensions & Pensioners Welfare and Department of 

Expenditure) 

 Banking (Department of Banking) 

 Land Records (Ministry of Rural Development) 

 Road Transport (Ministry of Road Transport & Highways) 

 Treasuries (Ministry of Finance) 

 E-District (Department of Information Technology) 

 Common Services Centres (Department of Information Technology) 

 e-Courts (Department of Justice, Ministry of Home Affairs) 

 e-Procurement (Ministry of Commerce & Industry/ DGS&D) 

 And many more. 

12.7 CHALLENGES OF E-GOVERNANCE IN INDIA 

 Lack of motivation and awareness towards the role and importance of e-governance. 

 Lack of citizen-centric nature of applications and poor cooperation among bureaucrats 

and people at the local level of governance. 

 Lack of trust, poor technical designs which leads to lack of interoperability among 

distinct e-governance applications, and underutilization of ICT infrastructure resources. 

 One of the challenges to attain the ability of high level of data abstraction is to maintain 

the privacy of data in designing e-governance applications. 

 Authentication is very important to know the right user of the services or it may be 

misused by private competitors. Meanwhile, the digital signature plays a major role in 

providing authenticity. In fact, it is expensive and causes for frequent maintenance. 

 Maintenance should be given due importance because IT ministry has been 

continuously developing new software to fill the current needs of citizens. 
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 Digital divide- Even in the era of science and technology, a huge gap exists between 

users and non-users of e-governance services. In India, majority of the masses, living 

below poverty line are deprived of government services. This gap needs to be made 

narrow, and then only the benefits of e-governance would be utilized equally. 

 Infrastructure is essentially required for the implementation of e-governance as much as 

possible in India. Electricity, Internet, and poor adaptability of technology will retard 

the progress of e-governance. In the context of developing countries, there should be 

enough basic facilities to give an impetus to e-governance. 

12.8 POINTS TO REMEMBER 

  E-governance is simply the use of information communication technologies (ICTs) to 

carry out public services, that is to say, the use of the internet to ensure that services are 

delivered in a much more convenient, customer-oriented, and cost-effective manner. 

  E-governance is the application of Information Technology to the process of 

government functioning to achieve a Simple, Moral, Accountable, Responsive, and 

Transparent (SMART) Governance. 

 The major objectives of e-governance are to improve government processes (e-

administration), connect citizens (e-citizens and e-services), and build external 

interactions (e-society).  

 It is expected that e-governance would enable government to discharge its functions 

more effectively and can be able to work with more transparency. 

 The National e-Governance Division (NeGD) is providing strategic direction in terms 

of framing policies and implementation strategy for the Digital India Programme in 

different domains of e-Governance.  

 E-governance strengthens the democracy by ensuring greater citizen participation at all 

levels of governance. 

 E-governance revolutionizes the way governments function, ensuring much more 

transparency in the functioning thereby eliminating corruption. 

 The rapid growth of communications technology and its adoption in governance would 

help in bringing government machinery to the doorsteps of the citizens. 

 E-governance helps citizen empowerment through access to information, better 

management, greater convenience, revenue growth, cost reductions, etc. 

12.9 GLOSSARY 

 CSC- Common Service Center. 
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 ERP- Enterprise Resource Planning. 

 G2B- Government to Business. 

 G2C- Government to Citizen. 

 G2E- Government to Employee. 

 G2G- Government to Government. 

 GPS- Global Positioning System. 

 ITeS- Information Technology enabled Services. 

 MCA- Ministry of Corporate Affairs. 

 NeGD- National e-Governance Division. 

 NeGP- National e-Governance Plan. 

 NISG- National Institute for Smart Government. 

 PPP- Public Private Partnership. 

 SMART- Simple, Moral, Accountable, Responsive, Transparent. 

 SWAN- State Wide Area Network. 

12.10 CHECK YOUR PROGRESS 

Descriptive type questions- 

a) What are the benefits of e-governance? 

b) Explain the summarized view of e-governance in India. 

c) List five major challenges of implementing e-governance in India. 

d) Define in short, the various e-governance models. 

e) Define briefly the role and responsibilities of the National e-Governance Division 

(NeGD). 

f) List the name of ten miscellaneous e-governance projects in India. 

Objective type questions- 

a) Infrastructure is essentially required for the implementation of successful e-governance 

projects. (True/False) 

b) One of the major challenges in implementing successful e-governance projects is a lack 

of motivation and awareness. (True/False) 
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c) The National e-Governance Division (NeGD) is providing strategic direction in terms 

of framing policies and implementation strategy for the Digital India Programme in 

different domains of e-Governance. (True/False) 

d) PMIS stands for Prime Minister Information System. (True/False) 

e) DigiLocker aims to provide a digital wallet to every citizen of the country where we 

can deposit the money. (True/False) 

f) National e-Governance Division was established by the Ministry of ........  

g) Government-to-Citizens (G2C) model of governance has been designed to facilitate 

citizen interaction with ........ 

Answer (objective type question)- 

[a] True  [b] True  [c] True  [d] False  [e] False  

[f] Electronics & Information Technology   [g] Government 
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